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Getting Started with ATOM

Intended Audience

This document is intended for Network Administrators & Operators that are using ATOM to
perform Network management, configuration management, services automation and MOPs.

References

1. ATOM Deployment Guide - All aspects of ATOM Deployment including sizing and
deployment process

ATOM User Guide - Master [This Document]

ATOM User Guide - Remote Agent Deployment Guide

ATOM User Guide - Performance Management & Alerting

ATOM User Guide - Network Configuration Compliance, Reporting & Remediation

ATOM API Guide - Discusses all external interfaces and integration flows

N o o~ w N

ATOM Platform Guide - Discusses Service model, Device model and Workflow
development

ATOM Solution Overview
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Zero Touch

Provisioning

. Workflow &
MuItl—Ver:;jor Low Code
Suppo e P4 Automation

Features

Closed Loop Telemetry &

Automation Network
/ SSEESS\  Analytics

Following sections provide a brief overview of ATOM Features.

Configuration Management

ATOM provides Configuration management capabilities for a wide variety of devices. This includes
configuration archival, scheduling, trigger driven configuration sync, configuration diff etc.,

Topology

ATOM provides topology discovery through CDP & LLDP. Topology can be displayed hierarchically using
Resource Pools (Device Groups). Topology overlays Alarms and Performance information.

Collection & Reporting

ATOM supports collection of network operational and performance data through various protocols like
SNMP, SNMP Trap, Syslog & Telemetry. Such information can be visualized in ATOM as reports or can be
rendered on Grafana as Charts. Admin guide discusses Report customization in further detail.

Network Automation

ATOM provides Model driven Network automation for stateful services. Stateful services involve a
Service model (YANG) and some business logic. Service model development is covered in ATOM Platform
guide. Admin guide discusses how to deploy & operate a service.

Workflow & Low Code Automation
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ATOM provides an intuitive graphical designer to design, deploy and execute simple or complicated
network operations and procedures. It allows the administrator to configure pre-checks, post-checks and
approval flow. Workflow creation flows will be covered in the ATOM Platform Guide. Admin guide
discusses how to deploy & operate.

Telemetry & Network Analytics

In today’s economy, data is the new oil. Anuta’s ATOM helps organizations collect a massive amount of
network data from thousands of devices and generate detailed in-depth insights that will help them
deliver innovative applications and solutions to their customers. ATOM can collect network data from a
variety of sources including model-driven telemetry, SNMP and Syslog. The diverse data format of each
source is normalized to provide a single consistent view to the administrator. Grafana is packaged as part
of ATOM to view historical data, observe patterns and predict future trends. Organizations can integrate
their Big Data and Al platform with ATOM to generate business insights from the network element
configuration and operational state.

Procedure to Create Native Telemetry Collection

® Create a new Telemetry Collection
O Provide the name of collection
O Choose Junos as platform
O Select the transport as UDP which we will auto select the encoding as compact GPB with
Dial Out Mode
® To configure resource filtering on device, select the filtering tab and choose the sensor name in
dropdown & add regex pattern to configure
O Select ALL option, if we have same resource filter across sensors
® Once telemetry collection is provisioned, users can’t edit the entry.

O Subscription is not required in this case.

Closed Loop Automation

Anuta ATOM allows administrators to define a baseline behavior of their network and remediation
actions to be initiated on any violation of this behavior. ATOM collects a large amount of network data
from multi-vendor infrastructure using Google Protobufs and stores in a time series database. ATOM
correlation engine constantly monitors and compares the collected data with the baseline behavior to
detect any deviations. On any violation, the pre-defined remediation action is triggered thereby always
maintaining network consistency.

The solution simplifies troubleshooting by providing the context of the entire network. Customers can
define KPI metrics and corrective actions to automate SLA compliance.

Multi-Vendor support

Anuta ATOM has the most comprehensive vendor support. It supports thousands of devices spanning
across 45+ vendors and automates all the use-cases including Data Center Automation, InterCloud,
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Micro-Segmentation, Security as a Service, LBaaS, Campus/Access, Branch/WAN, IP/MPLS Edge, Virtual
CPE, and NFV.

Multi Tenancy

ATOM supports Multi-Tenancy across organizations and Sub-Tenancy within an Organization.

e Multi-Tenancy - Supported on ATOM On-Premises & ATOM Silo/Dedicated Deployment
on ATOM Cloud.
o Tenants (Coke, Pepsi etc.,) are completely isolated from each other.
® Sub-Tenancy - Supported on All ATOM Deployments - On-Premises, ATOM Cloud
Silo/Dedicated and also ATOM Cloud Shared.
o Data sharing across sub-tenants (Coke.east, Coke.west, Coke.it etc.,) is controlled
by Tenant Admin.
By Default Data at a higher Level Tenant is Visible to the Sub-Tenants.
By Default, Data under a sub-tenant is visible to the Tenant
By Default, Data under a sub-tenant is not visible to other Sub-tenant
Example - Coke.east owns a resource (credential set or device etc.) and wants to
share with sub tenants (Coke.west but not with Coke.it). In this case, ATOM Multi
Tenancy Infrastructure provides a facility to share a resource with particular
sub-tenants. Upon sharing the resources as required, each individual ATOM User
interface will provide information on Resource sharing as shown below. This
behaviour will be the same across all the resources in ATOM and will not be
discussed specifically across features in the user guide.

o O O O

Sample View of Resource being shared from Coke.east to Coke.west

@ atom () > Devices ﬂ = O 2

Cokewestadmin

Devices  Credential Sets  Credential Profiles  Credential Maps  Discover y  Discovered Devices

cC + B o & » 20f2  Search Q
O w«a Ipvé_address Management-Station Managed-Devices Unmanaged-Device-Capability Owner Shared With Created-On
O 17216344 coke.east coke.west 2021-03-24 10:35:49.955

[0 17216.3.46 coke coke,coke.west 2021-03-24 09:34:28.263

Multi-Tenancy including Sharing, Wild Card usage to share across multiple Sub-tenants, Users
within a Sub-Tenant and more details are discussed in ATOM Multi Tenancy & Sub-Tenancy
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Viewing the Dashboard

Dashboard provides a simple, integrated, comprehensive view of the data associated with the
resources managed by ATOM. Information about the devices, services, service approvals are
available “at-a-glance” for the administrator.

Starting from the 7.x release, Dashboard, the landing page of ATOM, is organized into dashlets.
A dashlet is an individual component that can be added to or removed from a dashboard. Each
dashlet is a reusable unit of functionality, providing a summary of the feature or the function
supported by ATOM and is rendered as a result of the custom queries written in DSL.

You can customize the look of the Dashboard, by adding the dashlets of your choice, and
dragging and dropping (the extreme right corner of the dashlet) to the desired location on the
dashboard.
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Each dashlet contains the summary or the overview of the feature or the functionality
supported by ATOM.

For example, the dashlet “Device” displays the summary of devices managed by ATOM.
Some of the statistics that can be of interest in this dashlet could be as follows:

e Total number of devices

e Number of online devices

o Number of offline devices

These statistics can be gathered by ATOM and displayed in the corresponding dashlet depending
on the DSL query written for each of them. You can save the layout containing the dashlets of
your choice and set in a particular order.
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Resource Management

ATOM Resource management involves device credential management, device onboarding
through discovery or manual import, configuration archival, topology discovery & visualization,
resource pools (device grouping), IP Address Management etc.,

Following table provides a quick summary of the activities that can be Resource Management

activities.
If you want to.. Navigate to ...
Credential Sets, Credential Maps and Devices Resource Manager > Devices
Device Discovery Resource Manager > Devices > Discovery
Visualize Topology Resource Manager > Network > Topology

Create & Visualize Logical & Hierarchical Network | Resource Manager > Network > Resource
Device Groups/Resource Pools Pools

Create physical locations Resource Manager > Locations

Device Management

Device Management involves onboarding of devices and working with Device inventory,
Configuration, Monitoring & Alerts. Devices can be added Manually, through an API or
Automated Discovery using CDP/LLDP.

All Device Mgmt activities can be performed from Device Explorer & Grid View. Following are
the three main views for a Device.

Grid View - Grid layout of all Devices & and action on a device(s)

Tree View - Device Group based tree view of devices that provides a much easier way to
toggle between devices and inspect various device characteristics.

Topology View - Devices can be visualized in a Topology view

Device Detail View - On Clicking a Device from Tree View or Grid View a detailed view of
the device is presented. This is same as the view when a device is selected from the Tree

view
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Grid, Tree view & Topology Views can be toggled using the view selector button available at the
bottom right hand side corner of the page.

Network ol R Summary y  Configuration ~ Monitoring  Alerts.
abies QG T @r0criical @1 waming [ Tote B O e uni
v B Albevices
B c search a
® 17216359
172161130 Alert Name Device/NodeName Device Name Device FQDN Resource Severity Ack Status Message
© 7216223 [m] 172.16.18.176 eor-chb-2-gw.net disney.com @ ® Open Interface GigabitEthernet|
17216544 [m] 1721618176 e ® open The input error 1
1721621.18 (] 172.16.18.176 eor-chb-2-gw.net.disney.com Jcontroller-devices/device=172.16.18.176/int [ criical ] ® Open The HC Ingress Utilisatior
172.16.5.49
(] 172.16.18.176 eor-chb-2-gw.net.disney.com fcontrollerdevices/device=172.16.18.176 [ criical ] ® Open CPU usage reached to 92
172.16.5.40
=) 121656 test D ® o Device 17216583 i usi
® 1721623245
> 172.16.1.145 Open Device 172.16.1.145 Diag
® 17216597 N e © " 9
17216541 (m] 172161145 @ ® o The Status of the Device
@ vPLS [m] 172.16337 BIGIP_Active.com a ® Gpen The Status of the Device
72165402 o 126508 S ED ® o veceimzissssoen
® 172165143
10.1.15.27

@ 17216.16.162
172.16.5.54
@ 17216337
® 172161227
® 172165221
® 172162236
1011533
® 17216.23.225
172.16.5.48

17216543

® 172162235

1011521 o ¥ N

Credential Management

ATOM provides multiple functions like Provisioning, Inventory Collection etc. Function like
Provisioning can be various ways - Payload (CLI vs YANG or Other) over a Given Transport (SSH,
Telnet, HTTP(S), etc.,). For example, based on the use case ATOM Workflow Engine can use
various Payload + Transport mechanisms to perform Provisioning actions. ATOM helps
accomplish this using:

e Credential Sets - Define the Transport/Connectivity & Authentication to the devices
e Credential Profile - Maps Credential Sets to various functions in ATOM
This addresses various scenarios, some as follows:

o Reuse of same SNMP Credentials across the entire Network, while retaining
Device/Vendor Specific Transport for Provisioning.

e Inventory Collection Via SNMP for a Given Vendor/Device vs Telemetry for another

Credential Sets
Following section provides guidance on how to configure device credentials in ATOM.
1. Navigate to Resource Manager > Devices > Grid View(lcon) > Credential Sets

2. Create/Edit a Credential Set
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e Name: Enter a string that will be used to identify the Credential Set

e Description: Enter a description w.r.t the created Credential Set(Optional)

SNMP Transport credentials:
Select Transport type as “SNMP” can view below option

® SNMP version: Select the version of SNMP that should be used for device
communication

o SNMP Read Community String: Enter the string that is used by the device to
authenticate ATOM before it can retrieve the configuration from the device

o SNMP Write Community String: Enter the string that is used by the device to
authenticate ATOM while writing configuration to the device

e Timeout: Enter the time taken for the response from the device in seconds.

o Number Of Retries: Enter the number of times the SNMP request is sent when a

timeout occurs.

ssssss SNMPV2C SNMPVE

CLI Device(SSH/TELNET) Transport Credentials:
Select Transport type as “SSH/TELNET”
e User name: Enter a string that should be used to login to the device
e Password: Enter a string that used be a password for logging into the device

e Enable Password: Enter a password to enter into the privilege exec mode of the
device.
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e Mgmt-VRF-Name: Enter the name of the management VRF configured on the
device. This will be used by ATOM to retrieve the audit logs from the device.

e Port Number: Enter the number of the port on the device that should be used for
communication with ATOM

e Command Execution Wait Time: Enter the number (in millisecs) that ATOM should
wait for the consecutive commands to be executed on the device. Enter any number
between 10 to 30000.

e CLI Configure Command TimeOut: Enter the time (in seconds) that ATOM should
wait for the command line prompt on the device to appear. Enter any between 1 to
1200.

e Max Connections: Enter the number of max connections that can be opened for a
given device at any time.

(@ atom ) > Deviess A= 2

Create Credential Set | [3,

NNNNNN

ssssssssssss

API Device Transport Credential:
Select Transport type as “HTTP_HTTPS / GRPC”
e User name: Enter a string that should be used to login to the device
e Password: Enter a string that used be a password for logging into the device

o Port Number: Enter the number of the port on the device that should be used for
communication with ATOM.

e Max Connections: Enter the number of max connections that can be opened for a
given device at any time.
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e

9

D i
Transport Type &
HTTP_HTTPS x -

>

GRPC Transport credential:

Create Credential Set | [3 ~ @

Max Connections.

a

Credential Profile
By default, ATOM has the following out of the box functions:
e Config Provisioning
e SNMP
o Telemetry
e HTTP provisioning
® NETCONF provisioning
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Navigate to Resource Manager > Devices > Grid View(lcon) > Credential Profile

1. Here, provide the name of credential profile, description and add the transport
credentials by choosing the appropriate functions.

=

Create Credential-Profile D_

Entities + .

¥ Credential-Profile - Netconf-Htts Transport Credentials

Transport-Credentials - 1 N
netconf-hits

Transport-Credentials - 2

Transport-Credentials - 3 Description

2. Below is the snapshot to attach the credential set with function.

Entities -
ide

v Credential-Profile-
jSWTelemetry

PerfStats

Function e

TELEMETRY COLLECTION x v
Credential Set &

TelemetryPerformance x v

Credential profile payload in XML:

Credential Maps

Credential Map allows users to map multiple Credentials Profiles to an IP-Address range. This
addresses the following use cases:

® Device Discovery - When ATOM needs to Perform Discovery using SNMP Sweep or
CDP/LLDP. Since devices are yet to be onboarded, explicit assignment is not available.

e Credential profile is mandatory when onboarding a device.

When ATOM needs credentials for a device and explicit Device to Credential Profile is not
available, ATOM will cycle through the IP Address range and use the first credential profile that
works. The successful Credential Profile is mapped to the device. This process is repeated
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whenever ATOM is unsuccessful communicating with the device using the current assigned
credential profile.

To create a Credential Map:
1. Navigate to Resource Manager > Devices > Grid View(lcon) > Credential Maps
2. Create/Edit Create Credential Map:

e Name: Enter a name for the Credential Map

e Start-IP-address: Enter an IP address in the range from which ATOM starts the sweep
for locating the devices.

e End-IP-address: Enter an IP address in the range beyond which ATOM will not
continue the sweep for locating the devices.

Note: The Start and the End IP address are the range of IP addresses of the devices.

o Credential Profile: Select one or more Credential Profiles shown.

& Create Credential Map kX

IP Range o
172.16.3.30-172.16.3.41

Credential-Profile &

Selected (D 90f9  searcl h Q

B CredentialProfile 4 Description Owner
D BIGIP_API BIGIP_API system
D PAN_API_443 PAN_API_443 system
D SSH_SNMP SSH and SNMP Profile system
[ wMTCredentialProfile WfMTCredentialProfile system
O csd_profile csd_profile system

3 even_tavpn_profile evpn_I3vpn_profile system

[ netcont_profile netconf_profile system
profile1 profile1 system

I:I ssh_snmp_bgp ssh_snmp_bgp system

Device Onboarding

Devices can be onboarded into ATOM using an API, Manually through User Interface of
Discovery using CDP/LLDP.

Discovering Devices

Devices discovery is covered in section - Device Discovery

Adding Device Manually

We may have scenarios where device discovery is not viable. Some reasons below:

e Lack of support for Layer 2 discovery support on the device
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e Operational/Administrative reason to not use LLDP/CDP

e SNMP Sweep discovery is not suitable - IP Address Range are not well defined,
contiguous or some other reasons

Before you begin, it’s mandatory to define Credential Sets & Credential Profiles.
To Add/Edit a Device:

1. Navigate to Resource Manager > Devices (Grid View)

2. Add - Select Add action
a. IP address: Enter the IP address of the device
b. Credential Profile: Select the Credential Profile of the device
c. Driver name: Driver can be selected for API devices.

d. Latitude & Longitude: is a measurement on a globe or map of location north or
south of the Equator on devices

3. Modify - Select Device & Select Edit action

4. Delete - Select one/more device(s) and Select Delete Action

,,,,,,

ananananan

UNKNOWN

Deseription

rrrrrrrrrr

aaaaaaaaaaaaaaa

Upon device addition, ATOM will perform the following:

Added Devices are shown in Devices grid and Device status will be shown in Green if device is
SNMP reachable and ATOM is able to work with the device successfully.
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® Devices  CredentialSets  Credential Profiles  Credential Maps  Discovery

c + B @A 80f8 | Search Q
0 O W4 Status. MgmtIp-Address Fqdn-Name Name Device Type Credential Set Last Extended-inv-Time 0sversion Platform De
[l O 72isiee [ ] 1721618176 eor-chb-2-gwnet disney.com CiscolOSXRVA000 05/26/20,12:16:25 PM 614 6.1.4{Ciscol0SXRYI000 Cisco ASR 9000/I0SXR Cisco Systems

0O 17216332 [ ] 17216.3.32 anuta-lab02 anutacorp.com Cisco CSR 1000V 05/26/20,12:17:06 PM 15.6(1)S 15.6(1)SICisco CSR 1000V|Cisco CSR 1000V/I0SXE[Cisco Syst.
IS8 O o [ ) 17216333 ‘wbucbb-bur-0-gw.net disney.com Cisco CSR 1000V 05/26/20,11:58:42 AM 156(1)s 15.6(1)SICisco CSR 1000V|Cisco CSR 1000V/I0SXE[Cisco Syst

0O 7216341 [ ] 17216.3.41 CSR_3.41.anutacarp.com Cisco CSR 1000V 05/26/20,12:15:45 PM 15.6(1)S 15.6(1)SICisco CSR 1000V|Cisco CSR 1000V/I0SXE[Cisco Syst.

O 17216342 [ ] 17216.3.42 n7-cbb-0-gwnet disney.com Cisco CSR 1000V 05/26/20,12:09:09 PM 15.6(1)S 15.6(1)SICisco CSR 1000V|Cisco CSR 1000V/I0SXE[Cisco Syst.
D 0O 17216343 [ ] 17216.3.43 ana-sve-0-gwnet.disney.com Cisco CSR 1000V 05/26/20,12:09:45 PM 15.6(1)S 15.6(1)SICisco CSR 1000V|Cisco CSR 1000V/I0SXE[Cisco Syst.

O 17216344 [ ] 17216.3.44 whuchb-bur-1-gw.net disney.com Cisco CSR 1000V ALLICisco CSR 1000V|Cisco CSR 1000V|IOSXE[Cisco Systems

O 17216349 [ ] 17216349 wh.anuta.com Cisco CSR 1000V 05/26/20,12:15:13 PM 15.6(1) 15.6(1)S1Cisco GSR 1000V[Cisco GSR 1000V/IOSXE|Cisco Syst.

Device Views

ATOM has 3 views for the devices - Tree (Device Explorer), Topology and Grid.

1. Tree View:

Network i Summary  Configuration  Monitoring  Alerts.
Search with device attributes Q| G 10Minute 30 Minute
v |B Al
(B Allpevices I CPU Utilisation 1min Device Level of Hardware Summary = # X Top5DiskUtilisation across Network of Hardware Summary = # x
® 17216359 05

® 172162233

® 172161139

® 17216544
® 172162118 as
® 17216549
@ 17216540 ¢
® 1721623245 00
as
® 17216597
Metrics 8 .
searchforameric Q@ C = W
s
v 172161139
WAN._Interface_Traffic_M.
7
¥ Templates 0910 0915 0920 0825 0930 0935 0940 0945 0950 0955
COS._Stats_Per_queue
65 & Disk Utilisati 59
Cos_stats_per_interface N - N Disk Network |
0510 w20 00 o940 090 1000 Dk e N -
Hardware Summary Disk Utilisati Network | %
P_Address_Composition - cpmCPUTotallminRey.7,172.16.3.46 - cpmCPUTotallminRey_7,172.16.3.44 Disk Utiisati Network t 9
- cpmCPUTotallminRey_4097.172.16.18.176 = Disk Utilisati Network %

Interface Drops and Erfo.
InterfacePerformance

/' Update Template.

2. Topology View
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® Topology ~ Resource Pools  Network-Connections. £
C < O Search device by name Q
£
Resource Pools IWANHUB | 6 1 8
1 | ] ° o Resource pool Devices offine | Connections
IWANDCRP
o]
IWANHUB

@ IWANHaSPOKE
ase-svc-1-gw.anutanetworks.com
D [ee——"

o [
IND
California

[ J
17216.350

Milpitas

rks.com - gsrag, com
America

RP_Mail

RP_DOC

A]

©)

enacch.anuta.com

csr42 anutacorp.com

3. Grid View:

® Devices  Credential Sets  Credential Profiles  Credential Maps  Discovery
c + B @ 1-500f 181 Page1 0f4 > >l fearch a
o o w©a us Mgmtip-Address FqdnName Name Device Type Gredental Set Last Extended-Inv-Time 0sVersion Platform
il O 11e 10114 CISCOAIrCTSS08K9 CISCOAITCTSS08K9 SSH_1 ALLICISCOAIrCTSS08K'
O 1oa1as 10115 cat385024P-3 cat385024P SSH_1 ALLicat385024P|Catal
[ofl O 116 10116 cat35024p-1 cat3ss024P SSH_1 ALLIcat385024P(Catal
O 1011519 10.1.15.19 PaloAlto PA-5060 SSH ALLIPA-5060|Palo Altc
0 0 0o 1011521 Cisco Virtual ASA Cisco Virtual ASA SsH ALLICIsco Virtual ASA)
O 1011523 10.1.15.23 CiSCOASAS510 CiSCOASAS510 SSH ALLIciscoASAS510/Ci4
b O 1011525 1011525 Cisco Nexus 7004 Ciseo Nexus 7004 SsH ALLICIsco Nexus 700:
a O 1011527 10.1.15.27 Cisco Nexus 5010 Switch Cisco Nexus 5010 Switch SSH ALLICisco Nexus 501
O 1011529 1011529 Cisco Nexus 3064 Switch Ciseo Nexus 2064 Switch SsH ALLICIsco Nexus 3064
> O 1011831 10.1.15.31 Cisco ASR 9006 Cisco ASR 9006 SSH ALLICisco ASR 9006t
O 1011533 1011533 BIGIP LTMVE BIGIP LTMVE SsH ALLBIGIP LTM VERI
O 1011534 10.1.15.34 APIC SSH ALLIAPIC|Cisco APIC]!
O 10121 10121 CiscolSRA331 CiscolSR4331 SSH_1 ALLE
O 10122 10122 CiscOAIrCI2504KD CiSCOAITC2504K0 SsH1 ALLICISCOAICIZ504KS
O 10123 10123 Catalyst4500X16 Catalyst4500%-16 SSH_1 ALLICatalyst4500X-16
O 10124 10.1.24 CiscoCatalyst3560 Cisco Catalyst 3560E-12SD SSH_1 ALL[Cisco Catalyst 35
O 10125 10125 Cat385024P-4 catas5024P SSH_1 ALLicat385024P(Catal
O 101023 INFOBLOX ALLIINFOBLOX|INFOBI
O 172161138 17216.1.138 Router Cisco 871 11/21/19,4:03:40 PM 12.4(15)T10 12.4(15)T10[Cisco 87
O 17216139 172161139 eorwdw-aaahq1-vpn1-gw.net disney.com Cisco 891 03/03/20, 2:53:34 PM 155(1)T 15.5(1)TICisco 891(Cit
O 172161145 17216.1.145 UNKNOWN telnet ALLIUNKNOWNUNKN
O 172161146 172.16.1.146 Router146.anutacorp.com Cisco 2951 telnet 07/26/19,3:52:06 PM 15.3(BLD_T_BASE_3_OLYMPUS_201302140413) 15.3(BLD_T_BASE_3_(
O 172161350 172.16.1.150 CE1-ISR.anutaqa.com Cisco3945SPE250 SSH 07/26/19,3:52:25 PM 15.1(1)T2 55
O 172160227 172.16.1.227 PE2-ASR1002 UNKNOWN ssh_hpnv LR am

Device Explorer

Device explorer view will provide the devices, its associated config and observability elements in
logical hierarchy. This view contains the available device-groups and its associated devices . By
default, all the devices are part of AllDevices Group.

Device group will have all the corresponding device details Each group and node will have the
following sections:

1. Summary : It provides the device platform, version, serial number, current operating OS,
Device hardware health, Interface summary, Config compliance violations and Active
alerts and recent activity.

25



ATOM User Guide

2. Configuration : it provides the entire summary of config related operations.

a. Config Archive : It shows the each config retrieval, type, retrieval & parsing

status.

b. Changelog : provides the summary of change in configuration such as number of
lines added, deleted or modified and at what time & corresponding changes.

c. Config Data : it will provide the entire config tree through YANG models parsing.
This is not applicable for any device group as they can have heterogeneous
models based on the grouping criteria & provisioning interface such as ATOM
abstract device models, OC or Native models.

3. Monitoring : It contains all possible templates & charts through inheritance from its
group or node level. It will show the default template by default as its monitoring
summary. Refer Monitoring Guide for more details.

4. Alerts : It will show the all active alerts and its history by default. Alert filter view is also
available to search & prioritise the alerts. Refer Alerting Guide for more details.

Each device-group view will have a Summary dashboard which can be customizable.

Device Actions

ATOM supports common actions on Device. These actions can be performed from Device Grid
view on one or more devices or from within the Device specific view and will be discussed in
Device Summary section.

Jobs & Subscriptions
Various Collection & Diagnostics jobs can be invoked.
1. Navigate to Devices > select one or more devices
2. Click on the Jobs and select the job to run
a. Jobs action -> Run Device Inventory
b. Jobs action -> Run Extended Inventory
c. Jobs action -> Run Topology Inventory
d. Jobs action -> Retrieve Configs
e. Jobs action -> Run Diagnostics
f.  Jobs action -> Run Policy
g. Jobs action -> Run Profile
3. Click on the Subscriptions to configure Syslog Subscription on the Devices

a. This will result in ATOM being configured as a Syslog receiver and is a
configuration change on the device.
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Iy

Devices

c
a

[m]
a
[m]
a
[m]
a
[m]
a
[m]
a
[m]
a
a
a
a
a
a

’

CIPN
1721617135
17216330
17216331
17216332
17216340
17216342
17216343
17216346
17216373
17216376
172164154
172.16.4.60
17216461
172165104

172.16.5.80

172.16.5.80_swim

17216.5.89

17216595

Credential Sets

Credential Profiles ~ Credential Maps

Discovery

B & @ A A ¥ sclected EB

stat

Discovered Devices

18018 | Search B
Jobs FadnName Name Device Type Credential Set LastExtended-Inv-Time 0s-Version Platform
Run Device Inventory asr17.135 CiscolOSXRV9000 10/30/20, 11:39:23 AM 633 6:3.3[Ciscol0 Systems
un Extendad ventry wnacrp-dtss-0-gw.net disney.com Cisco CSR 1000V 11/01/20,10:16:04 AM 156(1)3 15.6(1)SiCisca CSR 1000V]Cisco CSR 1000VII0SXE[Cisco Syst
ana-buf-6-gw anutacorp.com Cisco CSR 1000V 10/30/20, 11:05:26 AM 15.6(1) 15.6(1)SiCisca CSR 1000V]Cisco CSR 1000VII0SXE[Cisco Syst
Run Topology Inventory enachb-kmtc net disney.com Cisco CSR 1000V 10/07/20,10:20:02 AM 15.6(1)S 15.6(1)S[Cisca CSR 1000V[Cisco CSR 1000V/I0SXE[Cisco Syst
Retrieve Configs ‘wnacrp-dtss-0-gwtest.com Cisco CSR 1000V 10/07/20, 11:08:49 AM 15.6(1) 15.6(1)SiCisca CSR 1000V]Cisco CSR 1000VII0SXE[Cisco Syst
i Disgnostics n7-cbb-0-gw Cisco CSR 1000V 10/06/20, 12:53:36 PM 156(1)8 15.6(1)8iCisco CSR 1000V]Cisco CSR 1000VII0SXE[Cisco Syst
‘wnacrp-dtss-0-gw.net disney.com Cisco CSR 1000V 10/21/20, 101414 PM 15.6(1) 15.6(1)SiCisca CSR 1000V]Cisco CSR 1000VII0SXE[Cisco Syst
Run Policy aanchb-ana0-gw Cisco CSR 1000V 10/08/20, 8:42:04 AM 156(1)8 15.6(1)S(Cisca CSR 1000V|Cisco CSR 1000V/I0SXE|Cisco Syst.
Run Profile ana-buf-2.gw Gisco Nexus 9000v 10/05/20, 445:50 PM 0@)7(4) 7.0(3)17(4) Cisco Nexus 9000vICisco Nexus 9000INXOSICisco
17216376 17216376 Panorama AL ALL|PanoramalPanorama|[PANOS Panorama Systems
172164154 WX 10/10/20,207:18 AM 202R1.10 20.2R1.10[yMX|Juniper MX|JUNOSIuniper Networks
17216460 1tm01.anutacorp.com bigipVirtual AL ALLIbigipVirtual[Biglp TMOSIFS Networks
17216461 tm02.anutacorp.com bigipVirtual AL ALLIbigipVirtual BiglpTMOSIFS Networks
172165104 anutachb-lab1 JuniperVSRX 10/06/20,3:02:39 PM 17.3R2.10 17.3R2.101JuniperVSRX|Juniper SR Series FirewalllJUNOSIJu
172.16.5.80 Router123 Cisco 2911 10/06/20, 12:49:10 PM 157(3M6 15.7(3)Mé[Ciseo 2911Cisco 2900/10S[Cisco Systems
172.16.5.80 Router123 Cisco 2911 10/06/20, 10:53:12 AM 157(3M6 15.7(3)Mé[Ciseo 2911Cisco 2900/10S[Cisco Systems
172.16.5.89 WX 10/08/20,1:53:52 PM 202R1.10 20.2R1.10[yMX|Juniper MX|JUNOSIuniper Networks
17216595 $10112b1-5.95 WX 10/18/20,1:39:54 PM 17.4R1.16 17.4R1.16[yMX|Juniper MX|JUNOSIuniper Networks

[u}

[u}

Devices
c L]
8 d4a
1721618176
O 17216332
O 17216333
O 721634
O 17216342
O 17216343
O 17216344
O 17216349

Credential Sets

6 @ a

Status

Credential Profiles  Credential Maps

QA ¥ selected G

Notifications
Subscribe To SysLog Events

UnSubscribe To SysLog Events

17216341
17216342
17216343
17216344

172.16.3.49

Discovery

gdnName

Name
eor-chb-2-gwnet disney.com
anuta-1abo2.anutacorp.com
whucbb-bur-0-gw.net disney.com
CSR_3 41 anutacorp com
n7-cbb-0-gw net disney.com
ana-sve-0-gwnet disney. com
‘whucbb-bur-1-gw.net disney.com

wbu.anuta.com

Device Type

CiscolOSXRV9000
Cisco CSR 1000V
Cisco CSR 1000V
Cisco CSR 1000V
Cisco CSR 1000V
Cisco CSR 1000V
Cisco CSR 1000V

Cisco CSR 1000V

Credential Set

LastExtended-Inv-Time
05/26/20,12:16:25 PM
05/26/20,12:17:06 PM
05/26/20,11:58:42 AM
05/26/20,12:15:45 PM
05/26/20,12:09:09 PM

05/26/20,12:09:45 PM

05/26/20,12:1513 PM

0s-Version
614
15.6(1)8
15.6(1)8
15.6(1)8
15.6(1)8

15.6(1)8

15.6(1)8

80f8 | Search B

Platform

6.1.4{Ciscol0SXRY3000/Cisca ASR 9000]I0SXRICisco Systems
15.6(1)SICisco CSR 1000V[Cisco CSR 1000V/IOSXE|Cisco Syst..
15.6(1)SICisco CSR 1000VICisco CSR 1000V/I0SXE|Cisco Syst
15.6(1)SICisco CSR 1000VICisco CSR 1000V/I0SXE|Cisco Syst
15.6(1)SICisco CSR 1000VICisco CSR 1000V/I0SXE|Cisco Syst
15.6(1)SICisco CSR 1000VICisco CSR 1000V/I0SXE|Cisco Syst
ALLICisCo CSR 1000V/Cisco GSR 1000V/10SXE[Cisco Systems

15.6(1)SICisco CSR 1000VICisco CSR 1000V/IOSXE|Cisco Syst

De

Devices
c 7 L]
4

1721618176

17216332

17216333

172.163.41

17216342

17216343

17216344

172.16.3.49

Credential Sets

Credential Profiles  Credential Maps

G @ 2 A ¥ soced @B

Status

Notifications
Subscribe To SysLog Events

UnSubscribe To SysLog Events

17216.3.41
172.16.3.42
172.16.3.43
17216.3.44

172.16.3.49

Discovery

gdnName

Name
eor-chb-2-gwnet disney.com
anuta-lab02.anutacorp.com
‘whucbb-bur-0-gw.net disney.com
CSR_3 41 anutacorp com
n7-cbb-0-gw net disney.com
ana-sve-0-gwnet disney. com
‘whucbb-bur-1-gw.net disney.com

wbu.anuta.com

Device Type

CiscolOSXRV9000
Cisco CSR 1000V
Cisco CSR 1000V
Cisco CSR 1000V
Cisco CSR 1000V
Cisco CSR 1000V
Cisco CSR 1000V

Cisco CSR 1000V

Credential Set

LastExtended-Inv-Time
05/26/20,12:16:25 PM
05/26/20,12:17:06 PM
05/26/20,11:58:42 AM
05/26/20,12:15:45 PM
05/26/20,12:09:.09 PM

05/26/20,12:09:45 PM

05/26/20,12:1513 PM

0s-Version
614
15.6(1)8
15.6(1)8
15.6(1)8
15.6(1)8

15.6(1)8

15.6(1)8

80f8 | Search B

Platform

6.1.4{Ciscol0SXRY3000/Cisca ASR 9000]I0SXRICisco Systems
15.6(1)SICisco CSR 1000VICisco CSR 1000V/I0SXE|Cisco Syst
15.6(1)SICisco CSR 1000VICisco CSR 1000V/I0SXE|Cisco Syst
15.6(1)SICisco CSR 1000VICisco CSR 1000V/I0SXE|Cisco Syst
15.6(1)S[Cisco CSR 1000VICisco CSR 1000V/I0SXE|Cisco Syst
15.6(1)SICisco CSR 1000VICisco CSR 1000V/I0SXE|Cisco Syst
ALLICisCo CSR 1000V/Cisco GSR 1000V/10SXE[Cisco Systems

15.6(1)SICisco CSR 1000VICisco CSR 1000V/IOSXE|Cisco Syst

De

Exporting Device Information

You can export the device information of the devices either in the XML or JSON format.

1. Navigate to Resource Manager > Devices > Grid View(lcon) > Devices

2. Select one or more devices
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3. Click the View/Download button and select either the XML or JSON
VTY Sessions

This is used to view the active vty sessions.

1.  Navigate to Resource Manager > Devices > Grid View(lcon) > Devices

2.  Select any device
3. Click the VTY Sessions button

® Devices  Credential Sets  Credential Profiles  Credential Maps  Discovery
o C /s § 6 @ a ’@ ¥ selected 90f9 | Search Q
I\
B da Status Mgmt-Ip-Address Fqdn-Name Name Device Type Credential Set Last-Extended-Inv-Time Os-Version
18 )
O 172161139 o 172.16.1.139 eorwdw-aaahq1-vpn1-gw.net.disney.com Cisco 891
A O 1721618176 [ ] 172.16.18.176 eor-cbb-2-gw.net.disney.com CiscolOSXRv9000 05/26/20, 12:16:25 PM 6.1.4
o O 17216332 [ ] 172.16.3.32 anuta-lab02.anutacorp.com Cisco CSR 1000V 05/26/20, 12:17:06 PM 15.6(1)s
172.16.3.33 [ ] 172.16.3.33 whucbb-bur-0-gw.net.disney.com Cisco CSR 1000V 05/26/20, 11:58:42 AM 15.6(1)s
D O 17216341 [ ] 172.16.3.41 CSR_3.41.anutacorp.com Cisco CSR 1000V 05/26/20, 12:15:45 PM 15.6(1)s
o O 172163.42 [ ] 172.16.3.42 n7-cbb-0-gw.net.disney.com Cisco CSR 1000V 05/26/20, 12:09:09 PM 15.6(1)s
O 17216343 [ ] 172.16.3.43 ana-sve-0-gw.net disney.com Cisco CSR 1000V 05/26/20, 12:09:45 PM 15.6(1)s
>— O 17216349 [ ] 172.16.3.49 wbu.anuta.com Cisco CSR 1000V 05/26/20, 12:15:13 PM 15.6(1)8
O 17216599 ) 172.16.5.99 UNKNOWN

Clear Device VTY Sessions

C 10f1

Transport Type 4 Is In Use Last Accessed Time

SSH true 05/26/20,2:42:27 PM
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Default Jobs

Below are the jobs which run during the device onboarding process in the mentioned order.

1. Device Inventory : It gathers the Platform, OS Version through SNMP and gets the
Device to ONLINE. If the platform is not found in ATOM then check Platform guide on

2. Device Extended Inventory : It collects the Serial Number, Interface performance,
health, availability etc.,

3. Device Diagnostics : ATOM will perform the reachability check through Ping, SNMP and
Telnet/SSH if they are applicable.

4. Base Config Pull or Config Retrieval : It will retrieve the configuration and persist in the
database. Configuration will be collected if the credential function is set to Config
SNAPSHQOT or any of the PROVISIONING functions. Build data model flag is used to parse
the configuration into YANG entities from the specified config source snapshot.

Below is the example, to backup cli and netconf xml config and parse the xml version.

® Transport-Credentials

+ B8 30f3  Search Q

Id Function Build-Data-Model Credential Set

3 CONFIG SNAPSHOT ® Cli_credentials

C
O
||I o 2 CONFIG SNAPSHOT Q Netconf_provisioing
[m]
[m]

netconf_provisioning NETCONF PROVISIONING Netconf_provisioing

5015 | Keyword a

eeeeeeeeeeeeeee arse Status erat 5 ConfigType: Parsing ID RetfievallD | Retrieval Time Tags
172163170 172163170 172163170 cu FINfOWagR  04/23/20, 54955 P

cu OCO7C00Y...  04/07/20, 721:57 P

@ 7216343

® estza0

172163170 172163170 172163170 Base config au 0:bJQTICHh.. 04107720, 12:46:56 PM

[m]

O °

0O 172163170 172163170 172163170 [ ]

0 1m0 72165170 72163170 ° ° Jobsconfig pull NETCONE JZWSgAVIUQLMSOVYSQSIYY Kye26hM.  04/07/20,721:42PM
[m] °

[m] °

® 17216338
® 17216344
® 17216459

172163170 172163170 172163170 Y Base config NETCONF MBIGANID]RHEDMPHCZKZFNA 0 04/07/20, 12:46:42 PM

® 17216330

@ cesLscenerion &

® 7216345
® 17216333
® 17216339
® 172163170

All the above operations can be customized for any platform as required and scheduled similar
to other collection jobs.

Device Summary

Device summary view provides a quick snapshot of important device attributes including Alarm
summary, interface summary, recent configuration change history and health.
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Device Summary also provides access to most popular device actions and quick links to

frequently used activities.

1. Navigate to Devices > select a device

2. Click on the Device > Summary> to view the details associated with each attribute.

@ atom > Devices/Details
e B T
tributes

»
Details | test G nens

config-parse-status
SUCCESSFUL

® 1011527

® 17216554

©® 1721616162 G

Juniper Networks

® 17216337
©® 172161227

® 172165221

@ 172162236

® 1011533
sys-descr
® 1721623225 ’
Juniper Networks, Inc. srx240h intemet router, kemnel

© 17216543 JUNOS 12.1X44-D40.2 £0: 2014-08-28 12:20:14.UTC
© 172716548 junipernat 121/ bbil Actions
D40.2/obj-octeon/junos /bsd/kemels/JSRXNLE /kernel
@ 172162235 Build date: 2014.08-28 134
® 1011521
device-type
® 172162234 JuniperSRX240
® 17216528 ~
id
® 17216583 7216583 R
® 17216:3.40 @ Recent Activity
credential-set
Retrieval Status A\
® ner so
RETRIEVED
® 17216.16.164 g
® 172165545 -02.603760 RETRIEVED
® 1011529 ey RETRIEVED
© 1721623243 JUNOS RETRIEVED
@ 1721616161 e RETRIEVED
@ 1011525 ONLINE RETRIEVED
©® 1011523 name RETRIEVED
® 01519 test RETRIEVED
®w1s L | e=remmen

Configuration Management

Configuration Archive

Parse Status

SUCCESSFUL

SUCCESSFUL

SUCCESSFUL

SUCCESSFUL

SUCCESSFUL

SUCCESSFUL

SUCCESSFUL

FAILED

Ll interface Status
Total
ot
° o 63

Up

13

Others

Ll Heatth

No Data

CPU Utilisation (%)

Operation Name
Create: firewallfiter

Create: access-ist

Create: application-policy

Greate: application-policy

Delete: application-pBlicy

SERVMODEL'Add the Application policy with SSL Cert Lb profile
Delete: application-policy

Jobretrieve-confi

9

=0 2 e

admin

[l Config Compliance Status

4 5

Down Violation Count
N
CRITICAL
Severity
N
No Data No Data

Memory Utilisation Temperature (C)

Retrieval Id Parsing Id

FighhNXvUIS4usR6LYEWDfSg DOTePBIDRISBazCbS5VIrCe:
1aEyPegURRF 24Dt] 4veX0Lw
PmncatQizeRcikVTIUXSERQ
Hdbo~fyDQTV2DZkyUv-pfvg
F5DIMCZQtiap0_OHP-dYA
6830Q1ho-DQWqTbMXDIZTEA
K2dlk1go1FXSXmBSZRINI4ITY

JgChTKVGVNTICHIp-000INVA

“9 ¥ 5

ATOM Collects Device configuration periodically as configured in Jobs->Configuration or upon a

config change event from the device. To trigger configuration collection through config change
notification, ATOM should be configured to receive config change notification through SNMP

Trap or Syslog.

1. To view Device(s) Configuration - Navigate to Devices > select a device(s)

Click on the “Configuration > Archive” Tab

2
3. Select an Entry in the Grid
4

In Details view - CLI/XML Configuration is displayed

]
OX{7JUBdXXSVENRekSY 7P
AvzSLOGILSja0kVSY4f11Q
JXWGA41AKZ0SdS3yS|20W G0l
MytiXWew3GRAGYYn_Sn-2Aq)
FRI2CIXEMSsysWVbzBDGalg

KLLBodIHVWQJqRAjxsFSEf9g

Y
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Network
Search with device attributes

v |8 AlDevices

® 17216359
® 172162233
® 172161139
® 17216544
® 172162118
® 17216549
® 17216540
® 1721623245
® 17216597
® MPLS

® 17216541
® 172165143
® 1011527
® 17216542
® 1721616162
® 17216554
©® 17216337
® 172161227
® 172165221
® 172162236
@ 1011533
® 1721623225
©® 17216543
® 17216548
©® 172162235

® 1011521

. Summary  Configuration  Monitoring  Alerts
c § ¥ b s mD m ——— 1-s00r911 Pagt
Device ID Device IP Device FQDN Retrieval Status | Parse Status Operation Name Config-Type
O 172161139 172.16.1.139 eor-cbb-0-gw.net di. [ ] [ ] Create: |3-service
[0 172183170 172163.170 172.16.3.170 o o Fix Job: 172.16.3170 NETCONF
O 172163170 172163470 172163170 [ ] [ ] Base config NETCONF
[ 172161339 17216139 eor-cbb-0-gwnetdi ) ) Jobiretrieve-config
[0 Cisco541 172165.41 ase-sve-1-gw.anuta. [ ] [ ] Base config
[ 172161339 17216139 eor-cbb-0-gwnetdi ) ) Jobiretrieve-config
172.16.3.40 172.16.3.40 [ ] [ ] Jobrretrieve-config
O 172162297 172162297 [ ] Config-Pull
O 172162297 172162207 [ ] Config-Pull
O 172162297 172162297 [ ] Config-Pull
O 172162297 172162207 [ ] Config-Pul
[0 172162297 172162297 [ ] Config-Pull
O 172162297 172162207 [ ] Config-Pul
O 172162297 172162297 [ ) [ ] Fix Job: 172.16.22.97
O 172162297 172162207 [ ] Config-Pul
[0 172162297 172162297 o Config-Pull
O 172162297 172162207 [ ] Config-Pul
O 17216118 172161139 Y ° Jobretrieve-config
O 172162287 172162297 [ ] Config-Pul
[0 172162297 172162297 o Config-Pull
O 17216340 172.16.3.40 [ ] [ ] Jobrretrieve-config
O 17216340 172.16:3.40 [ Config-Pull
O 172162297 172162297 [ ] Config-Pul
[0 172161139 172161139 [ (] Create: logging-hosts
[0 172161139 172161139 [ ) [ ) Jobrretrieve-config
0O 17216340 17216.3.40 ([ ] ([ ] Delets: I3-service.
[1 17216340 17216340 ([ ] [ ] Update: 13-service

Configuration Diff

X Configuration Details A

Current Configuration

2 show running-config
3 Building configuration. ..
4 current configuration : 48217 bytes

! Last configuration change at 1:18:32 UTC Tue
Feb 18 2020 by admin

8 version 15.6

9no service pad

vice tcp-keepalives-in

ce tcp-keepalives-out

ce timestamps debug datetime msec localtime
shou-timezone

13 service timestamps log datetime msec localtime
shou-timezone

ice password-encryption
15 service sequence-numbers

16 no platform punt-keepalive disable-kernel-core
17 platform console virtual
1
1

8 platform hardware throughput level ME 500

22 boot-start -marker
23 boot system Flash: /c800-universalkd-mz.SPA.154-

no shell processing
f definition 111

30 address-familv iova

Type and Enter

Configuration differences across various revisions can be viewed by selecting two versions from
the Configuration archive grid.

1. To view Device(s) Configuration - Navigate to Devices > select a device(s)

. Click on the “Configuration > Archive” Tab

. Search configuration grid using tags or other attributes

2
3
4. Select two configuration revisions
5

. Click on “Compare” to launch configuration diff view
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o 1 auaress
shutdoun

nterface cigabitetherneto/1s
no suitchport

no 1p address

shutdown

204 interface Gigabittherneto/1s
no suitchport

6 no ip address

shutdoun

9 interface Gigabitetherneto/2s
o no suitchpert

no 1p address

shutdown

214 interface Gigabitethernete/21

195.20.247.137 | Jun 1,2019, 1:06:21 PM

Configurations.

X COMPARING | CONFIGURATION DETAILS

215 e switchport
216 —se-ipademass

219 interface Gigabitetherneto/22
228 no switchport

221 1o ip address

222 shutdoun

224 interface Gigabitethernete/23
225 =

T chport trank_sncspsulation dotiq

19520.247.137 | Jun 2, 2019, 9:54:32 AM
96 snuzaown

1971

198 interface Gigabitethernete/1s

no switchport

no 1p address

shutdonn

iterface Gigabitetherneta/1s
no switchport

o ip address

shutdonn

2071
208 interface Gigabitethernete/20
no switchport

no 1p address

shutdonn

iterface Gigabitethernete/21

214 switchport access vian 782
215 _switchport mode access

216_shutdown
217 o cdp enable
215_channel-group 22 mode active
2191

226 interface GigabitEthernete/2z
221 no switchport

222 o 1p address

223 shutdown

2241

225 interface Gigabitethernete/2s

226 no switchport
227 o ip address

231
232 interface Gigabitetherneto/2s

228 shutdown
291
230 interface Gigabitetherneta/2+

231 o switchport.
232 o ip address

233 switchport.
234 —switenport
235 —switehport sode trunk

O

195.20.247.137 [}

233 shutdown
2341
235 interface Gigabitethernete/2s

Update: device

06/02/19,9:24:06 AM

MSI0ZdHIUIRJOGGH7L...

Configuration Tagging

Configuration version can be tagged using user provided flags or tags. This can be used for

filtering and comparison of configuration revisions.

1. To view Device(s) Configuration - Navigate to Devices > select a device(s)

. Click on the “Configuration > Archive” Tab

. Select an entry from the configuration revision grid

2
3
4. Click on “Update Tags”
5

. Enter one or more tags in the lower right of the configuration details view

Configuration

letwark

Searchwithdevice arribites. Q| G
¢ (B AlDerices
@ 17216343
@ 1721533
@ 172161.139
® 17216330
CREALERT
@ 1014101
@ 17216342
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® 17216347
@ 17216599
® 1721633
@ 1721634
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@ 17216336
+ (B Firewsl
+ B Hest
+ (B Layer 2 switch
+ B Leyer 2/3 switch
+ (B Layer 3 Router
+ (B Loadbalzncer
+ (B OfineDevices
- @ veN

c

oo

Summary

L I 4

Davice ID

17216331
17216331
17216331

17216.3.31

Menitoring
@ selected @
Davice IP

172.163.31

172163.31

172163.31

172.16.3.31

s

Davice FOON

na-cob-lgunet di_
na-ctb-lgunetdi_

ana-chb-1-gunet di_

anz-cob-1ginet di

Retrisval Stzwws

Changelog  Config Data

Parze Staws

Operation Name:
Config-Pull

Fix Jobi 172.16.331
Config-Pull

Base config

Canfig-Type

X Configuration Details

9 2820 by adwin

7 wrf definition ANUTA_EMPLOY

amily ipvd
ess-Fanily

Type and Enter
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Configuration Change Log

Configuration archive provides full comparison of device configuration changes across revisions.
ATOM provides another view to see only config modifications only.

This can be enabled from Admin Settings.
1. Administrations > System> General settings> Admin settings
2. Edit “Admin Settings”
3. Set “generate-config-inventory-event” to true
Config change history for devices can be tracked as follows:
1. Navigate to Devices (Tree View) > select device(s)
2. Click on the “Configuration” Tab
3. Click on the “Change Log” Tab

W Network ke Summary  Configuration  Monitoring  Alerts

‘Search wit hdeviceamibmes Q|G || @ s () ConfigDatz Search a
b
|8 AiDsices [ Dsviceld Addedlines | ModfiedLines Delersdlines  Diff Snippets Task\ Time Stamp 4,

® 17216377
[ FE

® 17216351
® 172161139
@ 17216338

@ 1721634
® 17216330
® 17216346
@ DEVICE4 52
® 17216339
® 17216372
® 17216580
@ 172163.49

Mering o display!
@ 17216378

@ 172165951
@ 17216376

@ 17216599

® 172165130

@ 172163358

& 1721618181

® 17216515

e

@ 172.16.595NETCONF
@ 17216371

@ 17216336 SHMP o 9 1§
<353

pp—
ascriptvoid(0):
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Summary Configuration Entities Config Change History

% CONFIG CHANGE HISTORY DETAILS

Configuration Change Management -
Create/Update/Delete

Configuration archive discussed in the “Configuration Management” section provides a
Read-Only view of Device CLI configuration. Additionally, ATOM provides Model driven
configuration for create, update & delete. This includes the following:

1. Discovery of Device configuration
2. Show a tree view of the configuration
3. Create/Edit/Delete of Device configuration
Configuration Editing can be done from “Config Data” view:
1. To view Device Configuration - Navigate to Devices > select a device
2. Click on the Configuration> Config Data Tab

3. From the Tree view select a node and possible operations are shown on the right hand
side

Note: Create/Edit/Delete from here will send configuration instructions to the device.
ATOM should be set to interactive mode from the Administration page.
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Py Meerk <
Qc

Search with device atiributes

v (B Albevices
® 17216377
® 459
oA ® 17216351
® 172161139
® 17216338

® 17216344

D

® 17216330
® 17216346
@ DEVICE4.59

® 17216339

Config Elements b3

Search for a config

—
» extcommunityists
features
hostname
hitp @
v interfaces
» Asyncl
» FastEthernet0
» FastEthernet]
» FastEthernet2

> FastEthemet3

Device

Summary  Configuration

+ B
Long:Name 4\
Asynct
FastEthemeto
FastEthemet!
FastEthernet2
FastEthemet3
FastEthemetd.
FastEthemets
FastEthemete
FastEthernet?
FastEthemets
FastEthemets.10
FastEthemets. 1213
FastEthemets 2134
FastEthemet8 2136
FastEthernets 2138
FastEthemets 22
FastEthemets 23
FastEthemets 3003
FastEthemets 302
FastEthemets 34
FastEthemets 78
FastEthemets 89
Gigabitetherneto

Gigabitethernet0. 18

000000000000 O0OO0O0OO0OO0OO0OOCOO0OO0OOO0O0O00)Q

GigabitEthernet0.45

Monitoring ~ Alerts

Name
Asynct
FastEthemet0
FastEthemet]
FastEthemet2
FastEthemet3
FastEthemetd
FastEthemets
FastEthemets
FastEthemet7
FastEthemets
FastEthemets 10
FastEthemets 1213
FastEthemets 2134
FastEthemets 2136
FastEthemete 2138
FastEthemets 22
FastEthemets 23
FastEthemets 3003
FastEthemets 302
FastEthemets 34
FastEthemets 78
FastEthemets 89
GigabitEthemeto
GigabitEthernetd 18

GigabitEthernet.45

Fas213¢.

Fa8.2136

Fag.2138

Fag.22

Fag.23

Fag.302

Fag78

Fag.89

Gi0e

Inventory (SNMP)

ifindex

16

2

1-50 0f 100 Pagel 0f2 > >l  Search Q

Description Mode Mtu
3nterface
3nterface
3nterface
3nterface
3nterface
3nterface
3nterface
3nterface
3interface
3nterface
subinterface

subinterface

subinterface

subinterface
description subinterface
subinterface
subinterface
subinterface
subinterface
subrinterface
subinterface
subinterface
gigabitEtherneto 13interface

null subinterface

subinterface

All Device inventory collected through SNMP Collection job is shown in Entities view. Following

provides guidance on

1. To view Device Configuration - Navigate to Devices > select a device

3.

Click on the “Monitoring” Tab

Collected data will be shown under MIB-name

Py etverk <
341 x C

O

11

fe!

%)

D
Metrics <

QcC

PP

Search for a metric

Top 5 interfaces by Ingr.
WAN_Total_Link_Utilisat.
v GigabitEthemnet1

Total Utilisation of Int.

test

test_pin
ifAdminStatus
ifHighSpeed

ifOperStatus

ifSneed

Summary

Charts

Variables

device

Configuration

Monitoring

172.16.3.41

Top 5 Interfaces by Egress Throughput

500

0
I 2. Mar 9. Mar

16. Mar 23. Mar

Alerts.

30. Mar 6. Apr

13 Apr

-+~ EgressThroughput in (bps)_device:172.16.3.41

ifHighSpeed of GigabitEthernet1

1000

ifHighs peed

20, apr

27. apr

10Minute 30

Refresh 5Minute 1D

Top 5 Interfaces by Ingress Throughput
8«

23 Mar

30.Mar 20, apr

27 Apr

2. Mar 5. Mar 16. Mar 6. Apr 15 Apr

- IngressThroughput in (bps)_device:172.16.3 41

ifAdminStatus of GigabitEthernetl = x

ifAdminStatus
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Adding Unmanaged devices

Some devices, with feature capabilities such as L2 only, L2 and L3 both, L3 only, can be manually
added to the Devices table. Such devices are not managed by ATOM and it does neither
generate configurations nor push any configurations on them. Multiple unmanaged devices can
be on-boarded into the resource pool and each such device can be used during service
instantiation.

To add an Unmanaged device, do the following:
1. Navigate to Resources > Devices > Add Device
2. Inthe Create device screen, select the Unmanaged option
Enter values in the following fields:
e Host Name: Enter a name for the device
e Device Capability: Select one or more capabilities from the available list.

For example, if you want the device to behave as a L3 device, choose L3Router
from the list.

o Device Type: Select the category of the device that it belongs to. 3. Add network
connections between the null device and it’s peer device as follows:

o Source Interface: Select the interface, on the null device, from which the
network connection should originate.

o Peer Device: Select the device, managed by ATOM, as the peer device.
e Peer Interface: Select the interface on the peer device where the network

connection should terminate.

Adding Dummy devices

In some scenarios, you may have to create devices for which configurations are created as a
part of a service but are not pushed to any actual device. These logical entities are termed
Dummy Devices and they do not have any real world counterparts with a pingable IP address.

Monitoring

ATOM enables you to create Assurance profiles to facilitate 24x7 uptime of your network.
Closed loop automation (CLA) framework allows you to define policies and remediation actions
in violation of those policies.

ATOM collects operational & performance metrics from multiple data sources such as SNMP,
SNMP traps, Syslog and Streaming Telemetry and stores them in a time-series database.

Following are the different activities on the metrics:
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e Visualize Data Using Charts & Reports

e Alerts against thresholds defined on the Metrics

e Alert Dashboards - Collection of Predefined & User Defined Dashlets
e Alert Routing to Email, Slack etc.,

e Actions on Alerts

e Closed Loop Automation Actions on the Alerts

Please refer to “ATOM User Guide - Performance Management & Alerting” for further details.

Network Topology

Network Connections

Network connectivity is discovered between devices using Layer 2 discovery protocols - CDP &
LLDP. In cases where CDP/LLDP is not supported or enabled on the device, Network connections
can be added Manually using Network connections .

NOTE: Network connections should be added manually between the devices that have LACP
port channels configured on them.

To add a Network Connection, do the following:

1. Go to Resource Manager > Network

2. Click Network Connections and click Add.

3. Inthe Create Network Connection screen, enter the values in the following fields:
e Unique ID: This is a system-generated ID for a network connection.
e Source Device: Select a Device (origin of the network connection)
e Source Interface : Enter a name for the interface on the source device
e Destination Device: Select a Device (the end of the network connection)

o Destination Interface: Enter a name for the interface on the destination device.
A Network Connection is established between the interfaces of the source and
the destination devices.
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Topology  Resource Pools  Network-Corections
@ e i

c + o A » 11011 | Search
0 O  uniqueid 4 Source-Device Source-nterface Destination-Device Destination-Interface System-Defined Owner Shared With
II| D 172.16.3.32_GigabitEthernet2_172.16.3.32_GigabitEthern: 172.16.3.32 GigabitEthernet2 17216.3.32 o
[0 17216332 GigabitEthernet3_172.16.3.32_Gigabitetherni  172.16.3.32 17216332 0
[:‘. [0 17216.3.43 GigabitEthernet1_172.16.3.32_Gigabitetherni  172.16.3.43 172.16.3.32 [V]
[0 17216.3.43 GigabitEthernet1_172.16.3.32_Gigabitetherni  172.16.3.43 17216332 0
@ [0 17216.3.43 GigabitEthernet1_172.16.3.32_Gigabitetherni  172.16.3.43 17216332 0
D [0 17216.3.46_GigabitEthernet2_172.16.3.46_GigabitEtherni  172.16.3.46 172.16.3.46 0
[0 17216.3.46_GigabitEthernet3_172.16.3.43_GigabitEtherni  172.16.3.46 172.16.3.43 0
* [0 17216.3.46_GigabitEthernet3_172.16.3.43_GigabitEtherni  172.16.3.46 172.16.3.43 0
[0 17216.3.46_GigabitEthernet3_172.16.3.46_Gigabitetherni  172.16.3.46 172.16.3.46 0
)_ D 172.16.3.46_GigabitEthernet3_172.16.3.46_GigabitEthern: 172.16.3.46 172.16.3.46 Gig 0
O  17216.3.73 mgmt0_172.16.3.73_Ethemet1/1 17216378 mgmto 17216373 Ethemet1/1 (]
Network Topology

All the devices for each of which network connections are available are displayed in the
topology view.

Resource Pools

A resource pool is a logical abstraction for flexible management of resources managed by
ATOM. A resource pool can contain child resource pools and you can create a hierarchy of
shared resources. The resource pools at a higher level are called parent resource pools. Users
can create child resource pools of the parent resource pool or of any user-created child resource
pool. Each child resource pool owns some of the parent’s resources and can, in turn, have a
hierarchy of child resource pools to represent successively smaller units of resources.

Resource pools allow you to delegate control over the resources of a host and by creating
multiple resource pools as direct children of the host, you can delegate control of the resource
pools to tenants or users within the organizations.

Using resource pools can yield the following benefits to the administrator:
e Flexible hierarchical organization
e |[solation between pools, sharing within pools

® Access control and delegation
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Creating a Resource Pool
1. Navigate to Resource Manager > Network > Resource Pools
2. Inthe right pane, click the Add Resource Pool button to create a Resource Pool

3. Inthe Create Resource Pool, enter values in the fields are displayed: .

1]
(€]

e

(8) atom > NewResource Poot

New Resource Pool

X

Name =

Description

Parent Resource Pool

Location

Available For Services

=]
Deploy

=]

e Name: Enter a name for the resource pool
e Description: Enter some descriptive text for the created resource pool

e Available for Services: Select this option if the resource pool can be used for creating
services.

e Parent Resource Pool: Select a resource pool that should act as the parent for this
resource pool that is being created.

® Location: Select the name of the site or the geographical location where this resource
pool should be created. See the section, "Locations" for more information about
creating Locations and Location types.

o Deploy: Select this option if the resource pool should be deployed or used in services.
Adding Devices to a Resource Pool
1. Click the created resource pool to add the required devices to it.

Select Resource pool > Add Devices
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® Topology  Resource Pools  Network-Connections %

Resource-Pools Information

c + 7 i ¥ sclaed @B

B Neme Description Awailable For Services Parent Resource Fool Location
0O re
ih @ =+ Add devices 11 View devices
O res ] RP
IOl O ]
L]

Available For Services
rue

true

@
D deploy
o

Name
test

Resource Path
Jresourcepoolresource-pools/resource-pool=test

2. All the devices available in ATOM are displayed in the left pane.

3. Click Add to include the required devices in the resource pool

Peering MX2-Lab-REQ = 192168.4695

1tm01.anutacorp.com = 17216460
Itm02.anutacorp.com = 17216.461 *
17216376 = 17216376

anabuf-ogw = 17216372

anabuf-2.gw

® Topology  Resource Pools  Network-Connections. O =
Bl - a
0
1 0 0 0

1l [ = Resourcepool | Devices | Offine Devices | Connections
-~ I LK
~ RS Status [

LJ  cowdw200celigwne @ 17216233

[0 enacbbkmicvodafone @ = 17216332
D O  enutachbrlab2 [ ] = 17216338

O enabufigunetdisne @ = 17216345

aancbb-anad-gw.netdic @ = 17216.3.46

O  anacdi-gwanutacop ] = 17216.334
PEN [ wnecrpdtssogqutest. @ = 17216340

O  Routernetdisney.com ] = 17216.3.48

[0 wbucbbbur1-gwnetd [ ] = 17216344

ana-buf-6-gw.anutacor] ] = 17216331

wnacrp-dtss-0-gw.net.c ] = 17216.330

O esnrass ° = 1617138

O sotlabi-59s [ ] = 17216595

O sevicesPEoCIabR @ = 1921684612 N

[m} [

[m} [ J

[m} [

[m} [

[m] [

[m} [

[m} [ ]

= s
~ i & =

test_enacc.anutacorp.

4. Select the device from the Drag and Drop the devices pane to the right pane All the
selected devices are now part of the resource pool created earlier.
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ology  Resource Pools  Network-Connections O i

Q
o | i

il Add devices C a

1-210f21

el (] neme Status P

[l O r7eobogn [ ) = 7216342
a = ° = 216340

D = ° — miese
[ ° = 21633 )

* D en . — 17216332 ‘wnacrp-dtss-0-gw.net.disney.com

. O ° = 21633 \\ :

i O - [ ) = 17216334 \\ * \
g w ) = 17216340 - \\\\\\\
[m} ° = 216348 —e
[m] ° — 7216344 /aancbb-anaﬂ-gw.net disney.com
g : - rea ana-buf-1-gw.net.disney.com

E = 172.16.17.135
(] [ ] = 17216595 -
m} ° —  1s21684012 )
a ° = s21684695 aa
m] D = mieas0 [
[m} ° = 7216460 N
[m] ° = 17216376
a ° = miean '
[m} ° = 216378 il '|= ° -
m 3 = 17216336 =
Locati
ocations

Devices & Resources Pools can be attached to a Physical Location. Location tagging allows
devices and resource pools to be visualized on a Geographical Map in topology view.

1. To Create/Edit a Location - Resource Manager > Locations > Resources-Location >click
Add Location

2. Inthe Create Location screen, enter values in the fields described:
e Name: Add the name of for the data center or the site that you want to create.

e Type: Select from the pre-defined location types from the drop-down menu.
(preferably select Site)

e Block: Enter the name of the block where the location is situated
e Building: Enter the name of the Building
e Street Number: Enter the number of the street where the Building is located
e Latitude: Enter the latitude of the site.
e Longitude: Enter the longitude of the site.
® Street: Enter the street name where the building is located.
o Country: Select a country from a pre populated list available in ATOM
o City: Select a specific city contained in the chosen country.
o State: Enter the name of the State or province to which the city belongs.
o Zip Code: Enter the zip code of the City where the Site is located.

o Parent Location: Select one of the predefined locations (of the type,
Region or Country) defined earlier.
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®R Create Location = [®, X °
o

Name o
ame of the locatio

o) Anuta

Q Type o

Site X v
Block

A-Block

Building
Anuta Residency
Street-Number
12

Street

For assigning the created Location to a Resource pool, refer to section, "Creating a
Resource Pool".

After the successful allocation of the Resource Pool to the given Location, you can view it on the
map. Select the created Resource Pool and click View on Map

Location Types
Add the types of the location that should be associated with a Location.
Navigate to Resource Manager > Locations > Location Types.

The default location types available in ATOM are Region, Country, and Data Center

® Resource-Locations  Location-Types

+ B o & » 30f3 | Search Q

Name A Owner Shared With Created-On Created-By Last-Modified-On Last-Modified-By

C
O county system system.* 2021-03-03 05:23:52.591 2021-03-03 05:23:52.591
O  Region system system.* 2021-03-03 05:23:52.591 2021-03-03 05:23:52.591

Site system system.* 2021-03-03 05:23:52.591 2021-03-03 05:23:52.591

IPAM
IP Address Pool Group

For effective management of IP addresses, you can arrange IP addresses as an ordered
collection and use them while instantiating a service.

1. Navigate to Resource Manager > IPAM > IP Address Pool Groups
2. Click Add IP Address Pool Group in the right pane
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3.

In the Create IP Address Pool Group screen, enter values in the fields:
a. Name: Enter the name of the IP address pool group
b. Label: Enter the name of the label that describes the IP address pool group
c. Click Add to add IP Address Pools to be included in the IP Address Pool Group

IP Address Pools

A range of IP addresses can be assigned to a pool and associated with a resourcepool.All these

IP addresses will be used during the instantiation of the service.

1. Navigate to Resource Manager > IPAM > IP4- Address Pools

2. Click Add IP Address Pool on the right pane and enter values in the following fields:

IPV4

Name: Enter a unique name for the IP address pool
CIDR: Enter the CIDR (IP address followed by a slash and number)
Description: Enter the description for the created IP Address Pool

Reuse: Select this option if the IP addresses contained in this pool should be reused
across different services.

Start IP:Enter the start IP address of the range of IP addresses
End IP: Enter the last IP address in the IP address range.

Resource Pool: Select the Resource pool to which these IP addresses should be assigned.
All the services that are created in these Resource Pools will use these IP addresses.

Creating IP address entries
IP Address entries are the IP Address Pools that have been reserved for a service.

e Click IP address pool > Action > IP address entries
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@ 1Pva Address Pools  IPv6 AdddressPools  Address-PoolGroups  Vlan-Pool-Groups.
cC + B o A A 10f1 | Search a
s
O neme 4 cidr Description Reuse Startip End-Ip Netmask Size Used Resour
i =G manes © 2552552550 256 2
fe!
>_

Creating Sub Chunks of the IP Address Pools

The network contained in an IP address pool can be divided into two or more networks within
it. The resulting sub chunks can be used for different services to be configured on a resource
pool tied with the parent IP address pool.

Create SubChunk

Ipaddresspooiname
ipv4_17216.0.0/24

Mask
Must bea vald Mask Range: /832, Ex /23

IPV6:

Resource Manager > IPAM > IP6- Address Pools
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a IPv4 Address-Pools IPv6 Adddress-Pools Address-Pool-Groups. Vlan-Pool-Groups
cC 4+ B o A » 1-500f1706 Page1 0735 > > | Search a
‘Q O neme 4 cidr Description Reuse Startlp End-ip size Used
il O  ronz001-apnicloopback 2405:00C0.0f00:0000:0/112 ® 65536 0
[ vLon2001-apnicptp127 2405:0DC0:0f00:0000:1:0/112 ® 65536 [
{:1 [0  Lonz001-arindoopback 2605:30C0:0f00:0000::0/112 ® 65536 10
O ronz00t-arinptp127 2605:30C0:0f00:0000:11:0/112 ® 65536 o
9 O  vonz001-arinptp127- 27 f00:1:0/127 b ipv6.net 2 1
o [0  Lon2001-ripedoopback 2A0E:BBCO:0f00:0000:0/112 ® 65536 [
O  ronz001-ipeptp127 2A0E BBC0:000:0000:1:0/112 ® 65536 4
O  Lon2002-apnicloopback 2405 2A0E:BBC0:0f00:0000:1:0/112 ® 65536 0
[  vLon2002-apnicptp127 2405:0DC0:0f00:1000:1:0/112 ® 65536 [
P[] Lonz002:arinoopback 2605:30C0:0f00:1000::0/112 ® 65536 9
O  ronz002arinptp127 2605:30C0:0f00:1000:11:0/112 ® 65536 o
O tonzoozarinptp127- 127 00:1000:1:0/127 b g ipve et 2 1
O tonz00zarinptp127- 127 00:1000:12/127 b ipvenet 2 1
O tonz00zarinptp127- an27 00:1000:1:4/127 b ipvenet 2 1
O  Lonz002-arinptp-127- 1127 30¢0:/00:1000:1:6/127 b di bdi2z.pve.net 2 1
[0  ron2002+ipeloopback 2A0EBBC0:0f00:1000:0/112 ® 65536 o
D LON2002-ripe-ptp-127 2A0E:BBC0:0f00:1000::1:0/112 ® 65536 0
[0  vLon2003-apnicloopback 2405:0DC0:0f00:2000:0/112 ® 65536 [
[  vLonzo0zapnicpp127 2405:0DC0:0f00:2000:1:0/112 ® 65536 0
[0  ronz003-arinoopback 2605:30C0:0f00:2000::0/112 ® 65536 9
O  ronz003arinptp127 2605:30C0:0f00:2000:11:0/112 ® 65536 o
[0  ron2003ipe-loopback 2A0EBBC0:0f00:2000:0/112 ® 65536 o
[0  Lon2003-ripeptp-127 2A0E:BBCO:0f00:2000:1:0/112 ® 65536 [
D LON2004-apnic-loopback 2405:0DC0:000:0000::0/112 ® 65536 0
[ LoN2004apnicptp127 2405:0DC0:0f00:3000:1:0/112 ® 65536 [
[0  LoN2004-2rinoopback 0530000/00.3000-0/11 R 65536 15

Address-pool-Groups

@& IPvd Address-Pools  IP6 Adddress-Pocls  Address-PookGroups  Vlan-Pool-Groups

> Address-Pool-Groups Information

C /s 1 ¥ sk @D Detasils  Entities

Name 4 Label Pool-Group-Type
Enter a keyword
ih Address pool

Ipaddress-Pools

VLAN Groups

You can define VLAN groups and VLAN pools and define them as resource boundaries for a
tenant in such a way that these VLAN Pools can be used during service instantiation on a
resource pool.

Adding VLAN Groups

1. Navigate to Resources > IPAM > VLAN Groups
2. In the right pane, click Add VLAN Pool Group

3. Inthe Create VLAN Pool Group screen, enter values in the following fields:
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e Name: Enter a name for VLAN Group

e Description:
4. Click Actions > vlan pools > vlan pool to create VLAN pools in the VLAN group:
5. Enter values in the following fields:

e Start VLAN: Enter a number from the valid VLAN range. (1-4096)

e End VLAN: Enter a number from the valid range (1-4096)

e Click Add to add the required resource pools to the VLAN Pools

e Click the vlan pool > click Actions to add allocated VLAN.

@® IPvd Address Pools  IPv6 Adddress-Pocls  AddressPool-Groups  Vlan-Pool Groups

% Vlan-Pool-Groups Information A
C 7/ 0§ # scdED Details Entities Pan |
!
D Name 4 Description
Enter & keyword.. Q
ih vian pool

Vian-Pools

javascriptvoid(0):
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Configuration Compliance

Configuration Compliance feature allows users to Define & Enforce Configuration Compliance
Standards. This is realized within ATOM using the following primitives.

1. Policies - Define Configuration standards & Remediation Policy by Device Family, Device
Type, OS Type etc.,

2. Profiles - Group multiple policies and apply configuration standards on one or more

devices

Reports - Comprehensive compliance reporting view at device level

4. Remediation - Fix Policy Violations on one or more devices

w

Following diagram summarizes the overall flow.

| | |
- Select One or Profiles Generate
Folicies more Policies & {Base, securily, Compliance Reporl
|i:aaa. qus._t;ba;ne? Create Logical [ wan-sacurity, Repart L | Zpk
INE-SOCUTTY ¥ Grouping L access-switch, eto, ) L]
Apply on [One
oF Mo E:I'_;”Ti n Review &
Devices pllance Sehect
| Remediation
]
Devices, Device Remediate -
Groups Viclatlons Remediation

ATOM supports Configuration Compliance for the following Vendors:

Cisco Systems
Juniper Networks
Fortinet

ForcelO Networks
Brocade

PaloAlto Networks
Riverbed Technology
F5 Networks

Policies

Compliance policy allows configuration standards to be defined in CLI format and YANG
format(x-path or xml). Following provides a high level overview of a Policy:

e Policy is a collection of Rules
e A Rule contains one or more Conditions
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e Condition describes
o Expected Configuration. Configuration can be parameterized through Rule

Variables.
o Action to be taken on a condition evaluation includes CLI commands or Netconf

XML RPC format to be used to remediate a violation.
® ARule can be attached to one or More device platforms - Vendor, OS Type, Device

Family, Device Type and OS Version

Create Policy

v

Create Policy
Rule(s)

v

Rule Basic
Information

v

Select Platform

Y

Provide Rule

Inputs
. Define
" Conditions/Actions

Palicy
Creation
Completed
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Use Cases

Configuration

Standard Style Example Reference

Example: All Devices in Target Network should Contain

a specific Domain Name
Static Expected Configuration: _

. . . . Scenariol

Configuration ip domain-name anutacorp.com

Fix Configuration:

<<If missing, configure the above command>>

Xpath Expression:
X—path. Cisco-10S-XR-native:native/ip/domain/name="anutacor | Scenario6
Expression , -

p.com

Template Payload:

<native

xmins="http://cisco.com/ns/yang/Cisco-I0S-XE-native"

>
XML Template <ip>
Payload . Scenarioll

<domain>
<name>net.disney.com</name>
</domain>
</ip>

</native>

Example: Devices in Target Network should have a

specific Loopback interface - LoopbackO or Loopback1

based on user input.
Dynamic
anflguratlon Expected Configuration: _
with User , ; . ; Scenario3
provided interface {{ interface_name }}
values

Fix Configuration:

<<If missing, Configure the specific Loopback

interfaces>>
X-path Xpath Expression: Scenario9
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Expression

Cisco-10S-XE-native:native/interface/Loopback/name="
0'and
Cisco-10S-XE-native:native/interface/Loopback[name=0
1/ip/address/primary/address='{{ lo0_ipv4addr }}' and
Cisco-10S-XE-native:native/interface/Loopback[name=0
1/ip/address/primary/mask="'255.255.255.255"' and
Cisco-10S-XE-native:native/interface/Loopback[name=0
1/ipv6/address/prefix-list/prefix="{{ lo0_ipv6addr }}'

Template Payload:
<native
xmlns="http://cisco.com/ns/yang/Cisco-10S-XE-native"
>
<interface>
<Loopback>
<ip>
<address>
<primary>
<address>10.100.99.98</address>
<mask>255.255.255.255</mask>

</primary>
XML Template </address> Scenariol3
Payload .
</ip>
<ipv6>
<address>
<prefix-list>
<prefix>2605:30C0::3B/128</prefix>
</prefix-list>
</address>
</ipv6>
<name>0</name>
</Loopback>
</interface>
</native>
Configuration | Example: All the VTY lines should have specific
with Patterns, | oo timeout and session-timeout configured.
Wildcards, Scenario4
etc.that

require Regular
expressions

Expected Configuration:
line vty (.*)
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session-timeout 10
exec-timeout 100

Fix Configuration:
<<If missing, Configure the timeouts under all matching
VTY lines>>

Configuration

Example: The physical Interface should not be shut
down and show be in auto-negotiation mode

Expected Configuration:
interface {{ interface_name }}

with no shutdown Scenario3
sub-modes negotiation auto
Fix Configuration:
<<If missing, Configure the above commands for one or
more interfaces>>
Example: Finding the Devices having extra ntp-server
addresses configured and removing those other than
expected server addresses.
Removing
unwanted Expected Configuration: Scenario?
extra ntp-server 10.1.1.1
configuration
Fix Configuration:
<< Configure above ntp-server if not found. Remove any
ntp server other than 10.1.1.1 >>
Example: Finding the devices in the network which
doesn’t contain the OSPF router-id configured as per
loopbackO ip address.
Advanced:
Pre_sence of an | Expected Configuration:
?rztr:yo\:\a;ubelock interface LoopbackO Scenario5
in another ip address 45.45.45.5 255.255.255.255

router ospf 100
router-id 45.45.45.5

Fix Configuration:
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router ospf 100
router-id 45.45.45.5

Scenario 1: IP Domain Name

Scenario: Network Devices must have domain name configured. In this example we are looking
for the domain name as anutacorp.com across all devices in the lab.

Platform:
Cisco 10S-XE

Expected Configuration:
ip domain-name anutacorp.com

Fix-CLI Configuration:
ip domain-name anutacorp.com

Follow the steps below to configure Compliance Policy for the above scenario.

1. Configure Policy

Steps:

e Navigate to Resource Manager > Config Compliance -> Policies

e Click ‘+" to create new Policy and provide the following information
o Policy Name
o Description

Add Policy

Policy Namee

IP_Domain_Name

Description

Check whether ip domain name is present in the
device or not

Create Policy
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2. Configure Rules

One or more rules can be configured to express configuration standards. Based on the
complexity of the scenario, configuration standards can be broken up into more than one
condition.

Steps:

e Navigate to Resource Manager > Config Compliance -> Policies
e Create/Select a Policy

® C(lick ‘+" to create new Rule

e ATOM opens up new wizard as shown below

Add Rule

Platform Selection Rule Variables Conditions and Actions

e Rule has four components
Basic Information
Platform Selection
Rule Variables
Conditions & Actions

o O O O

Basic Information

Provide basic information as described below. Information provided here is for documentation
purposes only.

Rule Name: Provide any Name
Description: Brief explanation of the configuration evaluation that the rule is going to perform.

Impact: If the device configuration does not meet the rule or rules in the policy, type it in the
Impact field.

Suggested Fix: Using which non-compliance can be corrected and device returns to a state of
Compliance.
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Edit Policy | IP_Domain_Name

Add Rule

Basic Information Platform Selection

Rule Names

Check_Ip_Domain_Name

Description

Check domain name for Cisco devices

Impact

If domain name is not present in the device. Device will be non-
compliant.

Suggested fix

ip domain name anutacorp.com

4

Platform Selection

Rules contain configuration standards expressed in CLI Configuration format. Configuration
standard can be at Vendor level, Device Type, Device Platform, OS Type or OS Version.

Steps:

e Navigate to Config Manager > Config Compliance -> Policies -> Rules
e Create/Select a Rule & Provide the following information

o Vendor

o OStype

o Device Family
o Device Type
o 0OS Version
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Add Platform ®

Vendorse

Cisco Systems A

08 type

Select v

Device family

Select v

Device type

Select v

08 version
ALL

Note: Platform Selection will be used during Policy execution. Devices that don’t match
the above criteria are skipped.

Note: It’s not common to have more than one Platform

Rule Variables
Rule variables allow configuration to be parameterized.

Steps:
o Navigate to Resource Manager > Config Compliance -> Policies -> Rules
® Create/Select a Rule Variables
o Key - Provide unique name to identify rule variable
o Description - Describe rule-input configuration
o Default Value - Default value. Can be overridden during Policy execution time

Conditions and Actions

Expected configuration & actions to be taken when violations are detected are specified in the
Conditions & Actions section.

Based on the complexity of the scenario, configuration standards can be broken up into more
than one condition.

Steps:
o Navigate to Resource Manager > Config Compliance -> Policies -> Rules
o Create/Select Conditions & Actions

o Condition Details - Described Below

o Action Details - Described Below

55



ATOM User Guide

Condition Details

Condition section provides users to specify the expected configuration and various options on
how to match the expected configuration including option to identify sub mode configuration
blocks.

| Conditions and Actions

Condition Details Action Details

Condition Names Values

Verify_IP_Domain_name
Sequence Numbers
1
Scope Details

Condition scope details

Configuration v

Block Options

Start Expression

Condition Match Criteria

Operator Launch Test Config

MATCHES_THE_EXPRESSION v

Rule-pass-criteria

All_SubBlocks v

Condition Name: Name of the Condition
Sequence Number : Order of the condition execution.

Scope Details
Condition scope details: Scope could be either full configuration copy or configuration
matched in prior condition.
e Configuration - Full Configuration
e Previously Matched Blocks - Subset of configuration matched by prior condition

Block Options
Start Expression - Regular expression indicating the start of the sub-block.
End Expression - Regular expression indicating the end of the sub-block.

Condition Match Criteria
Operator:
MATCHES_THE_EXPRESSION - Checks whether the condition value exactly matches with
device configuration or not.
DOESNOT_MATCHES_THE_EXPRESSION - Checks whether the condition value does not
match with the device configuration or not.
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CONTAINS_STRING - Checks whether the device configuration contains condition value
config or not.

Rule-Pass-Criteria:
All_SubBlocks - Checks whether the condition value matches in all the blocks or not.
Any_SubBlock - Checks whether the condition value matches in any of the blocks or not.

Value: Value field accepts Configuration Standard as CLI Configuration. Following types of
configuration can be provided:

Static Configuration

Dynamic/Parameterized Configuration
Configuration with Regular Expressions
Configuration coupled with Jinja2 Templating

Note: For some Vendor Configurations like Cisco 10S-Style, whitespace in command
prefix is mandatory to identify commands at sub-mode level.

For Scenario 1 - Provide value as ip domain-name anutacorp.com to search for a given domain
name in the running configuration.

Test Config

Based on the complexity of the configuration standard, Value may be complex and may need to
build up iteratively. Test Config utility helps the CLI configuration condition to be validated
against Test Configuration.

Steps:

Navigate to Resource Manager > Config Compliance -> Policies -> Rules ->
Create/Select Conditions & Actions

® C(lick “Launch Test Config” will launch a form to Test Condition
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Test Configuration and Results
Condition Match Operator: Rule Variables
MATCHES_THE_EXPRESSION
Value
ip domain-name anutacorp.com
Test Configuration Test Results
ip domain-name anutacorp.com {
"compliance-policies": {

"highest-severity*: ,
"rule-violation-count": 0,
"compliance-status™: "compliant’,
“compliant-rules-output’s
violated-conditions™: *,
"device-compliance-condition-output': {

"block-start-unmatched-content": "<![CDATA[]l>",

*block-start-condition-search-output': *<![CDATA[{\n \'block_start_matched_contents\" :[I\n}]}>",
“condition-search-output*: *<J[CDATA[{\n \'matched_contents\" : [J\n}]}>",
“total-block-count”: 1,

‘aggregated-condition-ouput’: "</[CDATA[{\n \'condition_contents\": [{\n ~\'condition_id\": null\n
\'block_start_matched_content\" : null,\n
V'matched_content\" : null\n } \n}]}>",

\"block_start_unmatched_content\": null\n \"unmatched_content\" : null\n

Condition Match Operator:
MATCHES_THE_EXPRESSION

DOESNOT_MATCHES_THE_EXPRESSION
CONTAINS_STRING

Value: Sample configuration to be tested. Value will be shown from the Condition Details. Value
can be further refined

Note: Any Edits to Value will reflect in the Condition Details -> Value and Vice-versa.
Test Configuration: Sample device configuration

Rule Variables: The rule variables created in the rule will be shown here with default values.
Values can be modified.

Note: Any Edits to Values will not be reflected in the Rule Variable default values
provided in Rule Variables Section.

Test Results: Based on Condition Match Operator test results will be shown on the right hand
side

Action Details

Action can be taken after Condition evaluation. Condition can result in either a “Match” or
“Non-Match”. Depending on the scenario one or both criteria may apply.
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Rule Variables Conditions and Actions

Details Action Details

Select Match Action Select Non-Match Action
Select action Select action
continue v continue v

Select Match Action - This option is applicable when Condition evaluates to a Match
Select action:
Continue - continue execution to next condition
Donot_raise_violation - skip execution and don’t raise violation
Raise_violation_and_continue - raise violation and continue execution to next conditions
Raise_violation - raise violation and skip execution

For Scenario 1, no action needs to be taken during a match condition, so select continue
as action.

Violation severity:
LOW
MEDIUM
HIGH
CRITICAL

Violation message type:
Default_violation_message
User_defined_violation_message

Derive fix cli commands:
Use_unmatched_block - unmatched config from the block
Use_matched_block - matched config from the block
Use_complete_block - total block config

Select Non-Match Action
Select action:
Continue
Don't raise violation
Raise violation and continue
Raise violation

For Scenario 1, Action is required when Condition is not matched. Select Raise violation
and continue.

Violation severity:
LOW
MEDIUM
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HIGH
CRITICAL

Violation message type:
Default_violation_message

User_defined_violation_message

Fix CLI: Provide the CLI Configuration to be used for remediation. Fix CLI can be either
provided here or derived.

Option - 1 - Explicit Remediation / Fix CLI
For Scenario 1, Provide “ip domain-name anutacorp.com” in Fix CLI.

Rule Variables Conditions and Actions
Condition Details Action Details @

Select Match Action Select Non-Match Action
Select action Select action
continue v Raise_violation v

Violation severity

CRITICAL v

Violation message type

Default_viclation_message v

Fix CLI

ip domain-name anutacorp.com

Derive fix cli commands

Select v

Option - 2 - Remediation Commands can be derived from Condition evaluation.

Derive fix cli commands:

Options below:
Use_unmatched_block
Use_matched_block
Use_complete_block

For Scenario 1, Select “Use_unmatched_block”. Since this is non-match Action,
unmatched_block will be Condition Details->Value and can be used as Fix CLI.
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Rule Variables Conditions and Actions
Condition Details Action Details @

Select Match Action Select Non-Match Action

Select action Select action

continue - Raise_violation_and_continue -

Violation severity
HIGH -

Violation message type

Default_violation_message v

Fix CLI

Derive fix cli commands

use-unmatched-block v

Scenario 2: NTP Server configuration check

Scenario:
1. All devices in the network should contain the designated ntp server.
2. Remove all other ntp servers
3. Inthis example
a. Expected ntp-server =10.0.0.1

Platform:
Cisco I0S-XE

Expected Configuration:
ntp server 10.0.0.1

Fix-CLI Configuration:
ntp server 10.0.0.1
<<Remove Any Other ntp server other than 10.0.0.1>>

This use case uses regular expressions and contains two conditions.

1. Condition-1 - Check for expected config & if not found remediate using Fix CLI.
Fix-cli Configuration :
ntp server 10.0.0.1

2. Condition 2- Check for unwanted ntp-servers and remove them.
Fix-cli Configuration :
no ntp server 10.0.0.2 //Derived
no ntp server 10.0.0.3 //Derived

Steps:
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e Navigate to Resource Manager > Config Compliance -> Policies
e Click ‘+" to create new Policy and provide the following information
o Policy Name - NTP_Common_Peer_Configuration
o Description
e Select the Policy and Click ‘+’ to create new Rule
o Rule Name - Check_NTP_Common_Peer_Configuration
o Navigate to Config Manager > Config Compliance -> Policies -> Rules
e Select a Rule & Provide the following information
o Vendor - Cisco Systems
OS type - IOSXE
Device Family - ALL
Device Type - ALL
OS Version - ALL
e Rule variables are not required for this scenario.
e Now fill the Conditions and Actions

o
o
o
(@]

Condition1

The Verify_NTP condition will check if the NTP server config is present in the device or not.

- Conditions and Actions

Condition Details Action Details

®

Condition Names Values
ntp server 10.0.0.1
Verify_NTP

Sequence Numbere
1 -

Scope Details

Condition scope details

Configuration v

Block Options

Start Expression

Condition Match Criteria

Operator 4
MATCHES_THE_EXPRESSION v
Launch Test Config

Rule-pass-criteria

All_SubBlocks v

Here Non-Match Action can be done either using the commands in Fix CLI or using the Derive fix
cli commands.
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e Using the Fix CLI user needs to provide the configuration commands manually.
e Using the Derive Fix CLI Commands user needs to select the use_unmatched_block as
shown below.

Rule Variables Conditions and Actions
Condition Details Action Details ®

Select Match Action Select Non-Match Action
Select action Select action
continue v Raise_violation_and_continue v

Violation severity

CRITICAL v

Violation message type

Default_violation_message v

Fix CLI

Derive fix cli commands

use-unmatched-block v

Here on Match Action it will Continue and on Non-Match Action the Derive fix cli commands
uses the use-unmatched-block to remediate the device.

Condition2

Remove_ NTP_Extra_Config condition will use the regex to match and capture the extra NTP
server ip configured in the device other than the expected ip.
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- Conditions and Actions
Condition Details ~ Action Details :

Condition Namee Valuee
ntp server (2110.0.0.1)(\d+\d+.\d+.\d+)
Remove_NTP_Extra_Config

Sequence Numbere

Scope Details

Condition scope details

Configuration v

Block Options

Start Expression

&
Condition Match Criteria
Operator 4
MATCHES_THE_EXPRESSION A
Rule-pass-criteria
All_subBlocks v

The extra NTP server ip captured will be stored in the backend data structure which is shown in
the Test Results tab.

Test Configuration and Results @

Condition Match Operator: Rule Variables
MATCHES_THE_EXPRESSION M
Value

ntp server (110.0.0.1)(\d#\d+\d#\d+)

Test Configuration Test Results

"compliant-rules-output’: {
"violated-conditions™: ™,
"device-compliance-condition-output”;
"block-start-unmatched-content™: <[CDATA]]>",

ntp server 10.0.0.1
ntp server 10.0.0.2
ntp server 10.0.0.3

put': \"block_start_matched_contents\": [{\n \'groups\":[{\n  \'index\"
1\n Vgrep_content\’:\"10.0.0.2"\n  V'grep_group\*: T\ }1\n },{\n \Vigroups\":[{\n  Vindex\":1,\n  V'grep_content\"
\"10.0.0.3\"\n  \'grep_group\": T\n }1\n } \n)]}>",

"condition-search-output’: ‘</[CDATA[{\n \'matched_contents\": [\ \'groups\':[{\n  \index\":\n  \'grep_content\":
\10.00.2VAn  Vgrep_group\': T\n }]\n ), (\n V'groups\": [{\n  \index\": 1\n  \'grep_content\":\"10.0.0.3\'\n
Vgrep_group\": 1} \n }I\ll>",

“otal-block-count’: 2,

*aggregated-condition-ouput’: *<[CDATAI(\n \'condition_contents\": [{\n ~\‘condition_id\": nulln
\'block_start_matched_content\": null\n  \'block _start_unmatched_content\" : null\n - \'unmatched_content\": nullAn
\'matched_content\": null\n } \n}f}>",

o "template-substituted-content": "<![CDATA[ntp server (?!10.0.0.1)(\\d+.\\d+.\\d+.\\d#)]}>", o

The captured data will be stored in the condition-search-output
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test-results

{

"compliance-policies™ { |
"highest-severity": ™,
"rule-violation-count": 0,
"compliance-status”: "compliant”,
"compliant-rules-output™: {
"violated-conditions": ™,
"device-compliance-condition-output™: {

"block-start-unmatched-content": "<![CDATA[]>",

"block-start-condition-search-output”: "<!/[CDATA[{\n \"block_start_matched_contents\": [{\n \"groups\": [
f\n  \index\":1\n  \"grep_content\":\"10.0.0.2\"\n  \"grep_group\": 1\n  }]\n }, {\n \'groups\": [{\n
Vindex\": 1\n  \'grep_content\" :\"10.0.0.3\"\n  \'grep_group\": 1\n }]\n }\n}]]>",

"condition-search-output": "<![CDATA[{\n \'matched_contents\":[{\n \'groups\":[{\n  \'index\": 1\n
\"grep_content\" : \"10.0.0.2\"\n  \"grep_group\":1\n }]\n },{in \'groups\":[{\n  V'index\"':1,\n
\"grep_content\": \"10.0.0.3\"\n  \"grep_group\": 1\n }]\n } \n}]]>",

"total-block-count"; 2,

"aggregated-condition-ouput™ "<![CDATA[{\n \"condition_contents\":[{\n \"condition_id\" : null,\n
\"block_start_matched_content\" : null,\n \"block_start_unmatched_content\" : null,\n \'unmatched_content\":
nullAn  \"matched_content\" : null\n } \n}]]>",

"template-substituted-content": "</[CDATA[ntp server (?!10.0.0.1)(\\d+\\d+.\\d+.\\d+)]]>",

"block-unmatch-count™ 0,

"cli-match-output”; "<![CDATA[ntp server 10.0.0.2\nntp server 10.0.0.3\n]]>", |

] "condition-status™ true,

"unmatched-content™ "<!/[CDATA[]>",

"id"; "Remove_NTP_Extra_Config",

"block-match-count™ 2,

"cli-unmatch-output": "<![CDATA[]]>"

L
"name”: "test-condition”,

"failed-conditions™
}
}
}

AL
ar

A

On Match Action write a jinja2 configuration template to remove the extra ip’s captured using
the above test-result data structure.

65



ATOM User Guide

Edit Policy | NTP_Common_Peer_Configuration

Edit Rule | Check_NTP

Basic Information Platform Selection Rule Variables Conditions and Actions

Conditions and Actionse

ondition Detail Action Details
C / W Selected @ 2012 search Q - @
Select Match Action Select Non-Match Action
Condition Name Select action Select action
[ Verify_NTP Raise_violation continue

Remove_NTP_Extra_Con... Violation severity

CRITICAL

Violation message type

Default_violation_message

Fix CLI

{% for content in matched_contents -%}
{% for group in content['groups’] -%}

no ntp server {{ group[‘grep_content] }}
{%- endfor %}

{% endfor %}

Derive fix cli commands

Select

Finally if different NTP servers are present on the device, for Non-Compliant device Fix CLI will
show up as below

ntp server 10.0.0.1
no ntp server 10.0.0.2
no ntp server 10.0.0.3

Scenario 3: Interface configuration check

Scenario: All devices in the network should have a specific interface in no shutdown state with
auto negotiation enabled. The interface block can have extra configuration commands under it
but should be in no shutdown state and auto negotiation enabled.

Platform:
Cisco 10S-XE

Expected Configuration:
interface {{ interface_name }}
no shutdown
negotiation auto
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Fix-CLI Configuration:
interface {{ interface_name }}
no shutdown
negotiation auto

This use case is an interface block configuration having rule variables. In this use case as no
shutdown is generally not visible on device running config, we will check whether the interface
is in shutdown or not. If shutdown it will remediate to no shutdown.

Steps:
e Navigate to Resource Manager > Config Compliance -> Policies
e Click ‘+" to create new Policy and provide the following information
o Policy Name - Interfaces
o Description
e Select the Policy and Click ‘+’ to create new Rule
o Rule Name - Check_Interfaces
o Navigate to Config Manager > Config Compliance -> Policies -> Rules
® Select a Rule & Provide the following information
o Vendor - Cisco Systems
OS type - IOSXE
Device Family - ALL
Device Type - ALL
OS Version - ALL
e Now create the Rule variables for this scenario.

(@]
o
O
o

Edit Policy | Interfaces

Edit Rule | Check_Interfaces

Basic Information Platform Selection Rule Variables Conditions and Actions

Rule Variables

|:| Key Description Default Value
D interface_name GigabitEthernets
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- Conditions and Actions
Condition Details  Action Details :

Condition Names Values
interface {{interface_name }}
Verify_Interface no shutdown

negotiation auto

Seguence Numbere

4r

1

Scope Details

Condition scope details

Configuration v

Block Options

Start Expression

Condition Match Criteria

Operator “

CONTAINS_STRING v
Launch Test Config

Rule-pass-criteria
Any_SubBlock v

In the policy we will have a jinja rule variable interface_name. Here Verify_Interfaces condition
will check if the interface block config is present in the device or not and under that interface if
no shutdown and negotiation auto is present.

For Scenario3 Condition Match Operator as CONTAINS_STRING will check whether the device
configuration contains condition value or not. If device configuration contains value, the result
will be Compliant, else Non-Compliant.
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Test Configuration and Results

Condition Match Operator: Rule Variables
CONTAINS_STRING v
Value

interface {{ interface_name }}
shutdown

negotiation auto

interface_name: GigabitEthemet5

Test Configuration Test Results
interface GigabitEthemet5 {
description TEST
ip address 94.1.1.9 255.255.255.252
shutdown

"compliance-poli
negotiation auto

*highest-severity

"rule-violation-count": 0,
"compliance-status": "compliant’,
"compliant-rules-output”: {
"violated-conditions": *,
"device-compliance-condition-output’: {

"block-start-unmatched-content': *<![CDATA[]>",

"condition-search-output’s *<![CDATA[{\n \'matched_contents\": [ \n}lJ>",
"total-block-count™: 1,

"aggregated-condition-ouput’: '<J[CDATA[(\n \'condition_contents\":[{\n ~\'condition_id\" : null\n
\'block_start_matched_content\": nullAn ~ \'block_start_unmatched_content\" nuli\n  \'unmatched_content\": null\n
\'matched_content\": null\n } \n}f}>",

Here on Non-Match Action select Continue and on Match Action add Fix cli commands to
remediate on the device

Rule Variables Conditions and Actions

Condition Details Action Details

Select Match Action

Select Non-Match Action
Select action

Select action
Raise_violation

continue
Violation severity

v
CRITICAL

Violation message type
Default_violation_message v
Fix CLI

interface {{ interface_name }}
no shutdown

negotiation auto

il
Derive fix cli commands

Select

For Non-Compliant devices Fix CLI will show up later-on as below.

interface GigabitEthernets
no shutdown

negotiation auto
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Scenario 4: Enforce VTY Session Timeouts

Scenario: All devices in the network should contain the network admin preferred VTY
session-timeout and exec-timeout on all vty lines. If VTY session-timeout and exec-timeout is
not configured on the device or mis-match with the network admin preferred timeouts, ATOM
CLI compliance can configure the devices with the user preferred VTY timeouts on all the vty
lines.

In this example we are considering the VTY session-timeout and exec-timeout as 10 sec.

Platform:
Cisco 10S-XE

Expected Configuration:
line vty (.*)
session-timeout 10
exec-timeout 10 10

Fix-CLI Configuration:
line vty <>
session-timeout 10
exec-timeout 10 10

This use case is using the regex and rule variables and uses jinja2 template for fix-cli
configuration.
Steps:
e Navigate to Resource Manager > Config Compliance -> Policies
® C(lick ‘+" to create new Policy and provide the following information
o Policy Name - Enforce_VTY_Session_Timeouts
o Description
e Select the Policy and Click ‘+” to create new Rule
o Rule Name - Check_Enforce_VTY_Session_Timeouts
o Navigate to Resource Manager > Config Compliance -> Policies -> Rules
e Select a Rule & Provide the following information
o Vendor - Cisco Systems
o OS type - IOSXE
o Device Family - ALL
o Device Type - ALL
o OS Version - ALL
® Now create the Rule variables for this scenario.
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Edit Policy | Enforce_VTY_Session_Timeouts

Edit Rule | Check_vty_session_timeouts

Basic Information Platform Selection Rule Variables Conditions and Actions

Rule Variables

|:| Key Description Default Value
D exec_timeout 10
[ session_time.. 10

Here created user defined rule variables vty_exec_timeout and vty_session_timeout with
default timeout as 10. These rule variables will be used in the condition value.

The verify_session_exec_timeouts condition will check whether the device in the network is
configured with user preferred VTY timeouts or not.

- Conditions and Actions
Condition Details  Action Details :

Condition Namee Valuee
line vty (%)
verify_session_timeouts session-timeout {{ session_timeout }}

exec-timeout {{ exec_timeout }} 0

Sequence Numbers

1 2

Scope Details

Condition scope details

Configuration )

Block Options

Start Expression

Condition Match Criteria

Operator .

CONTAINS_STRING ~

Rule-pass-criteria

All_SubBlocks v

Here under Condition Match Criteria the Operator used was CONTAINS_STRING to check for
session-timeout and exec-timeout in line vty config.

Here Rule-pass-criteria used All_SubBlocks to check the condition config in all line vty
configurations of the device. If all the line vty is matching with the condition then compliant. If
any of the line vty is not matching then non-compliant.
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The launch Test Config will check values with the Test configuration and gives the Test Result
whether compliant or not.

Test Configuration and Results

Condition Match Operator: Rule Variables
CONTAINS_STRING
Value

session_timeout: 10

exec_timeout: 10
line vty (*)

session-timeout {{ session_timeout }}
exec-timeout {{ exec_timeout }} 0

Test Configuration Test Results
line vty 0 4 “unmatched-content': ‘<[CDATAI{\n \'unmatched_contents\": [\ \'groups\':[{\n \index\":1\n  \'grep_content\":
sessiontimeout 5 \04V\n  Vgrep_group\": T\n }]\n ,{\n \'groups\":[{\n \iindex\":1,\n  \'grep_content\":\'5 98V"\n  \'grep_group\"
access-class ssh-permit-acl in T\n }\n }Nnjll>",
exectimeout 50
privilege level 15

“id": "verify_session_timeouts’,

"block-match-count': 0,
transport input ssh

“li h-output’: *<![CDATA[line vty 0 4\n 5\n I h-permit-acl in\n i 50\n
line vty 5 98 privilege level 15\n transport input ssh\nline vty 5 98\n 5\n P in\n 50\n
session-timeout 5 privilege level 15\n transport input sshn]}>"
access-class ssh-permit-acl in
exec-timeout 50

privilege level 15

“name’: "test-condition’,
transport input ssh

"failed-conditions”: ™

h

"compliance-status": "non-compliant™

Here the unmatched line vty will be captured and stored in the backend data structure. The
captured data structure maximizes the view shown below.
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test-results

{
"compliance-policies™ {
"highest-severity": ™',
"rule-violation-count": 0,
"noncompliant-rules-output™ {
"violated-conditions™; ™',
"device-compliance-condition-output”: {

"block-start-unmatched-content™ "<!/[CDATA[]>",

"block-start-condition-search-output"; "<![CDATA[]]>",

"condition-search-output": "<!/[CDATA[{\n \"matched_contents\": [ J\n}]]>",

"total-block-count™ 2,

"aggregated-condition-ouput”: "<![CDATA[{\n \"condition_contents\":[{\n \"condition_id\": null,\n
\"block_start_matched_content\" : null\n \"block_start_unmatched_content\" : null\n \"unmatched_content\":
null\n  \"'matched_content\": null\n } [\n}]]>",

"template-substituted-content": "<![CDATA[line vty (.*)\n session-timeout 10\n exec-timeout 10 0]]>",

"block-unmatch-count™ 2,

"cli-match-output”: "<![CDATA[]]>",

"condition-status™ false,

"unmatched-content™ "<![CDATA[{\n \"'unmatched_contents\":[{\n \"groups\":[{\n  \"index\":1,\n
\'grep_content\" :\"0 4\"\n  \'grep_group\": T\n }[\n }, {\n V'groups\":[{\n  Vindex\":1\n
\"grep_content\": \"5 98\"\n  \'grep_group\": 1\n }]\n } \n}ll>",

"id": "verify_session_timeouts",

"block-match-count™: 0,

"cli-unmatch-output”; "<![CDATA[line vty 0 4\n session-timeout 5 \n access-class ssh-permit-acl in\n exec-
timeout 5 0\n privilege level 15\n transport input sshinline vty 5 98\n session-timeout 5 \n access-class ssh-
permit-acl in\n exec-timeout 5 0\n privilege level 15\n transport input ssh\n]]>"

h
"name”: "test-condition”,

"failed-conditions":
h
"compliance-status”: "non-compliant”
}
}

4L
ar

On Match action will continue and on Non-Match Action fix-cli will use the jinja2 template

configuration written based on the above captured data structure.
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Rule Variables Conditions and Actions
Condition Details Action Details ®

Select Match Action Select Non-Match Action
Select action Select action
continue v Raise_violation v

Violation severity

CRITICAL v

Violation message type

Default_violation_message v

Fix CLI

{% for content in unmatched_contents %}
{% for group in content['groups’] %}

line vty {{ group['grep_content’] }}
session-timeout {{ session_timeout }}
exec-timeout {{ exec_timeout }} 0

exit

{% endfor %}

{% endfor %}

Derive fix cli commands

Select v

The Non-compliant device fix-cli configurations derived from above jinja2 snippet will look like
below.

line vty 0 4

session-timeout 10

exec-timeout 10 0
exit

line vy 5 98
session-timeout 10
exec-timeout 10 0
exit

Scenario 5: Enforce OSPF Router Id as LoopbackO

Scenario: All devices in the network should contain the OSPF router-id configured with
loopbackO ip address. If OSPF router-id is not configured on the device it will configure the OSPF
router-id with the value of loopbackO0 ip address on the devices.

Platform:
Cisco 10S-XE
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Expected Configuration:
interface LoopbackO
ip address 45.45.45.5 255.255.255.255
!
router ospf 100
router-id 45.45.45.5

Fix-CLI Configuration:
router ospf 100
router-id 45.45.45.5

This use case is using the regex and contains two conditions.

1. First condition is to capture and store loopbackO ip address. It will not have a fix-cli
configuration as the intention of the condition is to capture loopbackO ip address.
Fix-cli Configuration :
<< no fix cli configuration >>

2. Second condition will check whether the OSPF router id is the same as the first
condition's captured loopbackO0 ip address or not. if not matching then it will configure
the OSPF router id with loopback0.

Fix-cli Configuration :
router ospf 100
router-id 45.45.45.5
Steps:
e Navigate to Resource Manager > Config Compliance -> Policies
e Click ‘+" to create new Policy and provide the following information
o Policy Name - Enforce_OSPF_Router_Id_as_Loopback
o Description
e Select the Policy and Click ‘+’ to create new Rule
o Rule Name - Check_OSPF_Router_ld_Cisco
o Navigate to Resource Manager > Config Compliance -> Policies -> Rules
® Select a Rule & Provide the following information
o Vendor - Cisco Systems
o  OS type - IOSXE
o Device Family - ALL
o Device Type - ALL
o OS Version - ALL
e Rule variables are not required for this scenario.
o Now fill the Conditions and Actions
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Edit Policy | Enforce_OSPF_Router_ld_as_Loopback

Edit Rule | Check_OSPF_Router_Ild_Cisco

Basic Information Platform Selection Rule Variables Conditions and Actions

Conditions and Actionse

c +

Condition Name

O
D Verify_Loopback0_lp
O

Verify_OSPF_Router_Id_as_Loopback

Condition1

- Conditions and Actions

Condition Details  Action Details

D

Condition Namee Valuee
C Name, can co g . interface Loopbacko
Verify_Loopback0_lp ip address (\d+\d+\d+ \d+) (\d+\d+\d+\d+)

Sequence Numbers

1

ar

Scope Details

Condition scope details

Configuration v

Block Options

Start Expression

Condition Match Criteria

Operator
CONTAINS_STRING ~

Rule-pass-criteria

Any_SubBlock v
4

Launch Test Config

Another way of writing the above block configuration using the Block Options Start Expression
is shown below.
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The first line “interface Loopback0” can be written in the start Expression with regex symbol »
to indicate the block starts with interface Loopback0. The remaining configuration lines can be
written in value.

Condition Details Action Details

®

Condition Names Values
ip address (\d+.\d+\d+\d+) (\d+.\d+\d+.\d+)
Verify_Loopback0

Sequence Numbere
1 a

Scope Details

Condition scope details

Configuration v

Block Options

Start Expression

*interface Loopback0

Condition Match Criteria

Operator “

MATCHES_THE_EXPRESSION ~

Rule-pass-criteria
All_SubBlocks v

The launch test config will check the condition value with the Test configuration and will give

the Test Result. Here the captured loopbackO ip address will be stored in the backend data
structure as shown below.
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Test Configuration and Results

Condition Match Operator: Rule Variables
CONTAINS_STRING

Value

interface Loopbackd
ip address (\d+\d+\d+\d+) (\d+\d+\d+\d+)

Test Configuration Test Resuits
; “highest-severity’
“rule-violation-count’: ,
interface Loopback0 “compliance-status": "compliant’,
1 address 45.45.45.5255255.255.255 “compliant-rules-output” {
“violated-conditions
interface Loopbackl “device-compliance-condition-output’: {
o address “block-start-unmatched-content': “<[CDATA[>",
interface Loopback200 8

ip address 94.1.1.1 255.255.255.255
'

\'matched_contents)
Vgrep_group\": 1\n ), {\n  \'index\": 2\n

“condition-search-output': *<[CDATA[(\n
\'45.45.45.5\"\n

20 }\n I,
“total-block-count’ 1,

\index\
\'grep_content\" : \"255.255.255.255\"\n

\"grep_content\"
\'grep_group\':

“aggregated-condition-ouput": "<[CDATA[{\n \"condition_contents\": [{\n \"condition_id\" : null\n
\'block_start_matched_content\": null\n ~ \'block_start_unmatched_content\': null\n - \'unmatched_content\": null\n
. \'matched_content\" : nuil\n } \n}]J>*,

Loopback0\n ip address (\\d+.\\d+.\\d#-\d#) (Wd+\d+\d+ )],

The Test result in maximize view is shown below. This output will be used in condition2.
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test-results

{
"compliance-policies”: {
"highest-severity": ™",
"rule-violation-count”: 0,
"compliance-status": "eompliant”,
"compliant-rules-output": {

"violated-conditions™ ™",

"device-compliance-condition-output”; {

"block-start-unmatched-content"; "</[CDATA[]>",

"block-start-condition-search-output": "<![CDATA[]]>",

"condition-search-output”: "<!|[CDATA[{\n \"'matched_contents\":[{in \"groups\':[{\n  \'index\":1\n
\'grep_content\": \"45.45.45.5\"\n  \"grep_group\": 1\n },{\n  V'index\":2\n \'grep_content\":
\"255.255.255.255\"\n  V'grep_group\": 2\n }]\n }\n}j]>",

"total-block-count”; 1,

"aggregated-condition-ouput™ "</[CDATA[{\n \"condition_contents\": [ {\n \'condition_id\" : null,\n
\"block_start_matched_content\" : null,\n \"block_start_unmatched_content\": null,\n \'unmatched_content\":
nullAn  \"matched_content\" : null\n } \n}]]=",

"template-substituted-content": "<![CDATA[interface LoopbackO\n ip address (\\d+.\\d+.\\d+.\\d+)
(\Wd+\\d+ \d+A\Nd4+)]]=",

"block-unmatch-count™ 0,

"cli-match-output™ "<![CDATA[interface LoopbackO\n ip address 45.45.45.5 255.255.255.255\n]]>",

"condition-status™; true,

"unmatched-content™ "<![CDATA[{\n \"unmatched_contents\": [ \n}]]>",

"id"; "Werify_Loopback0_lp",

"block-match-count™ 1,

"cli-unmatch-output"; "<![CDATA[]]>"

b

"name”: "test-condition”,

m.

"failed-conditions";

'
'
}

ok
ar

For Non-Match Action violation is being raised and fix-cli is having no commands as this
condition is to capture the loopbackQ ip.

79



ATOM User Guide

Rule Variables Conditions and Actions

Condition Details Action Details ®
Select Match Action Select Non-Match Action
Select action Select action
continue v Raise_violation v
Violation severity
CRITICAL A
Violation message type
Default_violation_message v
Fix CLI
e
Derive fix cli commands
Select v
Condition2

The Verify_OSPF_Router_Id_as_Loopback condition will check whether the OSPF router id is the
same as the first condtion's captured loopbackO ip address or not. if not matching then in fix-cli
it will configure the OSPF router id with loopbackO.
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- Conditions and Actions

Condition Details Action Details

O 0

Condition Names Values

e ! P router ospf (*)

Verify_OSPF_Router_Id_as_Loopback router-id {{ condition_contents[0]['matched_content"]'matched_contents™][0]["groups][0]["grep_content™] }}
Sequence Numbers

1 =

Scope Details

Condition scope details

Configuration ~

Block Options

Start Expression

Condition Match Criteria

Operator #

CONTAINS_STRING hd
Launch Test Config

Rule-pass-criteria

All_subBlocks v

On Match Action it will continue. On Non-Match Action it will use the jinja2 template
configuration in fix-cli to configure the OSPF router id with loopbackO0 ip.

Rule Variables Conditions and Actions
Cendition Details Action Details @ :

Select Match Action Select Non-Match Action
Select action Select action
continue v Raise_violation v

Violation severity

CRITICAL A

Violation message type

Default_violation_message v

Fix CLI

{% for content in unmatched_contents %}

{% for group in content['groups”] %}

router ospf {{ group['grep_content'] }}

router-id {{ condition_contents[0]['matched_content’]
['matched_contents"][0]["groups"][0]["grep_content’] }}
exit

{% endfor %}

{% endfor %}

Derive fix cli commands

use-unmatched-block v
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The Non-compliant device fix-cli configurations from the jinja2 template configuration is given
below.

Fix Configurations

router ospf 100
router-id 45.45.45.5
exit

Scenario 6: BGP TTL Hop-count

Scenario: All devices in the network should contain the network admin preferred BGP
ttl-security hops. If hops is not configured on the device or mis-match with the network admin
preferred ttl-security hops, ATOM CLI compliance can configure the devices with the user
preferred hops.

In this example we are considering the ttl-security hops as 5.

Platform:
Cisco 10S-XE

Expected Configuration:
router bgp 65535
bgp log-neighbor-changes
neighbor 2.3.2.6 ttl-security hops 5

Fix-CLI Configuration:
router bgp 65535
bgp log-neighbor-changes
neighbor 2.3.2.6 ttl-security hops 5

This use case is using the regex and rule variables and contains two conditions.

1. First condition is to match the block. It will not have a fix-cli configuration as the
intention of the condition is to match the block.
Fix-cli Configuration :
<< no fix cli configuration >>

82



ATOM User Guide

2. Second condition will check whether the BGP ttl-security hops is in the first condition's
matched block or not. if not matching in the block then it will configure the BGP hops.
Fix-cli Configuration :
router bgp 65535

neighbor 2.3.2.6 ttl-security hops 5

Steps:
o Navigate to Resource Manager > Config Compliance -> Policies
e Click ‘+" to create new Policy and provide the following information
o Policy Name - BGP_TTL_Hop_Count
o Description
e Select the Policy and Click ‘+’ to create new Rule
o Rule Name - Check_BGP_TTL
o Navigate to Resource Manager > Config Compliance -> Policies -> Rules
® Select a Rule & Provide the following information
o Vendor - Cisco Systems
OS type - IOSXE
Device Family - ALL
Device Type - ALL
OS Version - ALL
Now create the Rule variables for this scenario.

o O O O

Edit Policy | BGP_TTL_Hop_Count

Edit Rule | Check_BGP_TTL

Basic Information Platform Selection Rule Variables

Rule Variables

c +

O ey Description Default Value

O asn 65535

O hops 5

[0  neighbor 1111
Condition1

The first line “router bgp (.*)” to be written in the start Expression with regex to indicate the
block starts with router bgp. The remaining configuration lines can be written in value.
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Edit Policy | BGP_TTL_Hop_Count

Edit Rule | Check_BGP_TTL

Basic Information > Platform Selection Rule Varizbes > condii ctions
Conditions and Actionse Condition Details Action Details
C /B sdecied @B 2072] Enierabeyword Q — @
Condition Name. Sequence Numbsr Condition Names Values
Verify_86P 1 bgp lognelghbor-changes

Verify BGP
O  wify_BGP_TTL 1 7

Sequence Numbere

Scope Details

Condition scope detais

Configuration v

Block Options

Start Expression
outer bp (+)

Condition Match Criteria

Operator 4

GONTAINS_STRING v
Launch Test Gonfig

Rule-pass-ciiteric

Any_SubBlock v

On Match Action execution continues to the next condition. On Non-Match Action it will raise a
violation and continue next condition. The “Fix-CLI” for the condition was written based on the
test results obtained from “Launch Test Config”.

When the start Expression is used the regex captured data will be stored in
“condition_contents” of “aggregated-condition-ouput” in test results.

Test Configuration And Results  Netconf Payload To Restconf Plan

Test Configuration and Results @

Condition Match Operator: Rule Variables

GONTAINS_STRING v
asn: 65535
neighbor: 11.1.1
Value
hops: 5

bap log neighbor-changes

Test Configuration asinenity
router bgp 65535 {
bgp log neighbor-changes “compliance-policies”
"highest-severity': ",
“rule-violation-count': 0,
“compliance-status "compliant’,
“compliant-rules-output
"Violated-condition:
*device-compliance-condition-output’:
"block-start-unmatched-content': *<|[CDATA[{\n \"block_start_unmatched_contents\": [\n}]]>",
"block-start-condition-search-output’: ‘<{[CDATAK(\n \'block_start_matched_contents\":[{\1 \'groups\”:[{n  Vindex\" : 1\n
\'grep_content\" : '65535V,\n  \'grep_group\": 1\n }1\n }nlll>,
“condition-search-output": "<[[CDATA[{\n \'matched_contents\": [ \n)]J>",
"total-block-count’: 1,
*aggregated-condition-ouput’; “<J[CDATA[\n \'condition_contents\" :[{\n \"condition_Id\’ : \'Verify_BGP\'\n -

o \'block_start_matched_content\":{\n  \'block_start_matched_contents\": [(\n  \'groups\':[{\n  Vindex\":1\n
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test-results

{

“compliance-policies": {
"highest-severity™ ",
"rule-violation-count™ 0,
"compliance-status”: "compliant”,
"compliant-rules-output”: {

"violated-conditions™ ",
"device-compliance-condition-output™: {

"block-start-unmatched-content™ "<|[CDATA[{\n \'block_start_unmatched_contents\": [ [\n}]]=",

"block-start-condition-search-output™ "<I[CDATA[{\n \'block_start_matched_contents\": [{\n \"groups\":[{\n
\index\":1\n  \'grep_content\":\"65535\"\n  \"grep_group\": 1\n }]\n } I\n}]]=",

"condition-search-output™: "<I[CDATA[{\n \"matched_contents\": [ J\n}]]>",

"total-block-count™ 1,

"aggregated-condition-ouput™ "<![CDATA[{\n \"condition_contents\":[{\n \"condition_id\" : \"Verify_BGP\"\n
V"block_start_matched_content\": {\n  \'block_start_matched_contents\": [{\n  \'groups\":[{\n Vindex\": 1,\n
\"grep_content\" : \"65535\",\n V'grep_group\":T\n  }1\n }In bwn \'block_start_unmatched_content\" : {\n
\"block_start_unmatched_contents\": [[\n }\n \unmatched_content\": {\n  \"unmatched_contents\": [I\n }\n
\"'matched_content\": {\n  \"'matched_contents\": [\n }\n }\n}]]=",

"enforcement-time™ 1597311923441,

"condition-input”: "<!|[CDATA[bgp log-neighbor-changes]]>",

"template-substituted-content™ "<I[CDATA[bgp log-neighbor-changes]]>",

"bleck-unmatch-count™ 0,

"cli-match-output”: "<I[CDATA[router bgp 65535\n bgp log-neighbor-changes\n]]>",

"condition-status™: true,

"unmatched-content”: "<I[CDATA[{\n \'unmatched_contents\": [ I\n}]]>",

"id": "Verify_BGP",

"block-match-count™: 1,

"cli-unmatch-output™: "<I[CDATA[]>"

b
"name": "test-condition”,
"failed-conditions™ ™
}
}
}

ok
ar
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Basic Information Platform Selection Rule Variables Conditions and Actions

Conditions and Actionse Condition Details  Action Details

C /7 W selected @ 202 Enterakeyword Q —_— @
. Select Match Action Select Non-Match Action
Condition Name Sequence Number
Verty 8o E Select action Select action
continue v Raise_violation_and_continue v
O  VerifyBGP_TTL 1

Violation severity

CRITICAL v

Violation message type

Default_violation_message v

Fix CLI

bap router {{ condition_contents[0][ block_start_matched_content]
[block_start_matched_contents][0][groups][o][grep_content] }}
bgp log-neighbor-changes

Derive fix cli commands

use-unmatched-block v

Condition2

The Verify_BGP_TTL condition will check whether the router bgp block config matched in the

previous condition has the ttl-security hops or not. if not matching then in fix-cli it will configure
the ttl-security hops.

This condition uses the condition scope details as Previously_Matched_Blocks to check on
previous condition matched block.

Edit Rule | Check_BGP_TTL

Basic Information Platform Selection Rule Variables Conditions and Actions

Conditions and Actionse Condition Details ~ Action Detals

C 7/ W selected @ 20f2 Enterakeyword Q @
Condition Name Sequence Number Condition Namee D
[ VerifyBGP 1 neighbor {{ neighbor )) ttl-security hops {{ hops }}
Vrify_BGP_TTL.
Vrify_BGP_TTL 1

Sequence Numbere

B N

Scope Details

Condition scope details

Previously_Matched_Blocks M
4
Condition Match Criteria
Operator
CONTAINS_STRING v

Rule pass-criteria

Any_SubBlock v

4

Launch Test Config
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Basic Information Platform Selection Rule Variables Conditions and Actions

Conditions and Actionse Condition Details  Action Detalls

C /W selected () 2012 Enterakeyword a
Select Match Action Select Non-Match Action
Condition Name Sequence Number
D Verify_BGP 1 Select action Select action
continue v Raise_violation
Verify_BGP_TTL 1

Violation severity
CRITICAL

) Violation message type

Defauit violation_message

Fix CLI

bop route olr
[block_st
neighbo

block_start matched_content]
o] groupsTlOllgrep_content] }}
ty hops {{ hops }}

Derive fix cli commands

use-unmatched-block

YANG Compliance

Note: In order to use Yang Compliance make sure that the config-snapshot is provided in the
Credential profile, which lets ATOM to parse the configuration and store it. For more
information on Credential profile please refer to credential profile section in ATOM User guide.

For Yang based Configuration Compliance, make sure to select the option of Inventory_Data for

Condition scope during Compliance Policy creation. This gives two ways of defining the
Condition Match Criteria

® Xpath Expressions
e XML Template Payload

Policy creation with Xpath Expressions

e Within Condition Match Criteria select “Matches_the_Xpath_Expression”
/”Doesn’t_Matches_the_Xpath_Expression” option for Inventory Operator field

e The Fix Mutation Payload is in Netconf xml RPC format written using the XML template
details for the yang parsed entities.

Navigate to Resource Manager > Config Compliance > Policy > + (Add Policies)
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* Edit Policy | Yang Based Policy

‘&-mandatory information Edit Rule | Rule1
IQ

Policy Namee Platform Selection
il e — i

[ o C 4+ 101 search a —_— @@
o Description

Description of the policy O  condition Name Condition Namee Xpath Expressione
can cont dns:d

Create yang based on Policy

[0  Domain_name_check =192.168.20.1' and dns:dns-

name-server-check server/name-server/server ='192.168.20.2|
0D <

y Scope Details

Condition scope details

> Inventory_Data
Condition Match Criteria

Inventory Operator
MATCHES_THE_XPATH_E v

Few examples

Scenario 7: IP Domain Name

In this example we are looking for the domain name as anutacorp.com across all devices in
the lab using X-path expression.

Xpath Expression:

Fix Mutation Payload:
Note: we can use ATOM_DEVICE_ID or inputDeviceld for substituting the deviceld.
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Defining Xpath Expression

Edit Policy | Yang_IP_Domain_Name

Edit Rule | Check_Yang_IP_Domain_Name

Conditions and Actionse

c 7

¥ selected (i) 10f1 ‘ Enter a keyword Q ‘

Condition Details  Action Details.

Condition Name Sequence Number Condition Names Xpath Expressions.
Verty_Yang,1P_Domain_Name 5 Condtion Narme, underscor
J0SXE- -
Sequence Numbere
Sequence Numbercontrols the order of exection ofthe Condions.
B
»
Scope Details
Condition scope details
Inventory_Data
&
Condition Match Criteria
Inventory Operator
MATCHES_THE_XPATH_EXPRESSION
v
Edit Policy | Yang_IP_Domain_Name
Edit Rule | Check_Yang_IP_Domain_Name
Conditions and Actions
Conditions and Actionse Condition Details  Action Detalls
C 7/ W Selected @ 1061 Enterakepword a
Condition Name Sequence Number Select Match Action Select Non-Match Actio
Verify_Yang_IP_Domain_Name 1 Select action Select action
continue Raise_violation N
Violation severity
CRITICAL N
» Violation message type
Default violation_message M
Fix Mutation Payload
<config-
<devices xmins="http://anutanetworks.com/controller’>
<device>

<id>{{ inputDeviceld }}</ids|
<native xmins="http://cisco.com/ns/yang/Cisco-I0S-XE-native>
<ip>
<domain nc:operation="create’>
<name>anutacorp.com</name>
</domain>

</devices>
</config>
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Fix Configuration Display in Remediation

o s No Rule Inputs 50
Fix Configurations.
ih
N o
£ | foutaton plar
163
Q Jurl>
cpath»
163
D -

</fiemutation-plan>

0 : 0 s [startnow

Scenario 8: IP Name-server check

Xpath Expression:

Fix Mutation Payload:

Defining Xpath Expression
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®R Edit Policy | YANG_IP_Name_Server

Edit Rule | Check_IP_Name_Server

Conditions and Actions

(|l Conitions and Actonse Condition Detals  Action Details

. C /W selected @ 10f1 Enterakeyword Q —_— @ @

Condition Name Sequence Number Condition Names Xpath Expressione

s

o Neme,can contain A propertyName=value

) contains(pro ue)

Verify_IP_Name_Server =192.168.20.1"and
192.16820.2'

Verify_IP_Name_Server 1

Sequence Numbers.

Sequence Number the order of execution of the Cand

%
D
o3

Defining Fix Payload

1 B

Scope Details

Condition scope details.

Inventory_Data v

%

Condition Match Criteria

Inventory Operator
MATCHES THE_XPATH_EXPRESSION -

®R Edit Policy | YANG_IP_Name_Server

Edit Rule | Check_IP_Name_Server

Il conditions and Actionse

Condition Details  Action Details

C /W selecied @B 101 Enterakeyword a —_— ® @

Condition Name. ‘Sequence Number CLCHLIEN R Ssecibioe Maich o

Verify_IP_Name_Server 1 Select action Select action
continue v Raise_violation v

Violation severity
CRITICAL N

» Violation message type

Default_violation_message v

Fix Mutation Payload
<config>
<devices xmins="http://anutanetworks com/controller’>
<device>
<id>{inputDeviceld ))</id>

<ip>

<name-server ncoperation=create’>
<no-vrf>192.168.20.1</no-vrf>
<no-vrf>192.168.20.2</no-vrf>
</name-server>

</config>

Scenario 9 : NTP server Check

Xpath Expression:
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Fix Mutation Payload:

Defining Xpath Expression
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R Edit Policy | YANG_NTP_Common_Peer_Configuration

Edit Rule | Check_NTP_Common_Peer_Configuration

([Pl conditions and Actionse

N C /s W seeced 10f1 ] Enterakeyword
Condition Name ‘Sequence Number
Verify NTP 1

$ O

Defining Fix Payload

Condition Details  Action Details

Condition Names

v, can contan Alphanum

Verify NTP

Sequence Numbers

Sequence Number contrls the oder of execution of the Candi

1 B

Scope Details

Condition scope details
Inventory_Data

Condition Match Criteria

Inventory Operator
MATCHES_THE_XPATH_EXPRESSION

Xpath Expressione.

xpath Exg

Namevalue

&

=192.168.20.3' and

i =192.168.20.4'and
=192.168.205'

list/ip-address=192.168.20.6

®R Edit Policy | YANG_NTP

Edit Rule | Check_NTP_Common_Peer_Configuration

([Pl concitions and Actonse

C /7 W selected

10f1 | Enterakeyword

¢

Condition Name Sequence Number

Verify NTP 1

8 0

d Actions.

Condition Details  Action Deails

Select Match Action

Select action

continue

Scenario 10 : Interface Check with rule_variable

Xpath Expression:

Select Non-Match Action

Select action

i Raise._violation

Violation severity

CRITICAL

Violation message type

Default vilation_message

Fix Mutation Payloac
<config>
<devices xmins="http://anutanetworks.comy/cortroller'>
<device>
<ido{{ inputDeviceld i</id>

<np>
<senver nG:operation="create’>
<serverist>
<ip-address>192.168.20.3¢/ipaddress>
</serverdist-
<serverlist
<ip-address>192.168.20.4</ip-address>
</serverlist>
<serverdist
<ip-address>192.168.20.5</ipaddress>
</server-list>
<severlist>
<ip-address>192.168.20.6</ipaddress>
</serverlist>
</server>
</ntp>
</native>




ATOM User Guide

Fix Mutation Payload:

Defining Rule Variables
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®R Edit Policy | YANG_Interfaces

Edit Rule | Check_Interfaces

Basic Information

([Pl Rue variabies

) c +

Key Description
ar0_uplink_interface
ar0_uplink_interface1_description
ar0_uplink_interface_ipv4addr

isis._region

1o0_ipvéaddr
1o0_ipvsaddr
102000_ipvaaddr
102000_ipv6addr
102007_ipv4addr
102007_ipv4addr
10200_ipvaaddr
10200_ipveaddr
102021_ipvaaddr
102032_ipvaaddr

102060_ipv4addr

O00OO0OO0OO0O00o0oo0oo0o0oo0oooOoOoo

subregion

Defining Xpath Expression

Conditions and Actions

16016
Default Value
2
ar0_uplink_interface1_description
192168.26.1
isis_region
10.100.99.98
2605:30C0:38/128
192.168.200.0
2605:30C0:48/128
192.168.200.1
192.168.200.7
192168.200
2605:30C0:58/128
192168.2021
192.168.20.32
192.168.20.60
BUR

Enter a keyword

R Edit Policy | YANG_Interfaces

Edit Rule | Check_Interfaces

il e

ions and Actionse
N C 7 W seeced 90f9 Enterakeyword
B Condition Name Sequence Number
9 Loopbacko 1
O  Loopbackeoo 1
b O  Loopback2000 1
° [0  Loopback2001 1
O Loopback2007 1
f O toopbackzo21 1
[0  Loopback2032 1
[0  Loopback2060 1
O aro_uplink interfacet 1

Defining Fix Payload

Condition Details  Action Details

Condition Namee Xpath Expressione

Loopbackd  and

100_Ipv4addr )y and

Sequence Numbere

Scope Details

Condition scope details

Inventory_Data M

Condition Match Criteria

Inventory Operator
MATCHES_THE_XPATH_EXPRESSION N

={(100_ipv6addr )}’

)

unch Test Config
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®R Edit Policy | YANG_Interfaces

Edit Rule | Check_Interfaces

s

(Il conditions and Actionse

Condition Details  Action Details.

C /W e oo mwsknes Q] - &)

B Condtion name —— Select Match Action Select Non-Match Action
9 Loopbacko f Select action Select action
i N ise.viol B
D O  Loopback200 N continue Raise_violation
O toopbackz000 1 Violation severity
O Loopbackzo01 1 CRITICAL v
N O toopbackao? ! Violation message type
O toopbacizoz 1 Default_violation_message v
[0  vroopback2032 1
Fix Mutation Payload
[0 Loopback2060 1 Sueviver
<id>{( inputDeviceld ))</id>
O aro_uplink_interfacet 1 ((inpuDeiceld )

<Loopback nc:operation="create">
<ip>

<address>10.100.99.98</address>
<mask»255.255 255.255</mask>
</primary>
</address>
</ip>
<ipv6>
<address>
<prefixist>
<prefix>2605:30C0:38/128</prefix>
</prefixist>
</address>
</ipve>
<name>0</name>
</Loopback>
</interface>
</native>

Scenario 11 : VRF Check with rule_variable

Xpath Expression:

Fix Mutation Payload:
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Defining Rule Variables
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Py Edit Policy | YANG_VRF

Edit Rule | Check_VRF °

Basic Infon

Conditions and Actions

([Pl rule variables

i c + 50f5 | Enterakeyword Q
O ey Description Defautt Value
A O oo 22001
o O 2007 22007
O oo 22021
o O 202 22032
O rd_2060 22060
»

Defining Xpath Expression

®R Edit Policy | YANG_VRF

Edit Rule | Check_VRF

Basic Information Platform Conditions and Actions

(|l Conditions and Actions Condition Detalls  Action Detalls

N C 7/ W selected @B 505 Enterakeyword a —_— @ @

B Condition Name. Sequence Number Condition Names. Xpath Expressione
A o oo . L ; hEoressin e e .
LON2001 ON2001' and 1d_2001 )Y and
D O ronzoo7 1 239.232.0.1"and
O onz021 1 Sequence Numbere 10
00255
o O onzoz 1 . ! p=22001 and
1 : =
O Lonzoso 1
»
Scope Details

Condition scope details.

Inventory_Data B

Condition Match Criteria

Inventory Operator
MATCHES_THE_XPATH_EXPRESSION v

)

Launch Test Config

Defining Fix Payload

Py FEcitPolicy | YANG_VRF

Edit Rule | Check_VRF

Platform S Conditions and Actions

([Pl cConitions and Actionsa Condition Details  Action Details

) C / W selected @ 50f5 Enterakeyword a —_— @ @

Select Match Action Select Non-Match Action
B Condition Name Sequence Number
9} g onon . Select action Select action
continue . Raise_violation_and_continue N
o O  tonzo07 1
O  ronzo21 1 Violation severity
° O vonzos2 1 CRITICAL v
) 0 roneoe0 1 Violation message type

Defaultvolation_message B

Fix Mutation Payload

<definition nc:operation="create">
<rd>2:2001</rd>
<name>LON2001</name>
<address-family>
<ipva>
<route-target>
<export>
<asnip>2:2001</asnp>
</export>
<import>
<asnip>2:2001</asnp>
</mport>
</route-target>
<mdt>
<default>
<address>239.232.0.1</address>
</default>
<data>
<multicast>
<address>239.232.1.0</address>
<wildcard>0.0.0.255</wildcard>
</multicast>
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® Snmp-string with rule_variable :

basicDeviceConfigs:snmp/snmp-community-list/snmp-string = "{{ community }}"

e Logical A|B : starts-with(vendor-string,'Cisco') or contains(device-family-string,'Cisco

800)

e Logical A&B : starts-with(vendor-string,'Cisco') and contains(device-family-string,'Cisco

800')
e Logical A&(B|C) : contains(vendor-string,'Cisco Systems') and

(contains(device-family-string,'Cisco 800') or contains(device-family-string,'Cisco CSR

1000V'))

e Logical A&(B|(C&D)):
contains(interface:interfaces/interface/if-name,'GigabitEthernetl1') and
(contains(os-version,'15.6(1)S') or (contains(vendor-string,'Cisco Systems') and
contains(device-family-string,'Cisco CSR 1000V")))

e Logical not(A&B) :

not(contains(basicDeviceConfigs:local-credentials/local-credential/name, 'admin') and

contains(basicDeviceConfigs:local-credentials/local-credential/name, 'cisco'))

How to derive the X-path expressions

There can be two ways by which you can derive the X-path expressions

o Navigate to the Device profile page to get the X-path Expression Details for the yang

parsed entities

Resource Manager — Devices — Select a Device — Configuration — Config Data —

Entities — Select Entity

For Example: If we want to write xpath expression for VRF name to match as “anuta”,

then below is how condition needs to be written
[3features:vrfs/vrf/name = ‘anuta’

I3features:vrfs/vrf : This is x-path derived based on model under device
name : Attribute of vrf name.

o Navigate to Schema Browser to see all yang models under path
/controller:devices/device

Policy creation with XML Template Payload

e Within Condition Match Criteria select “Matches_the_template_payload”
/"Doesn’t_matches_the_template_payload” option for Inventory Operator field
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e The Fix Mutation Payload is a Jinja2 template configuration in Netconf xml| RPC format
written using the unmatched content from the test results tab.
Navigate to Resource Manager > Config Compliance > Policy > + (Add Policies)
Few examples

Scenario 12 : IP Domain name check

Template Payload:

Fix Mutation Payload :

100
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Defining Template Payload

® Edit Policy | XML_IP_Domain_Name

Edit Rule | Check_IP_Domain_Name
)

Basic Information Platform Selection Rule Variables Canditions and Actions

1] [——— Condiion Details ~ Action Details

N C 7/ W sected @ 10f1 | Enterakeyword a @
Eari Ry L (L Condition Names. Template Payloade

@ Verify_Domain_Name 1

Verify_Domain_Name <native mins="http://cisco.comjns/yang/Cisco-10S-XE-native'>
D .

Seguence Numbers <domain>
<neme>anutacorp.com</name>

& Bt

1 B <ip>

» <mative>
Scope Details

Condition scope details

Inventory_Dzta v

Condition Match Criteria

Inventory Operator

MATCHES_THE_TEMPLATE_PAYLOAD M

p)

Launch Test Config

Here the matched and unmatched data will be stored in the backend data structure which is
shown in the Test Results tab. The matched data will be stored in the condition-search-output.
The unmatched data will be stored in unmatched-content.

Test Configuration And Results  Netconf Payload To Restconf Plan

Test Configuration and Reaul test- s
Test Configuration and Results est rej-. s

“compliance-polici
Condition Match Operator: "highest-severity’

. ®

"rule-violation-count

MATCHES_THE_TEMPLATE_PAYLOAD . "noncompliant-rules-output': E
"violated-conditions": ",
Template Payload "device-compliance-condition-output’: {
*block-start-unmatched-content™ "<I[CDATA[]>,
<native xmins="http://cisco.com/ns/yang/Cisco-I0S-XEnative™> *block-start-condition-search-output”:"</[CDATAI>",
<ip> “condition-status’ false,
<domain> “condition-search-output': "<![CDATA[{\"'matched\":[{\"controller:devices\"{\'device\":{\"id\"\"172.16.3.1 70\HIII>",
<name>anutacorp.com</name> “totakblock-count’: 0,
<fdomain> “unmatched-content’: "<I[CDATAK\ unmatched\"[{\"controller:devices\":(\'device\"{\Id\"\"172.16.3.170V' \'Cisco-
<fip> 10S-XE-native:native\":{\Ip\"{\'domain\":(\'name\"\'anutacorp.com\ NI
</native> "aggregated-condition-ouput™: "</[CDATA[(\n \'condition_contents\": [{\n \'condition_id\" : nulln
\block_start_matched_content\": null\n ~\'block_start_unmatched_content\": null\n  Y'unmatched_content\" : null\n
\"matched_content\" : null\n } [\n}]}>",
"id"; "Verify_Domain_Name’,
"block-match-caunt': 0,
“templ i xmins=\"http:/fcl '>\n - <ipr\n
<domain>\n p g
“block-unmatch-count’: 0
h o
"name”: “test-condition’,
“failed-conditions”: |
G seectes mm )
pl " pliant’ |
) Status )
172163.170 o )

antroller:devices\"{\'device\":

(172.16.3.170\HNDI>",

troller.device
WL,
2contents\":[{\n \'condition_id\": null\n  \'block_start_matched_content\"
2 fatched_content\" : null\n  \'matched_content\' : nullyn } \n}]l>",

\deviceV {IVId\'\"172.16.3.170V \'Cisco-10S-XE-

The Fix Mutation Payload is a Jinja2 template configuration in Netconf xml RPC format written
using the unmatched content from the test results tab.
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Defining Fix Payload

® Edit Policy | XML_IP_Domain_Name

Edit Rule | Check_IP_Domain_Name

[P conditions and Actonse

. C / W sclected @ 01 Enterakepword

Condition Narre ‘Sequence Number

Verify_Domain_Name 1

ns and Actions

Condition Details  Action Details

Select Match Action

Select action

continue

Fix Configuration Display in Remediation

Select Non-Match Action

Select action

v Raise_volation v

Violation severtty

CRITICAL N

Violation message type

Default violation_message v

Fix Mutation Payload
<config>
<devices xmins="http://anutanetworks com/controller'>

{2 for content in unmatched %)

{2 for device in content{'controllerdevices | devize’] %

<device>

<ids{{ devicel'id] })</ic>

http:/cisce.com/ns/yang/Cisco-I0S-XE-native™>

<domain nc:operation="create’>

Pe/name>
<domain>
<ip>
<fnative>
</device>

{3 endfor 6}
{% endfor 6}
</devices>
<Jconfig»

AR Jobnamee

domain_name
ih
Devicese
*
" » 172153170

& D

No Rule Inputs

Scenario 13 : IP Name Server check

Template Payload:

Fix Configurations

<ixmutation-plar>
<url>
controller 721631
</ur>
<rcpath>
controller 72.16.3.170/Cisco-10S XE-
</rcpath>
<operation>
POST
</operation>
<payload>
<domain>

<name>
anutacorp.com
</name>
</domain>
</payload>
<ffixmutation-plan>

0 B + [startnow

Hours Minutes.
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Fix Mutation Payload :
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* Edit Policy | XML_IP_Name_Server

Edit Rule | Check_IP_Name_Server

Basic Information Platform Selection Rule Var Conditions and Actions.

(1P concitons and Actionse Condition Details  Action Details

C 7/ W sclected @ 10f1 Enterakeyword a
%  Condition Name ‘Sequence Number Condition Names Template Payloade
9 ®  Verify.Name_Server 1
Verify_Name_Server =hity o
D <>
Sequence Numbers <name-server-
<norf>192.168.20.1¢/no-vr>
o 1921662024 na s
! b </name-server>
» <lip>
Scope Details </native>

Condition scope details

Inventory_Data v

Condition Match Criteria

Inventory Operator
MATCHES_THE_TEMPLATE_PAYLOAD v

)

Launch Test Config

Defining Fix Payload

®R Edit Policy | XML_IP_Name_Server

Edit Rule | Check_IP_Name_Server

Basi

information Platform Selection Rule Varial

Conditions and Actions

([P concitons and Actionse Condition Details Action Details

Pl C /B sceces @B 0t | Enerakemond a — @ @

[ Condition Name Sequence Number Selectietnf o Select Non-Match Action
Verify_Name_Server B Select action Select action
continue v Raise_violation v

()

Violation severity

CRITICAL .
> Violation message type
Default_violation_message v
Fix Mutation Payload
<config-

% for content In unmatched %)
% for device In contentl'controller devices I device’] %)
<device>
<id>{{ device['1d"] }</ic>
<native xmins="http:/cisco.com/ns/yang/Cisco-I0S XE-native’>
<ip>
<name-server nc:operation=create’>
{% for name._server in device[ Cisco-10S-XE-native:native][ip]
[name-server][no-vrf] -5}
<no-vif>{{ name_server J</no-vrf>
(% endfor %)
</name-server>

</device>
(% endfor %)
{2 endfor %}
</devices>
</config>

Fix Configuration Display in Remediation
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(9)  Jobname. No Rule Inputs

Fix Configurations

o R emuation plar-

1631
<fur>
<rcpath>
721631
D </epath-
<operation>
o PoST
</operation>
<payioad>
<name-server>
<ot
192168202
<ot
</name-server>
</payload>
</fixmutation-plan>

0 Ea +  [startnow
Hours Minutes

Scenario 14 : Interface check

Template Payload:
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Fix Mutation Payload :
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Defining Template Payload

R Edit Policy | XML _Interfaces

Edit Rule | Check_Interfaces

(|l Contions and Actionse Condition Details  Action Details

. C /7 W selcied @ 90f9 | Enterakeyword aQ — @ @
ol e ‘Sequence Number Condition Names Template Payloade
Q ) | Condition Name,cancontan Alphanumercs, underscoe, ace andhypen . Devce Payload Can b ghven
Loopbackd y .
D O  Loopbacka00 1 nterfanes
O Loopbackzo00 1 Sequence Numbere <Loopback>
. of execution <ip>
o O  Loopbackeo01 1 = <address>
1 : P
[0 Loopback2007 1 primary>
> <address>10.100.99.98</address>
O  loopbackz021 1 Details <mask>255.255.255.255</mask>
L) </primary>
[0 Loopback2032 1 ) o
[ Loopback2060 1 Eondopscopelied </ip>
nventory_Dat: . <ipve>
[ aro_uplink_interface1 1 nventory-Data D reses
. <prefixdist>
“ <prefix-2605:30C0:38/128</prefix-
Condition Match Criteria </prefixist>
</address>
</ipve>
invenioty,Opeator <name>0</name>
MATCHES_THE_TEMPLATE_PAYLOAD . </Loopback>
</interface>
</native>
y

Defining Template Payload

®R Edit Policy | XML _Interfaces

Edit Rule | Check_Interfaces

(|l conitions and Actionse

Condition Details  Action Details.

. C 7/ W selected @ 9079 Enterakeyword Q SSS ® @

o)
B condition Name Sequence Number Select Match Acto Select Non-Match Act
9 ‘ Epgire P Select action Select action
continue N Raise.violation_and_continue v
D [0  vLoopback200 1
[0  vLoopback2000 1 Violation severity
o O toopbackzo01 1 CRITICAL M
» O Loopbackzo07 ! Violation message type
O loopback2021 1 Default_violation_message v
[0  vroopback2032 1
Fix Mutation Payload
[0  vroopback2060 1 < (10°] jj</id>
O woupink merfacer | <native xmins="http://cisco.com/ns/yang/Cisco10S-XEnative">

I {5 for loopback [

[Loopback] %)
<Loopback nc-operation="create’
<ip>
<address>
<primary>
<address>{{loopbacklip]laddress][primary]
[address] }j</address>
<mask>{(loopback{ip]faddress|[primary][mask]
Jye/mask>
</primary>
</address>

<address>
<preficist>
{% for prefix in loopback[ipv6Jaddresslprefix-
list] %}
<prefic>{{ prefix] prefix] }}</prefix>
(% endfor

<rorefixcist> .

Scenario 15 : VRF check
Template Payload:
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Fix Mutation Payload :
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Defining Template Payload

110



ATOM User Guide

* Edit Policy | VRF_XML

Edit Rule | Check_VRF

information

([P concitons and Actionse Condition Details  Action Details

C 7/ W selected @B 505 Enterakeyword Q = @ @

Condition Name ‘Sequence Number Condition Namee. Template Payloade

LON2001 1 LEilo

LoN2001 <ipva>
Lon2007 1 e
<default>
5 <address>239.232.0.1</address>
Lon2032 1 </default>
1 g <data>
Lon2060 1 data
» <multicast>
. <address>239.232.1.0¢/address>
Scope Details
b2 <wildcard>0.0.0.255</wildcard>
</multicast>
Condiition scope details. <date>

LoN2021 1 Sequence Numbers.

Oo0o0oOSs o

Inventory_Data N </me>
<route-target>
<export>
<asnip>22001</asnip>
Condition Match Criteria </export>
<import>
nventory Operator ;:‘s:o\::z 2001</asnip>
MATCHES_THE_TEMPLATE_PAYLOAD - </route-target>
</ipva>
</address-family>
<name>LON2001</name>
<wd>2:2001/rd>
</definition>
<>
</native>

Launch Test Config

Defining Fix Payload

R Edit Policy | VRF_XML

Edit Rule | Check_VRF

Rule Variables Conditions and Actions.

(Il conditions and Actionse

Condition Detalls  Action Detalls
c 7 @ selected @ 50f5 Enterakeyword Q @ @
Select Match Action Select Non-Match Action
B Condition Name Sequence Number
Lonz001 | Select action Select action
O oo . continue v Raise_violation_and_continue N
O  tonzozt 1 Violation severity
O  Lon2032 1 CRITICAL v
N O tonoso ! Violation message type
Default_violation_message v
Fix Mutation Payload
<config»

<devices xmins="http://anutanetworks com/controller">

{2 for content in unmatched -%)

{% for device in content('controller:devices |'device] %)

<device>

<id>{{ device['id"] }j</id>
<native xmins="http://cisco.com/ns/yang/Cisco10S-XE-native™>
ps
{% for vf_def in device[Cisco-10S-XE native:native][vrf [ definition]

{5 if if_def[name] == 'LON2007" %)
<definition nc:operation="create"
{5 i wrf_deffrd] %)
<rd>{({ vrf_deflrd] }}</rd>
{5 endif %)
<name>{ vrf_def[name]] }}</name>
<address family>
<ipva>
<route-target>
{% for export in vrf_def[address-family lipv4]
[route-target][export] %}
<export>
<asn-insl exnortfasnn] e/asn-in> .

How to derive the XML Template payload
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o Navigate to the Device profile page and export the XML template details for the yang
parsed entities

Resource Manager — Devices — Select a Device — Configuration —Config Data —
Entities — Select Abstract entity — Use Download button to export/copy the XML
payload

Example : Let's derive domain-name XML Template payload

Navigate to Devices — select a device— configuration -> Config Data — Entities —
dns-server — Export XML payload using download button.
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Profiles

A profile allows one or more Policies to be grouped and executed on one or more devices either
on-demand or as per Schedule. Profile execution results in a per-device compliance report

included in the execution.

Create Profile

'

Select Policies

Provide Rule
Inputs

I Select Davices -+

i

Trigger Cr Schedule
Profile run

l

Steps:

a. Navigate to Resource Manager > Config Compliance -> Profiles
e Select “+” to Create a Profile
e ATOM opens up a new wizard and displays 2 sections.

o Policies - Select one/more policies
o Devices & Schedule - Select one/more devices or Device groups

b. Create profile by providing name, description and select policy which was created previously
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IP_Domain_Name.

Select policies Select devices and schedule

Profile names Select policiess

C  selected @D 330733 search Q
Day0_Config
L Name Description
Description P
e ————
IP_Domain_Name Check whether the domain name is present in the ¢

c. Navigate to the next tab, Select devices and schedule. We can select either device(s) from
Devices or Device Groups tab

g

c 130f13  search Q
[0 Name Description
D AllDevices All Device Group
D Firewall Firewall Devices Group
[ Hest Host Devices Group
Edit Profile
Select policies Select devices and schedule
C  selected {l 220f22 | Enter a keyword Q
1D Status Name Device Type Ver]
172.16.3.170 (] 172.16.3.170 Cisco CSR 1000V Cis|

d. After device(s) are selected, choose if the compliance checks need to be run against an
archived config or current running-configuration of the device. By default Latest From Config
Archive is selected.

Schedule: The profile job can be scheduled in Hours or Minutes. Alternatively, a job can be
started right away by enabling Start now option.

Configuration:
- Current Config: This will pull the current device configuration and evaluate against the
polices.
- Latest From Config Archive: This will use the latest configuration that is stored in the
ATOM. Optionally you can add a check to skip the compliance check when the
configuration is older than n hrs
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Select Configuration

O Current Config

@ Latest From Config Archive

Skip when config older than
0 =
Hours
Schedule
Frequency
0 = 0 =
Hours Minutes
|:| Start now

Or the profile job can triggered at a later point of time using run job icon on the profiles view

C s B 8 i Selected (D

Name Description Policies

ip_domain_profile IP_Domain_Mame
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Report

Navigate to Resource Manager > Config Compliance -> reports

Compliance report is generated upon completion of Profile run. For each device, the report lists
the compliant and non-compliant policies, rules and conditions .

After profile job is run, audit details can be viewed in Report View

Dashboard  Policies  Profiles  Report  Remediation  Archive
= = @ oskipped Conditions @ 0 Compliant @ 1 Non Compliant Total = CIRE
c i —

Host Name Device Type Severity Device Compliance Status Execution Condition Status Device Id Vendor Policy Name Rule Name Condition Name
[0 wnacrpdtssOgwnetdisneycom  Cisco CSR 1000V  critical | ™Y ) ) 17216330 Cisco Systems IP.DomainN..  Check IPD..  Verify_IP_Domain

Since IP_Domain_Name policy has a condition named Verify _IP_Domain_name, where it didn’t
meet the required criteria. The condition is marked as Non_compliant.

Severity: Severity the condition where the condition Match Action or Non Match Action is of
type Raise_violation or Raise_violation_and_continue.

Upon checking the row you can see the expected and the fix commands for that condition along
with action-severity, action-type and other metadata related to device & condition.

Dasnboara  Follcies  Profies  Keport  Kemediation  Archive Compliance detalls X
= = @ 0'Skipped Conditions @ 0 Compliant @ 1 Non Compliant Total A Information

Device Type Severity Device Compliance Status Execution Condition Status Device Id Vendor Policy Name R

et deneycom  Ciseo CSR 1000V [Crtical ° ° ° 7216330 CicoSystems IP_DomainN.

Config Time

Policy Name  IF_Domain.

Rule Name
Condition 1D

Condition Status  (_Non Complaint )

A Expected Pattern

Dashboard  Policies  Profiles  Report  Remediation  Archive Compliance details X
= = @ 0 Skipped Conditions @ 0 Compliant @ 1 Non Compliant Total ~ Information

. A Expected Pattem

- ipdomain-name net disney.com

c @
Host Name Device Type Severity Device Compliance Status Execution Condition Status Device Id Vendor Policy Name R
Cisco CSR 1000V  Critical | ® ) ® 17216330 Cisco Systems IPDomainN.. €
z
A Action Details
ActionType  NON_MATCH_AGTION
Action Severity (CRITICAL )
Remediation Commands
ip domainname net.disney.com|
4
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The reports section also facilitates users to filter the results of what user is interested in. The
dropdown will display all the possible values for the filters. Users can try out any combination
and see the results. By clicking on the apply button.

Inorder to revert the filter that are applied you can click on the clear button.

Dashboard Policies Profiles Report Remediation Archive

= T A ~ @0 Skpped Conditions @ 0 Compliant @ 1 Non Compliant (I} Total B O v wt s
Device Id v  Device Type v Vendor ~  Compliance Status ~  Condition Status v Locations ¥  Resource pools -

Device groups +  Severity +  Execution Status +  Policy «  RuleName +  Condition Name - @
e [ IP_Domain_Name rch B

10f1

Host Name Device Type Severity Device Compliance Statu. I— T Device Id Vendor Policy Name Rule Name Condition Name Confi
[  wnacrp-diss-0-gw.net.disney.com Cisco CSR1000V o ® ® 172.163.30 Cisco Systems IP_Domain_Name. Check_IP_Domain_Name Verify_IP_Domain_name 11701

Tired of filtering the results every time for more frequent data. We got you covered ATOM
provides an option to save the filter that you applied again with a single click.

e Select filters that you are interested in and click on the save button

e This will show a new pop-up box prompting for the filter name and the dashboard
where the user wants to pin it.

e C(lick on the save and apply button will save this filter and the resulting data will be
populated.

Save Filter

Enter Filter Name

Select Dashboard -
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Save Filter

filter

cli-summary-dashboard
default-dashboard
pnp-dashboard

compliance-dashboard

ummary
workflow-summary-dashboard
cli-summary-dashboard

smu-summary-dashboard

90f9

We can pin to the dashboard, upon saving the filter using dropdown.we are able to see the
filter under the dashboard.

Dashboard  Policies ~ Profiles  Report  Remediation  Archive

Cli Summary Dashboard

» ) . » . .
¢ Config Compliance - Execution Status ¢ Config Compliance - Compliance Status Ll st
0 0
ERRORS: 0.0% (0) | CONFIG_STALE: 0.0 % (0) COMPLIANT: 0.0 % (0) Shipped Couiions R
OFFLINE_DEVICE: 0.0 % (0) CONFIG_EMPTY: 0.0 % (0) [ NOT_APPLICABLE: 0.0% (0 ;
CONFIG.FULLFAL.. 00 (0 - engomore

NON_COMPLIANT: 3

il dd
0 6
KEipper Consitor I —
|
e —
SUCCESSFUL: 100.0 % (3) arnar e e
Lt vendortype Ll fjrer
0 4 0 6
[Skipped;Conciiions) [ e— Skippea Conaitions [l —1
5 1
T — - Noncompiam

From where | can access these saved filters?
e They are easily accessible. All the filters that are saved are listed under the dropdown on

the top.
e Click on the interested filter and you see the data getting filtered.

Dashboard Policies Profiles Report Remediation Archive
o = = Filter ~ @ 0 skipped Conditions @ 0 Compl @ 1 Non Compliant Total
Device Id ip_domain_name filter - Vendor - Compliance Status - Condition Status
. 10f1 . "

Device groups - Execution Status ¥  Policy +  Rule Name

c
Host Name Device Type Severity Device Compliance Status Execution Condition Status Device Id
[0 wnacrp-dtss-0-gw.net.disney.com Cisco CSR 1000V [ ] o [ ] 172.16.3.30
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ATOM also provides an option to view the statistics based on Pivot by Device, Device Type,
Policy, Location and Device Group.

Dashboard Policies Profiles Report Remediation Archive

CRV J= = Filter - @ o Skipped Conditions @ 0 Compliant ¢ 1 Non Compl
Device  Pivot By v  Device Type *  Vendor >  Cor
Device  Device ~  Severity ~  Execution Status ~  Pal
Device Type
C
Policy : : ) :
Host Mal Device Type Severity Device Compliance Status
[J v ‘Location isney.com Cisco CSR 1000V ®

Device Group

Users can opt for any view that they are interested in.

Pivot by device

= Filter ~ @0 skipped Conditions @ 0 Compliant @ 1 Non Compliant [ Total B @© vele unit 4

Severity Execution HostName Device ID Device Type Compliant Policies Non-Compliant Policies Compliant Conditions Non-Compliant Conditions Vendor

Critical ‘wnacrp-dtss-0-gw.net disney 172.16.3.30 Cisco CSR 1000V o 1 o 1 Cisco Systems
P .

Severity: The aggregated severity of that particular device.
Compliant Policies: The number of policies that are compliant against the device.
Non-Compliant Policies: The number of policies that are non-compliant against the device.
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Compliant Conditions: The number of Conditions that are complaint against the device
Non-Compliant Conditions: The number of Condition that are non-compliant against the device
Device ID: Displays all Device Ids for which compliance has run. This is the context column for
pivot by device.

Execution status: Based on execution on device it is updated as Successful, errors,stale config,
empty config, config pull failed, offline device.

Hostname: Hostname of a device is displayed here.

Device compliance status: Based on compliance run, for a device it is updated as Compliant,
non-compliant, Not applicable.

Device Type: The device type of a device is displayed(like cisco csr 1000v , cisco 891).

Vendor: vendors of device are displayed here (like cisco, juniper)

On clicking on the Device ID, Device ID filter gets applied and the user will be navigated to CRV.

Dashbosrd  Policies  Profiles  Report  Remedistion  Archive

5= @ 2 Skipped Conditions @3 Complian: @ 22 Non Compliant Toual M @ | veke Unit
Device ld:  172.16.22.101
c search a
Hast Na Severity Execution Device Type Device Compliance Status Condition Status Device id Vendor Rule Name Candition Name
]  critical | ® Cisoo CSR 1000V ° ° 172.16.22.101 ACLonLine.  Check Line_.  Verify_Line VTY
O = ® Ciseo CSR 1000V ® ® 172.16.22.101 Clack Synchr  NTP_TEMPL.  Check NTP_Samver
O = ® Ciseo CSR 1000V ® ® 172.16.22.101 Clock Synchr_  NTP_TEMPL.  Check NTP_Asso
O = ® Ciseo CSR 1000V ® ® 172.16.22.101 Clock Synchr_  NTP_TEMPL.  Check NTP_ACL
O  Critical | ® Ciseo CSR 1000V ® ® 172.16.22.101 Clock Synchr  CLOCK.TE.  Check Summer_.
O  Critical | ® Cisco SR 1000V ® ® 172.16.22.101 Ensble_Pass Check_pass.  verfy_Password.
O  Critical | ® Cisco CSR 1000V ° ® 172.16.22.101 IP_Domain N_  Check IP_D Verify IP_Demain...
] | Critical | Y Cisco CSR 1000V L ® Y 172.16.22.101 IP_Name_Ser. Check_IF_N.
D NA . Cisco CSR 1000V . . 172.16.22.101
]  critical | ® Cisoo CSR 1000V ° ° 172.16.22.101
D NA . Cis: . . 172.16.22.101
D NA . Cisco CSR 1000V . . 172.16.22.101
]  critical | ® Cisoo CSR 1000V ° ° 172.16.22.101 rify s

m = Policy x = ® 0 skipped Conditions @ 0 Compliant 1 Non Compliant Total

Complaince Status Severity Policy Name Compliant Devices Non-Compliant Devices Non-Compliant Conditions

O e [ Critical | P_Domain_Name 0 1 1

Severity: The aggregated severity of that particular policy.

Compliant Devices: The number of devices that are compliant against the policy.
Non-Compliant Devices: The number of devices that are non-compliant against the policy.
Non-Compliant Conditions: The number of conditions that are non-compliant against the
policy.
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Policy Name: Displays all policies for which compliance is run. This is the context column for
pivot by policy.
Compliance status: Based on policy, it is updated as compliant or non-compliant.

On clicking on the policy, the policy filter gets applied and the user will be navigated to CRV.

@ 0 Skipped Conditions @ 0 Compliant 15 Mon Compliant Toual M ©  vee Unit .
Folicy: an_Line
o0

c h Q
Hast Name Device Type Severity Device Compliance Status Execution Condition Status Device Id Wendor Policy Name Rule Name

Cisca 8  critical | ® ° ° 172.16.1.138 Cheok_Line_

Cisca 891  critical | ® ° ° 172.16.1.129 Check_Line_

Cizco CSR 1000V ® ™Y ® 172.16.16.161 Check_Line_..  Verify Line VTY

Cisca CSR 1000V  critical | ® Y ® 172.16.16.16 Check_Line_

Cizco CSR 1000V ® ™Y ® 172.16.16.163 Chack_Line._

Cisca CSR 1000V ® Y Y 172.16.16.164 Check Line_

CiacalOSXRYI000 | ritical | ® ° ® 172.16.17.133 Check_Line_

CiscalOSXRYI000 ® Y ® 172.16.17.134 Chack Line_

CiacalOSXRYI000 | Critical | ® Y Y 172.16.17.135 Cisco Systems ACL_on_Line_ Check_Line_

CiscalOSXRYI000 ® Y ® 172.16.18.176 Cisco Systems ACLonbine..  Chackline..  VerfyLine VTV

Cisca CSR 1000V  critical | ® ° ° 172.1622.101 cis ACLonLine_  Check_ Line_

Cisco CSR 1000V Gritical ® Y ® 172.16.22.102 Cisca Systems ACLon Line._  Check Line_.  Verify Line VTV

Pivot By Device Type:

Severity:The aggregated severity of that particular device type

Device type: Displays all device types available in compliance. This is the context column for
pivot by device type.

Vendor: Displays the vendors available in compliance .

Compliant Device: The number of devices that are compliant against the device type
Non-compliant device:The number of devices that are non-compliant against the device type.

Compliant policies:The number of policies that are compliant against the device type
Non-Compliant policies:The number of policies that are non-compliant against the device type
Compliant Condition:The number of conditions that are compliant against the device type.

Non-compliant Condition:The number of conditions that are non-compliant against the device
type.
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@® Dashboard  Policies ~ Profiles  Report ~ Remediation  Archive
o = Device Type x T Filter ~ @ 0Skipped Conditions @ 10 Compliant @ 6 Non Compliant  [EJ30 Total B O veke Unit s
\
i Device Id v Device Type v Vendor v Compliance Status ~  Condition Status v Locations -
L}
Resource pools v Device groups v Severity v Execution Status ~  Policy v RuleName -
*
c i search Q
(]
Severity Device Type Vendor Compliant Devices Non-Compliant Devices Compliant Polices Non-Compliant Policies Compliant Conditions. Non-Compliant Col

<]

() crica
O e
O @

Cisco CSR 1000V

Juniper vMX

MXx204

Cisco Systems
Juniper Networks

Juniper Networks

0

0

0

1

1

5

4

T

T

6

4

1

1

Click on device type> Cisco CSR 1000v here

Dashboard  Policies  Profiles Report  Remediation  Archive

]
o ED = DeviceType x = Filter ~ @ 0Skpped Conditions @10 Compliant @ 6Nan Compliant ([ Total M @  vee Unit s
" Device Id ~  Device Type ~  Vendor ~  Compliance Status - Condition Status - Locations -
]
Resource pools - Device groups - Severity - Execution Status:  Successful - Policy - Rule Name -
s
Bl concition Name - m
9 .
c : search Q
Severity Device Type Vendor Compliant Devices Nen-Compliant Devices Compliant Polices Nen-Compliant Policies Compliant Conditions Non-Compliant
o (N citical | Cisr CSR 1000V Cisco Systems 0 1 5 1 6 1
[m Y High | Juniper Networks 0 1 4 1 4 1
[ High | Mx204 Juniper Networks 0 | 0 4 0 .

https://172.16.21.154:30443/ngui/Cisco CSR 1000V

On clicking on the Device Type, Device Type filter gets applied and the user will be navigated to

CRV.
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@® Dashboard  Policies  Profiles  Report ~ Remediation  Archive
o CRV. = = Filter ~ @ o0skipped Conditions @ 6 Compliant @ 1 Non Compliant Total M @© vele Unit s
II Device Id v Device Type:  Cisco CSR 1000V v Vendor v Compliance Status hg Condition Status v Locations v
1]
. Resource pools v Device groups v Severity v Execution Status ~  Policy v RuleName -
)
R coniion Name - [ ove X cinr
o (] search Q
(]
Host Name Device Type Severity Device Compliance Status Execution Condition Status Device Id Vendor Policy Name
(-l O 7cobogw Cisco CSR 1000V [ NA Y ) ® 172.163.42 Cisco Systems AAA_Policy
O n7-cbb-o-gw Cisco CSR 1000V [ NA ] ) ° ° 172.163.42 Cisco Systems AAA_Policy
O n7<bb-ogw Cisco CSR 1000V [ NA ) Y ® 172.16.3.42 Cisco Systems Line_VTY_Policy
O n7-cbb-ogw Gisco CSR 1000V [ NA ] ) ° ® 172.163.42 Cisco Systems Logging_Policy
O n7-cbb-o-gw Cisco CSR 1000V [ NA Y ) ® 172.163.42 Cisco Systems NTP_server_cisco_policy
O n7-cbb-o-gw Cisco CSR 1000V [ NA ] Y ) ® 172.163.42 Cisco Systems SNMP_server_cisco_Policy
O n7<bb-ogw Cisco CSR 1000V ) Y ® 172.16.3.42 Cisco Systems Cisco_domain_name_policy

Pivot By Location:

@® Dashboard  Policies ~ Profiles  Report ~ Remediation  Archive
i3 = Location X = Filter ~ @ osSkipped Conditions @ 10 Compliant @ 6 Non Compliant [ Total () o Value Unit B
\
il Device Id v Device Type v Vendor v  Compliance Status ~  Condition Status v Locations
L}
Resource pools v Device groups v Severity v Execution Status ~  Policy v RuleName
~
a

c i search

Q

Severity Location Name

WY critical

Compliant Devices Non-Compliant Devices Compliant Policies Non-Compliant Policies Compliant Conditions Non-Compliant Conditions

Jindia_loc 0 1 5 1 6 1

Severity: The aggregated severity of that particular locations

Location Name: Displays all available locations over which compliance is run.This is the context

column for pivot by location.

Compliant Devices: The number of devices that are compliant against locations
Non-Compliant Devices: The number of devices that are non-compliant against locations
Compliant Policies: The number of policies that are compliant against locations
Non-compliant Policies: The number of policies that are non-compliant against locations
Compliant Condition: The number of conditions that are compliant against locations

Non-Compliant Condition: The number of conditions that are non- compliant against locations

Click on any of location name
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Dashbosrd  Policies  Profiles  Report  Remedistion  Archive

= Location * T Fie ~ @206 Skipped Conditions @ 108 Compliant @ 635 Non Compliant  [ELL) Total n o
Device Id *  Device Type *  Wenda ~  Compgliance Status ~  Condition Status ~  Lecstions location_california
Rescurce pools ~  Device group ¥ Severity ~  Execution Status ~  Palic *  RuleMame

Condition Name -

[ search
Severity Location Name Compliant Devices Non-Compliant Devices Complizn: Policies Non-Complian: Policies Compliant Condisions Non-Cor
O Sen Jose iz a 1 1 1 4 21
O Szn Jose Californiz DelhiAndhra Pradesh Mumbz 0 1 2 10 6 20
O ocation_california 0 4 0 7 3 54
O dhra Pradesl 0 z 0 12 6 a4
O wa 0 0 o o b 0
O we ocation_Milpitas a [ [ [} 0 (]
O wa ocation US4 Los Angeles location_Japan a o 0 o 0 o
O we on_USA location_Tokyo Las Vegas 0 0 0 o 0 0
0O we n_california 0 0 0 [ 0 0

L

on clicking on the location name, the location filter gets applied and the user will be navigated to

CRV.

Dashboard Policies Profiles Repart. Remediztion Archive
= T Filer ~ @206 Skipped Conditions @ 108 Compliant @ 635 Non Compliam  [EZE] Total
Device Id - Device Type - Vendor - Compliance Status - - Locations: Jocation_california -

Device groups - Sew - Exe - Folicy - Rule Name = Condition Name -
c i search Q
Host Name Device Type Severity Device Compliznce Status Execution Condition Status Device Id ‘Vendor Policy Mame Rule Name Condition Name Configuration
D Cisco 2951 NOT_APPLICABLE CONFIG_E 10919 11/05/20, 124
D Cisco 2845 NOT_APPLICABLE CONFIG_E 10912 11/05/20, 124
D can385024P-2 IEGBiQZ!P NOT_APPLICABLE CONFIG_E— 10113 11/05/20, 12
D ciscoAirCT5508K9 «ciscoAirCTS508K9 NOT_APPLICABLE CONFIG_E 100112 11/05/20, 124
D can385024P-3 ca1385024P NOT_APPLICABLE CONFIG_E._ 10.1.1.5 11/05/20. 1:0¢
D can385024P-1 ca1385024P NOT_APPLICABLE CONFIG_E._ 10118 11/05/20. 12
D Virtual A Cisco Virtual ASA NOT_APPLICABLE CONFIG_E._ 1011521 11/05/20. 12
D cisco, «ciscoASAS510 NOT_APPLICABLE CONFIG_E 10.1.15.23 11/05/20, 124
D Nexus 7004 Cisco Nexus 7004 NOT_APPLICABLE CONFIG_E— 10.1.15.25 11/05/20, 1224
D Nexus 5010 Switch Cisco Nexus 50105 NOT_APPLICABLE CONFIG_E._ 10.1.15.27 11/05/20, 12
D Cisco Nexus 3064 5 NOT_APPLICABLE CONFIG_E._ 10.1.15.29 11/05/20, 12
D Cisco ASR 9006 NOT_APPLICABLE CONFIG_E 10.1.1531 11/05/20, 124
D WA APIC NOT_APPLICABLE CONFIG_E 1011534 11/05/20, 124
D CiscolSR4331 NOT_APPLICABLE CONFIG_E._ 100.21 11/05/20. 12

Adding the same device in multiple resource pools and each RP associated with a different location,

all locations will be listed in pivot views.

Adding the same device in two resource pools and associate one RP with location and another RP

with no location, only location associated with RP will be listed.
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Pivot By Device Group:

® Dashboard  Policies  Profiles  Report ~ Remediation  Archive
= Device G x = Filter - 0 Skipped Conditi 10 Compliant 6 Non Compliant Total Val Unit +
o K] evice Group © 0 Skisped Conditions @ 10 Complian on Compliant (BT Tota B O v -
il Device Id v  Device Type v Vendo v  Compliance Status ~  Condition Status ~  Locations: jindia_loc -
]
Resource pools ~  Device groups v Severity ~  Execution Status ~  Policy ~  RuleName -
2
Condioname . oy X v § o |
c search Q
D
Severity Device Group Compliant Devices Non-Compliant Devices Compliant Policies Non-Compliant Policies Compliant Conditions Non-Compliant Conditions
o (] m Layer 2/3 switch o 2 4 5 4 5
[ High ] Layer 2 switch o 2 4 5 4 5
[ High | Layer 3 Router o 2 4 5 4 5
(W igh ] OffineDevices 0 2 o 2 10 2

Severity: The aggregated severity of that particular Device group

Device Group: Displays all available device groups over which compliance is run. This is the
context column for pivot by device group.

Devices in group: This gives the number of devices in a group

Compliant Devices: The number of devices that are compliant against device groups
Non-Compliant Devices: The number of devices that are non-compliant against device groups
Compliant Policies: The number of policies that are compliant against device groups
Non-compliant Policies: The number of policies that are non-compliant against device groups
Compliant Condition: The number of conditions that are compliant against device groups
Non-Compliant Condition: The number of conditions that are non- compliant against device
groups.

Click on any of device groups
m = Device Group X = Filter

- @ 206 Skipped Conditions @108 Compliant 635 Non Compliant Total M © Vs

- Vendo A Compliance Status A Condition Status v Locations: location_california A

c esrch
Severity Compliant Devices Non-Compliant Devices Device Group Compliant Policies Non-Compliant Policies Compliant Conditions Non-Compliant Conditions
0O na ] 3 % Layer 2 switch 1 27 2 Bl

0O we 0 38 ,er;— Router 4 78 103 601

0O we 0 2 0 12 H 35

O ne 0 5 VBN 0 29 17 122

O mwa [} 7 3 as 22 96

O mwa [} 0 11 3 2

O na ] [ arp 0 0 0 0

O o 33 cisco_g 4 33 105 613

O o He o 7 2 17

O wa o o arpl_device 0 0 0 0

On clicking on the device group, the device group filter gets applied and the user will be navigated

to CRV.
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T Fite ~ @18 Skipped Conditions @9 Compliant @ 51 Non Compliant Total =]
¥ DeviceType - e - pliance Sta - dition Sta ~  Locations: _lacation_califarnia -
- Device groups:  Layer 2 switch - Severity - Execution Statu *  Polic ~  RuleName -

pivot view :

Single pivot view can be selected.(no multi pivot view selection)

Upon selecting a pivot view, further filters like device id, device type, vendor,
compliance status,condition status,location,resource pool, device
groups,severity,execution status,policy, rule name, condition name can be applied.
Just with the pivot views, a filter can’t be saved, Based on further filters applied, a
filter can be saved. The saved filter can be deleted.

Bulk delete is not supported in pivot views

Remediation is not supported

Sorting is not supported on any column in pivot view.

Searching is not supported in pivot view.

The counts on top are related to the non- pivot views and labels are from condition
status

Export: based on pivot views, the records can be exported.

CRV(conditional report view) :

Doshboard  Poies P Report  Remediston  Archi

[crv B = @0SiippedCondtions @ 12Complisnt 2 Non Complan Toul B O e e
(S

HostName DeviceType Severiy DeviceComplnce tatus  Eveeution  CondiinSiatus | Deviceld PaiyName
O snckbansiqunst dsneycom  Cisco 891 [na ] ° ® ° 172161139 ACL Global
[ srctbanslgurer dineyeom Cisco o @ ° ° ° 2161138 ACL b
(O eorcbbancTgwret dineyoom oo o1 oot ° ° ° 172161139 46L_Blebe
[ sctbansiguradinyeem Cisee oo A ° ° ° 2181139 Aot gibal
[0 sanchbanaigunec dsneycom  Cisco: 01 m Y Y Y 172161139 ACL Global
[ srctbanslgurer dineyeom Ciseo o1 o ° ° ° 2161138 ACL_Gibel
O sencbbanslgunetdoneycom  Ciseo 891 ° ® ° 172161139 ACL Global
[m] Cisca CSR1000V o ° ° ° 17216345 AGL Global
[u] iscocsR 1000V [ra ] ° ° ° mi3ss £ct_Gibal
[ Gl CSR1000V o 'Y ° ° 1216345 4cLBleba
m] Cisco CSR 1000V m Y ® ® 17216345 ACL Global
[m] Cisca CSR1000V [ na ] ° ) ° 17216345 ACL Global
[u] iseoCo 1000V o ° ° ° 216358 xct_Gibal
Oess scoCsR1000¢ [itica | ° ° ° 21858 AcL_clbal

c rch Q
Davica Type Severity Device Compliance Status Exscution Candition Status Device Id Vendar Folicy Name Rule Nan
cat385024P NOT_APPLICABLE CONFIG_EMPTY 10113
cat385024P NOT_APPLICABLE CONFIG_EMPTY 10.1.1.5
cat385024P NOT_APPLICABLE CONFIG_EMPTY 10.1.1.6
Cisea 871 N ® Y Y 72.161.138 Enable_Password_Encryptian Check g
Cisco 871  critical ] ® ° ® 72.16.1.138 Cheok !
Cisco 871  Critical | ® ® Y 72.16.1.138 NTR_TE
Cisco 871  Critical | ® Y ® 72.18.1.138 NTP_TE
Cisco 871  Critical | ® ° ° 72.16.1.138 zatio WTE_TE
Cisco 871  Critical | ® ® Y 72.161.138 ck_Synchronization CLOCK_
Cisco 871  Critical | ® ° ® 72.16.1.138 IP_Demain_Name_Global Check.!
Cisco 871  Critical | ® ° Y 72.16.1.138 1P_Name. bal Check_I
Cisea 871 N ® ® ® 72.161.138 NTE_canfiguratians_Globa NTP_co
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The available columns are: Hostname, Severity, Execution, Device Type, Device
compliance status, condition status, Device id, Vendor, Policy name, Rulename,
Condition name, Configuration retrieved at, Expected pattern, Enforcement time.

The data can be filtered by applying filters on device id, device type, vendor, compliance
status,condition-status,location,resourcepool, device groups,severity,execution status,policy,
rule name and condition name.

Time based filtering : For timing based, user can use value and units(Days,weeks,months,
hours, minutes) fields.

Date wise filter: User can choose the date from the calendar symbol and click on ‘apply’ in
the calendar.

Count band - Represents counts for skipped, compliant, and non compliant conditions

e Skipped conditions - Platform mismatch and Execution Status (Stale Config,
Empty Config, Erros, Config Pull Failed, Offline Device) fall into this category.

e Complaint conditions - Based on conditions meeting the criteria

e Non- compliant conditions -Based on conditions meeting the criteria and

violations chosen

Multi-selection on filters is supported - More than one entry for a given filter can be
selected.

Sorting is enabled on all columns.

Searching is enabled for all columns.

The record details are listed when the checkbox for a given entry is selected. Device ID,
Device host name, Device type, Vendor, Device compliance status, Execution status, Config
time, Policy name, Rule name, Condition ID, Condition status, Expected pattern, Action

Details, Remediation commands( if it’s non-compliant) are shown as part of details.

Remediation :

Navigate to Resource Manager > Config Compliance -> Remediation

Fix CLI Action will generate the remediation CLI to be applied for each non-compliant device.
Users can schedule remediation on one or more devices or execute it right away. For each
device selected, ATOM will push remediation CLI to the device.
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Policy
Run
Complatad

Go to Report View

¥

Choose
Mon-compliant
Device

'

Trigger or Schedule
Fix Jab

Trigger Profile Run

Select a Report and click on the highlighted arrow for navigating to the Remediation

d.
screen.
Only if it is non- compliant, user will be taken to the remediation screen.
CRV = = Filter - @ o0 sSkipped Conditions @ 0 Compliant 1 Nen Compliant Total
c o
Host Name Severity Device Type Device Compliance Status Condition Status Execution Device Id
wnacrp-dtss-0-gw.net disney.com  Critical | Cisco CSR 1000V ® ® Y 172.16.3.30

b. Fix Violations by providing a Job name and verify rule-input values and fix CLI commands
under Fix Configurations. Click on the tick button to complete fix-job.
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Fix Violations

Job names No Rule Inputs

fix_ip_domain_name
Fix Configurations

ip domain-name anutacorp.com
Devicese
» 172.16.3.46

c. Fix Job can be scheduled using the Schedule option or can be initiated immediately by
enabling Start now. And click on the Tick button to initiate a fix-job.

Schedule

0, 03 Start now

Hours Minutes

1. Fix job can be initiated from the Remediation tab as well at a later point of time.

ﬁ Policies Profiles Report Remediation

C s ﬂ [ ] ¥ selected
0 )

Name Schedule
III fix_ip_domain_name ®

d. After remediation, trigger profile job and validate the report to see if the device came back as
a complaint.

ﬁ Policies Profiles Report Remediation
C Vd . [ | ¥ selected
0 - .
Name Description Policies
1 I . Ip_domain_profile IP_Domain_Name_Global

e. Below we can see the device is now back to complaint after fixing violations.
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CRV = = Filter A @ 0 Skipped Conditions @ 1 Compliant 0 Non Compliant Total

- Device Type - Vendo - Compliance Status - Condition Status

Remediation is not supported when the user is in pivot view.

Bulk delete:

Navigate to Resource Manager > Config Compliance -> reports(CRV)

- - Execution Status - Policy - - fition Nam:
&)
Host Name Device Type Severity Device Compliance Status Execution Condition Status Device Id Vendor Policy Name
D wnacrp-dtss-0-gw.net.disney.com Cisco CSR 1000V NA . . . 172.16.3.30 Cisco Systems IP_Domain_N...

® Dashboard  Policies  Profiles  Report  Remediation  Archive
o [ = T Filter ~ @ 2skipped Conditions @ 60 Compliant 48 Non Compliant [T Total B O |vee Unit s
Device Id > Device Type > Vendo ~  Compliance Status ~  Condition Status Locations -
ih
Resource pools > Device groups > Severit > Excoution Status > Policy Rule Name -
[}
C search Q
Host Device Type Severity Device Compliance Status Execution Condition Status Device Id Vendor Policy Name
Export
-8 O disney.com Cisco 891 [NA ] [ ) ® 172.16.1.139 Cisco Systems ACL_Global
Bulk Delete
> (] disney.com Cisco 891 [ NA ] ) ) ® 172.16.1.139 Cisco Systems ACL_Global
O aancbb-ana-1gw.net.disney.com Cisco 891 [ NA | ) ) ® 172.16.1.139 Cisco Systems ACL_Global
[ aancbb-ana-T1gw.net.disney.com Cisco 891 [ NA ] [} ) ® 172.16.1.139 Cisco Systems ACL_Global
O aancbb-ana-1gw.net.disney.com Gisco 891 [NA ) Y ™Y 172.16.1.139 Cisco Systems ACL_Global
O aancbb-ana-1gw.net.disney.com Gisco 891 [ NA | ) Y ™Y 172.16.1.139 Cisco Systems ACL_Global
O aancbb-ana-1gw.net.disney.com Cisco 891 [NA ° ) ® 172.16.1.139 Cisco Systems ACL_Global

In order to delete the records at shot bulk delete is used.
Based on filters applied, records can be deleted

e [f the filter is on Device(device id/ device group/ device Type) And invoke Bulk

delete, all the records related to devices are deleted.

e |If the filter is on Policy and Bulk delete is invoked,all the records Related to policies
across all devices are deleted.(columns like Policy, rule, condition, expected pattern,

enforcement time- empty)

e If the filter is on device + policy and bulk delete is invoked, all the records related to
policies across all devices are deleted but Device is not deleted.(columns like Policy,

rule, condition, expected pattern, enforcement time- empty)

e If the filter is policy+rule+condition, where there are many rules or many
conditions, records are deleted at policy level only.(records having the selected

policies are deleted irrespective of rule or condition)
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Purge compliance history:

In order to delete history details, we can use purge compliance history under
Monitoring--> jobs— Maintenance— purge compliance history..

& 17216.3.40

Dashboard  Policies  Profiles

Report  Remediation  Archive

c

Host Name

[ wnacrp-dtss-0-gw test com

Device Type Severity Compliance
Cisco C3R 1000V )

Unit 3
=8
Rule Name Conditi
2l cl

R Jobs

£ Search for a config QCcs

Il botorreports
» collection

el * configuration

9 » diagnostic
» discovery

D [ESTS—

* ¥ maintenance
PurgeComplianceHistory
PurgeNetifications
PurgeOlderAlarmRecords
PurgeOlderAuditLogs
PurgeOlderEvents
PurgeOiderTask
UnAckAckalert Job
purge_alerts
purge_audit_logs
purge_audit Joge-1
purge_audit_logs_2days
purge_events

tess-4

Edit PurgeComplianceHistory

Name »
PurgeComplianceHistory
Schedule

Enab

Description
I .Pu-rg\r\g-:n-r;\phance history
Interval

24

Maintenance-Type

PURGE_COMPLIANCE_HISTORY

Interval-Type

MINUTE m SECOND

Trinnarase Fuant

Say, the threshold is 60 and it is set for days. When this job is run, it deletes all the record
history details that are older than 60 days.

It can be set in hours too.
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Export:

Navigate to Resource Manager > Config Compliance -> reports(CRV/Pivot)

Using export will get report for all the records at one shot

@ Dashboard  Policies  Profiles  Report  Remediation  Archive
= T Filter ~ 2 Skipped Conditi 60 Compliant @ 48 Non Compliant Total val Unit B
o e @ 25kipped Conditions @ 60 Compliant @ 48 Non Compliant  [EE[J) Tota B O vie i
i Device Id ~  Device Type > Vendor ~  Compliance Status ~  Condition Status ~  Locations -
1
Resource pools v Device groups v Severity v Execution Status v Policy v RuleName -
*
c i search Q
(]
Host Device Type Severity Device Compliance Status Execution Condition Status Device Id Vendor Policy Name
Export
& O disney.com Gisco 891 ) Y ™Y 172.16.1.139 Cisco Systems ACL_Global
Bulk Delete
>, D i disney.com Cisco 891 (] (] ] 172.16.1.139 Cisco Systems ACL_Global
O aancbb-ana-1gw.net disney.com Cisco 891 Y Y ™Y 172.16.1.139 Cisco Systems ACL_Global
O aancbb-ana-1gw.net.disney.com Cisco 891 Y Y ™Y 172.16.1.139 Cisco Systems ACL_Global
O aancbb-ana-1gw.netdisney.com Cisco 891 ° ) ® 172.16.1.139 Cisco Systems ACL_Global
O aancbb-ana-1gw.net.disney.com Cisco 891 Y Y ™Y 172.16.1.139 Cisco Systems ACL_Global
O aancbb-ana-1gw.net disney.com Cisco 891 Y Y ™Y 172.16.1.139 Cisco Systems ACL_Global

Upon applying filters and the user does export, then the user can get only those records.
Without applying filters, if the user does export, all records are exported.

Provide a name to export file to be saved

Export

report

Close

Export file will be saved in the archive tab.
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Archive:
Navigate to Resource Manager > Config Compliance -> Archive
From here we can download the report and delete as well. File download format is CSV.

The headers of the downloaded csv report are according to the filter applied.
If pivot views are applied, the headers are according to it.

Dashboard Policies Profiles Report Remediation Archive

c

Name ReportType Size Owner Shared with

D ConditionView_April 7 CONDITIONS_REPORT 900 bytes coke coke.*

D Device Report DEVICE_SUMMARY 352 bytes coke coke.®

[ Lecation Report LOCATION_SUMMARY 242 bytes coke coke.* coke.north

@ Dashboard Policies Profiles Report Remediation Archive

C 3 W selected

Name ReportType Size Owner Shared With
I I - D ConditienView_April 7 CONDITIONS_REPORT 900 bytes coke coke.*
Device Report DEVICE_SUMMARY 352 bytes coke coke.*
.r:z [ vocation Report LOCATION_SUMMARY 242 bytes coke coke.* coke.north
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Dashboard

There are 5 Dashboards which gives a quick information about compliance status
e Config compliance -devices: Representing the number of devices participated

in compliance v/s all the available devices in ATOM.

| :
] Config Compliance - Devices

Total Davices = 27

e Config compliance- execution status: A pie chart representing the percentage
of execution status in terms of successful, config_empty, config_stale, errors,
config_pull_failed, offline_device.

13 2
L ] Config Compliance - Execution Status

OFFLINE_DEVICE: 0.0 % (00 COMFIG_STALE: 0.0 % (00
CONAG_PULL_FAILED: T T CONFIG_ERIPTY: 0.0 % (00
0.0 % (00

250 % (1)

SWCCESSFUL: 7500 % (2)
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e Config compliance- compliance status: A pie chart representing the
percentage of compliance in terms of Complaint, Non- compliant,

Not_applicable.

L =3 Config Compliance - Compliance Status

Ls

COMPLIANT: Z25.0 % {13

HON_COMPLIANT: 50.0 % (2}

- NOT_APPLICAELE: 25.0% (1)

e Compliance status by group: A bar graph representing compliance status
such as complaint, non-compliant, not_applicable for each and every device

group on which compliance profile jobs are run.

(O] Compliance Status by Device Group

MOT_APPLICABLE @ COBMPLIANT HOMN_COMPLIANT

wyar 2 Routar cisco-groups Laysr 2/2 switch Layar 2 switch

e Execution status by device group: A bar graph representing execution status
such as config pull failed, not applicable, config_stale, errors, offline device,
successful, config_empty for each and every device group on which
compliance profile jobs are run.

Upon clicking on any of the dashboards, the user is navigated to CRV.
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&  Execution Status by Device Group
B COMFIG_PULL_FAILED & NOT_APPLICABLE @ COMFIG_STALE @ ERRORS
& OFFLUINE_DEVICE & SUCCESSFUL COMNFIG_EMPTY

a

E z

3

5 2

e

= k

1

=

= 2

o 2

=

=

bl

=]

= 1 1 1

S 1

i

o

Layar 2 Routar cisco-groups Layar 22 switch Layer 2 switch Firmwall

Upon clicking on any of the dashboards, the user is navigated to CRV.
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FAQ’s

e We have a multi-vendor network, can ATOM help ensure compliance in my
environment?

ATOM supports compliance management for Cisco, Juniper and Fortigate at this point in
time.

e We want to standardize the network configs even before introducing automation, can
ATOM help?

The standard configurations can be defined explicitly in ATOM's compliance framework.
ATOM will perform compliance checks against the network and perform remediation in

case of non-compliance to standardize the network configurations.

e We already have a platform which checks for compliance, but the remediation is
manual, can ATOM help ?

Yes, ATOM is capable of performing remediation on non-compliant devices. The Fix-CLI
or derived CLIs can be scheduled or executed immediately to fix all non-compliance
issues in the network.

e (Can we schedule compliance checks periodically using ATOM ?

Yes, the profiling section in ATOM's compliance framework supports scheduling of
compliance checks against a device or a group of devices

e Can ATOM's compliance help in achieving regulatory compliance ?
Yes, based on the policies that regulatory authorities specify, ATOM's compliance
management framework can be configured to meet these requirements.

e We have multiple checks that need to be run on the network, can ATOM help handle this

scenario ?

ATOM'’s profiling section supports grouping of multiple policies
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Appendix
e Writing Jinja template configurations based on Test Result output

Below is a sample output from the test result obtained in Launching Test Config. This helps

writing jinja2 templates as required in use case requirements.

{
"compliance-policies": {
"highest-severity": "",
"rule-violation-count": O,
"compliance-status": "compliant",
"compliant-rules-output": {
"violated-conditions": "",
"device-compliance-condition-output": {
"block-start-unmatched-content": "<![CDATA[]]>",
"block-start-condition-search-output": "<![CDATA[{
"block_start_matched_contents" : []
H>",
"condition-search-output": "<![CDATA[{
"matched_contents" : [ {
"groups" : [ {
"index" : 1,
"grep_content" : "1.1.1.1",
"grep_group" : 1
13
1A
"groups" : [ {
"index" : 1,
"grep_content" :"2.2.2.2",
"grep_group" :1
13
3
H>",
"total-block-count": 2,
"aggregated-condition-ouput": "<![CDATA[{

"condition_contents" : [ {
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"condition_id" : null,
"block_start_matched_content" : null,
"block_start_unmatched _content" : null,
"unmatched_content" : null,
"matched_content" : null

1

H>",

"template-substituted-content": "<![CDATA[ntp server (?!10.0.0.1)(\d+.\d+.\d+.\d+)]]>",

"block-unmatch-count": 0,

"cli-match-output": "<![CDATA[ntp server 1.1.1.1
ntp server 2.2.2.2

11>,

"condition-status": true,

"unmatched-content": "<![CDATA[]]>",

"id": "Remove_NTP_Extra_Config",

"block-match-count": 2,

"cli-unmatch-output": "<![CDATA[]]>"

17

"name": "test-condition",

n, un

"failed-conditions":

}
}
Keys Condition value Jinja2 template
matched_contents - ntp server {% for content in
when matched with (?110.0.0.1)(\d+.\d+.\d+.\d+) [ matched_contents -%}
regex in the condition {% for group in content["groups"]

%}

no ntp server {{
group["grep_content"] }}
{%- endfor %}

value with the test
configuration.

{% endfor %}
unmatched_contents - | line vty (.*) {% for content in
when matches with the | session-timeout {{ unmatched_contents %}
regex and does not session_timeout }} {% for group in content["groups"]
match with the block exec-timeout {{ exec_timeout | %}
config in the condition |}}0 line vty {{ group["grep_content"] }}
value with the test session-timeout {{
configuration. session_timeout }}

exec-timeout {{ exec_timeout }} 0
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exit
{% endfor %}
{% endfor %}
condition_contents - conditionl: {% for content in
condition1 captured interface LoopbackO unmatched_contents %}
data will be accessible ip address {% for group in content["groups"]
to condition2 using (\d+.\d+.\d+.\d+) %}
condition_contents. (\d+.\d+.\d+.\d+) router ospf {{
group("grep_content"] }}
condition2: router-id {{
router ospf (.*) condition_contents[0]["matched_c
router-id {{ ontent'l"]["mftched_conter:'ts"][O]["
condition_contents[0]["ma grczcups J[0]["grep_content"] }}
tched_con"tent"}["matc!:]ed ?‘;;Iendfor %)
_contents"][0]["groups"][0 {% endfor %)
1["grep_content"] }}

Configuration Drift (Network Services)

Whenever there is a configuration change in the device that does not match with the generated
configuration on ATOM, a reconciliation task is generated in ATOM. After viewing the config diff
generated, the administrator can decide how to reconcile these config differences so that the
device and ATOM are always in sync with respect to the configuration states.

e Navigate to Automation->Services->Reconciliation in the left pane

e In the right pane, click Reconciliation > Entities to view all the reconciliation entities
that are generated at the device level and service level.
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@® Summan y  Cstalog  Reconcilistion  Approvals q
c Servioss Mo
0 . .
O  Devi Entity Name Servica Operation Detected Time
il O 72163170 DELETE 20200416 08:49:39.108
O 17218113 DELETE 20200400 09:35:59.606
.
[l O 2 DELETE 2020-04-09 09:35:55.6
O 17z1ea DELETE 2020-04-09 09:35:59.594
© [NSpp. beiere 0200803093550 579
o O 17aea DeLETE 20200409 09:35:59.541
O 17z1ea DELETE 20200409 09:35:59.52
[y O e DELETE 20200409 09:3522 365
O 17216320 3 e DELETE 20200409 09:3516.995
>_ |NuRESLEr 13-2e DELETE 20200409 09:35:16.894
O 172165156 DELETE 2020-04-00 09:28:46 549

e Double click the reconciliation entity of your choice, to view the Reconciliation details:

) X Reconciliation-Details 2
- O
i
0 Device Operation Detected Time. Device
17216345
ih 172.16.3.4 UPDATE 2020-04-30 06:0¢
X O 172183 DELETE 2020-04-30 06:0¢ Entity Name Service
IS8 [ 172637 DELETE 116 08:4¢ interface=GigabitEthernet. 13
O 7z DELETE 20200409 09:3
@ O 17218113 DELETE 202000090938 Configuration Difference
- “description’ "MPLS ATT"
o O 17aea DeLETE 202004090035 - “ipaddress’: '83.0.0.13"
O 17z1ea DELETE 20200409 09:35 pvG-address”: "26530c0-1:2.1°
“ipvé-prefix-length’ : *126"
* O 17218 DELETE 2020-04-09 09:3% - “I3features-vrf” - "vrf4*
O 1721 DELETE 2020-04-09 09:32 netmask’: 235,000
>_ | uERFFAIEES DELETE 20200409 09:3
Confliguration to be reconciled
O 17218340 13-se DELETE 2020-04-00 09:3%
O 17216340 3-ce DeLETE 2020040900:35  operation-Updatelnterface
‘commands:
O 1721651% DELETE 202004-09 09:26 terface GigabitEthermt3
ipv6 address 265:30c0:1:2:1/126
ipv6 enable
wrf forwarding vrf4
ip address 83.0.0.13 255.0.00
description MPLS ATT

The configuration difference between ATOM and the device is shown on the left pane where as
the right pane displays the configurations that should be pushed to the device to reconcile with
the state of ATOM.

e C(Click the Reconciliation Policy to create the policies for reconciling the config differences
either with the state of ATOM or with that of the device.

e OVERWRITE SERVER - The generated config diff is pushed to the database of
ATOM to reconcile with the state of the device

e OVERWRITE DEVICE - The generated config diff is pushed to the device to
reconcile with the state of ATOM.
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e WAIT FOR APPROVAL - Select this option if the generated reconciliation entities
require a review by an administrator. The generated config diff is sent to an
approver who can take the decision of either pushing the configurations to the
device or overwriting the ATOM database.

Device Reconciliation: aanchb-ana-1-gw.net.disney.com x

TaskD  JurazObEbLQbsiIdZpzliveg

QSR 30/04/2020,11:39:56 [ Unknown |

Logs  Commands

Setting the Global Policy

The policy configured in this setting will have an impact on all the reconciliation entities
generated for all devices.

Setting the Device Policy

You can set granular control of what needs to be done with the config diff generated by ATOM
for a specific device or a set of devices. The policy configured at the global level can be
overridden by the device level.

For example, if the global level the policy is set is WAIT FOR APPROVAL but at the device level it
is set to OVERWRITE DEVICE, all the reconciliation entities generated in ATOM for that device
will be reconciled with the state of ATOM.

Example

Let us understand how service compliance and reconciliation work by taking the service, L3
service” as follows:

1. Create a service instance in ATOM
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@ atom > Semvices » L3-Services =

2. Login to the device console and delete the “test VRF” from the device

172.16.3.42 - PuTTY - O X

3. Asthere is a config difference between the device and ATOM, a Reconciliation task is
triggered in ATOM.
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As the config change in the device is related to the created service in ATOM, a Service
Inventory task is created.

Servicelnventory_172.16.3.45

Task D POPPX1§m3USFyadoLeXBKaXg
LGSR BERY 30/04/2020,11:39:56 [ 30/04/2020, 11:39:56 JNGEECLER
[ @, 20208, 11:319:56 AM  Compliance e trollar:

complated for jeontrellar:services/13service v2il3-services/13-sarvicectast2. Service iz MON_COMPLIANT

The Service is marked as “Non Compliant” service as shown in the “Compliance”
Dashboard.

You can either resolve the service violation or look at the Reconciliation entities created.

Service Compliance

ATOM helps to detect any configuration deviations in network at the service level. ATOM
detects the missing, deleted, violated configurations of the services that have been instantiated
in ATOM and sends the reconciliation report.

When a service is instantiated on a device, all the necessary configurations are generated by
ATOM and pushed to the device. After the successful creation of the service on the device,
ATOM compares the running configuration on the device, compares this with the services that
were generated , flags the violations and marks the service as non-compliant.

If there is any service that is non-compliant, navigate to Automation ->
Services->Reconciliation->Services
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&® Summar) y Catalog  Reconciiation  Approvals
c Devicea zofz
‘D O stats Service Last Checked On Last Compliance Success.
||| O compuanT test2 04/30/20, 12:19:06 AM 01/21/20,8:53:27 AM
[0 MNON_COMPLIANT test3 04/30/20, 12:12:05 AM 02/12/20,11:23:39 PM
88 O orcowruaT anuta 04/30/20, 12:19:05 AM 02/17/20,11:23:39 PM

https://172.16.17.171:30443/ngui/atom/dashboard

Click Non Compliant Services to view those services

&® Summary  Catslog  Reconciliation  Approvals % Violstions 2
C  sdectsd Davices o
‘D B sews Service Last Checked On Last Compliance Success
ih O  compuanT test2 04/30/20, 12:19:06 AM 01/31/20,8:53:27 AM O Violsted
NON_COMPLIANT testd 04/30/20, 12:19:05 AM 02/12/20,11:2339 PM Yea
[8Y O orcomruaT anuta 04/30/20, 12:19:05 AM 02/17/20,11:2339 PM Yea 172.16.1.139
Vea 172.18.1.139
9 Yes 172.16.1.139
D Yes 172.16.1.139
Vea 172.18.1.139
* Yes 172.16.1.139
Yes Jeomrollerdevices/device=172.18.1.129
> Yes Ieor
Yes
Vea
Yes
Vea
Vea

Resolving Service Violations

ATOM generates the config diff, in the service created through ATOM. and pushes the deleted
configurations (that were either removed intentionally or accidentally) to the device, thus
enabling the administrator to maintain the same state of configuration in both.

1. Select Non Compliant Services > Click Resolve Violations
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@® Summary  Catslog  Reconcilistion  Approvals

C selected @ Devices

Status Service Last Checked On Last Compliznce Success

X Violations 2

il O compuanT tesi2 04/30/20, 12:19:06 AM 01/31/20, 8:53:27 AM O Vidlated
NON_COMPLIANT testd 04/30/20. 12:10:05 AM 02/12/20,11:23:39 PM ve
(S8 O norconruanT anuts 04/30/20, 12:19:05 AM 02/17/20, 11:23:39 PM ve
Ve feentroll
Yes feomrollerdevices/device=1

Yes Ieeniroller-devices/devi

Yes feomrollerdevices/device=1

2. Click the Task Viewer and look for the task named “RPC Operation:
Compliance:fix-service-violations”

Compliance:fix-service-violations x

TeskD  EykyQinof 7RBGSqIENNystag

LSREERY 30/04/2020, 11:26:32 [ 30/04/2020, 11:26:33 JUEEELER]
ion atior

%]

%]

service_v2:13-services/13-servicestests”,"task-1d": "EykyQinoF FRB6Sglohhyetag "}

€€€€§?é‘§

Collections in ATOM

ATOM collects network operational & performance data from multiple data sources such as
SNMP, Streaming Telemetry, SNMP Traps and Syslog.

Appropriate data source and data stream can be chosen based on device capabilities, and
throughput and latency requirements. Model-Driven Telemetry uses a push model and provides
near real-time access to operational & performance statistics.

The collected Operational and Performance data can be visualized using Grafana (available as
part of ATOM package) or in ATOM Ul (by using various built-in reports available in Report
section or under the device view). Users can build additional dashboards customized to their
interests. (See ATOM Platform Guide to know more on how to create custom dashboards).

Jobs

A Job is the configurable task on a device that can be managed by ATOM. A job thus created can
be a piece of work that can be created, executed and tracked in ATOM. Depending on the need,
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the administrator can schedule and manually run various Jobs to collect data about the device
state.

Jobs are classified into the following types:

o Collection Job

e Configuration Job
e Diagnostics Job

e Discovery Job

e Inventory Job

® Maintenance Job

e Batch-reports Job
e SNMP-collections Job

® Syslog-collection Job
o Telemetry-Collections Job

e Telemetry-measurement Job
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Collection Job

ATOM collects or retrieves the status of the device (OFFLINE or ONLINE) . By default, this job is
scheduled to run every 6 hours. Starting with 6.0 release, you can model the collection job to
collect information about the device using the SNMP OIDs. For more information, refer section,
“Modelling of Collection Job” in the “ATOM Platform Guide.”

Configuration Job

Configuration job retrieves the running configurations from the device, or is triggered in the
event of configuration discrepancies (either at the device or the service level) between the
device and ATOM.

Creating a Configuration Job
1. Navigate to Monitoring > Jobs > Configuration
2. Select the Configuration folder > Add Configuration

3. In the Create configuration screen, enter the values in the following fields:

latom > configurations ‘ll = O J
/7 C

Jobs

Seareh for s confi Q8 EditConfiguration

Configuration-Type
CLIDEVICE_COMPLIANCE SERVICE_COMPLIANCE

Interval-Type
MINUTE HOUR SECOND

Trigger-Naas-Event

Resource-Type

DEVICE_GROUP RESOURCE_POOL

Configuration-Pull-Type

e Name: Enter the name of the Job
e Description: Enter an appropriate description for the Job
e Configuration Type: Select the type of Configuration Job from the menu:

O CONFIG_RETRIEVAL - Retrieves the basic device configuration. This option is the
default value.

o DEVICE_COMPLIANCE - The device compliance job is triggered when there is a
violation of policy configured on the device or a set of devices. For information
about the Device Compliance Policies, refer "Creating Compliance Templates"
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o SERVICE_COMPLIANCE - The service compliance job is triggered when there is a
discrepancy in the service configurations available on ATOM and the device.

By default, ‘Servicelnventory’ Job of type Service Compliance is triggered every 5
minutes.

Resource Type: Select one of the following resource entities where the job should be
triggered:

o DEVICE: If the selected resource type is a Device, click Add to enter the IP
address of the device for ATOM to communicate with it.

o DEVICE GROUP: If the selected resource type is Device Group, click Add to enter
the device group for which the configuration jobs should be triggered.

o RESOURCE POOL: Click Add to select from the available resource pools where
the job should be run.

Config Pull type: If the selected configuration type is Config Retrieval, you can opt for
one of the following methods to be used while retrieving the configurations from the
device:

o TFTP_EXPORT - Select this option when ATOM should retrieve configs from the
TFTP server

o SHOW_COMMAND - Select this option if ATOM should retrieve configs from the
running configuration of the device. This will be useful when in some customer
environments where the TFTP port is disabled.

Parse Config: Select this option if the parsing of the configurations should be enabled on
the device/devices after the successful run of the config retrieval job.

Note: Use this option if you want to override the value set in the global parameters
of ATOM. By default, at the global level config parsing is enabled for all devices
However, using this option you can disable config parsing at the device level.

Schedule: Select the checkbox and schedule the job to be run at intervals
Interval: Enter the time period for which the job should be scheduled

Interval Type: Select the units of time when the job should be scheduled (HOUR or
MINUTE)

Click the Task viewer to check for the status of the executed job.

Option 1: A successful run of the Config Retrieval job, where ‘TFTP Export’ enabled,
fetches the following details from the device:
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Config Pull 172.16.3.31 x

Task ID BudL90c83_Rb-klyztiPhidw

Time Taken [EIENEAVRENENPE - EOEZIRESESEE (5 seconds)

Apr 3@, 20828, £:14:12 FM  RPC Operation retrieve-configs started.
Apr 38, 228, 6:14:12 PM Request

{"input": {"device-id": "172.16.3.31"}}

Apr 28, 2828, £:14:12 PM Config Pull Job started

Apr 38, 2828, 6:14:12 PM Config pull job started for 1 devices

Apr 38, 2828, &

Apr 38, 2828, 6:14:12 FM  Retrieving config for device: 172.16.3.31, osType=I0SXE

Apr 3@, 2028, £:14:12 PM  The following command(s) to be executed on device ana-cbb-1-
gw.net.disney.com(172.16.3.31)

1. copy running-config tftp://172.16.21.19/BudL90cB83_Rb-klyzt2PhNdw

Apr 3@, 2828, £:14:18 PM  Posted config-parse reguest on kafka. running-config = 34 KB

:14:12 PM Processing in Agent Name: default_agent

Apr 38, 2828, 6:14:18 PM Initiated config parsing, refer config parsing task details
Apr 3@, 2828, £:14:128 PM  Done retrieving configuration for the device : 172.16.3.31
Apr 28, 2828, £:14:13 PM Config request saved successfully

Case 2: A successful run of the Config Retrieval Job, with ‘show run config’, is shown as below:

Config Pull 172.16.3.31 x

Task 1D HEhAAFA9gwTi6EgPMe@ivFIw

Time Taken [RIUOENEFIORERRRYE - EUNEYLEIRENRIETE (24 seconds)

Apr 38, 2828, &:11:87 PM RPC Operation retrieve-configs started.

apr 28, 2e28, £:11:27 PM Request

{"input": {"device-id": "172.16.3.31"}}

Apr 3@, 2828, 6:11:@7 PM  Config Pull Job started

Apr 3@, 2828, &:11:87 PM  Config pull job started for 1 devices

Apr 28, 2828, 5:111:82 PM Processing in Agent Name: default_agent

Apr 3@, 2828, &:11:8% PM  Retrieving config for device: 172.16.3.31, osType=I0SXE
4Lpr 3@, 2828, &:11:38 PM  Posted config-parse reguest on kafka. running-config = 35 KB
Apr 38, 2828, &

Apr 38, 2028, 6

Apr 38, 2028, 6

:11:28 PM Initisted config parsing, refer config parsing task details
:11:38 PM  Done retrieving configuration for the device : 172.16.3.31
:11:38 PM Config reguest saved successfully

Diagnostics Job

Diagnostics job collects various CPU, memory utilization and interface performance data that is
used to provision the service. By creating a Diagnostics Job, you can run the basic device Telnet
or SNMP connections to the device and also perform module- level diagnostics.

Creating a Diagnostics Job

1. Navigate to Monitoring > Jobs > Diagnostic
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alc & | CreateDiagnostic | [

Name
diagnostics

Resource-Type

DEVICE_GROUP m RESOURCE_POOL

Schedule

O

telemetry-collections Description

Interval

Device ID
Selected 100f10  search
Deviceld 4

17216.1.139

oo

172.16.18.176
17216.3.32
17216.3.23
17216.3.41
17216.3.42

17216.3.43

oooo

2. Select Diagnostic and click Actions > Add Job
3. Inthe Add Diagnostic screen, enter values in the following fields:
e Name: Enter a name not exceeding 64 characters
e Description: Type an appropriate description for the job.
o Resource Type: Select one of the entities where the job should be run
o Device: Enter the IP address of the device
o Device Group: Select a device group from the drop-down list.

o Resource Pool: Select the resource pool from the available resource pools
in ATOM.

e Schedule: Select this option to run the job in specific intervals of time
o Interval: Enter a number representing a span of time.
o Interval Type: Select the units of time (minute or hour)

Click the Task Viewer pane and search for the Diagnostics job. A successful run of the
Diagnostic Job displays the following information in the task details:
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Create: diagnostic

Task 1D FUSQDUEYbTQUOWNrxlwaAD1IVE
Time Taken ELFiaigainery - g iiEal AT B el (1 seconds)

Apr 3B, 2828, PM  Reserved datanodes
PH Resuming commit

Iriggering data model commit

2]

=
=]
=
Apr 38, 2028, =]
Motification spec: SYSTEM, Generator type: DEFAULT, Timestamp: 2020-84-308T12:35:49.514F

Streams: ACLM
Payload:

et id>»
cdatancde - coun
cupdated - datanode - count r1</updated- datancde - caunts

CWNrxIwADIVg< ftask-id>
datarads - counts

cdeleted - datanade - cownt »Be fdeloted- datancde - count>
</task-comnit-notifications

s/notificaticons

¢ 3@, 2A2A, 6:85:43 PM Create: Sjobs:jobs/diagnosticjob:diagnostic/diagnostic=Jobl
diagrostic:

device-id: 172.16.1.139

end-tima: -1

interval-type: MINUTE

job-type: DIAGNOSTIC

name: Jobl

repeat-for-ever: true

resource- type: DEVICE

sehedule: false

synchronized: Lrue
r 38, Ip2d, &

N O T
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Discovery Job

Discovery job is used in discovery of the devices falling within a range of IP addresses.

The first step in provisioning a network is discovering the devices in the network. ATOM
discovers the devices in the pod using either CDP or LLDP. Based on this discovery, ATOM

automatically draws a network topology diagram.

P RA . PAIS - = Mnarztinn romnlated sucrassfinl v ——————————

If only SNMP is enabled, the topology diagram cannot be drawn as SNMP does just the sweep,
which is not a methodical way of discovering device hierarchy. Therefore, it should be ensured

that either CDP or LLDP is enabled on all the devices managed by ATOM.

A SEED device is the starting point from which ATOM discovers the network and its peers or
neighbor devices. SEED discovery type should be selected when devices in a smaller range are
required in the topology. This method of discovery is quicker, but fewer number of devices are

discovered.

If the selected discovery type is SWEEP, the devices within a range of IP addresses are

discovered.
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Creating a Discovery Job
1. Navigate to Monitoring > Jobs > Discovery > Add Discovery

2. Inthe Create Discovery screen, enter values for the mandatory fields:

acs Create Discovery | [ X

IntervalType

MINUTE HOUR SECOND

Trigger-Naas-Event

Sweep-ip-Range

e Name: Enter an alphanumeric string to identify the created discovery job
e Description: Enter some text that describes the Job

e Discovery Type: Select one of the discovery protocols that used for discovering
devices:

e SEED - By default, the discovery type is SEED.
e SWEEP - Change the value to SWEEP, if you want more devices to be discovered.

o Seed Type: Select the type of the seed protocol, either CDP or LLDP. In case the
Discovery type is selected as SWEEP, enter the SWEEP IP range in the field.

NOTE: This IP range should be the same or a subset of the range of IP
addresses defined in the Credential Map. IP addresses can be expressed in
CIDR notation as well.

e Hop Count: Enter the number of hops (devices)that ATOM should discover from
the seed device while using CDP.

e Seed IP Address: Enter the IP Address of the seed device from which the
discovery of the neighbouring devices should be initiated.

e Auto manage: Select this option to add the discovered devices to ATOM
automatically.
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If this option is selected, a Managed Task is generated after the successful run of
the discovery job.
e Schedule: Select this option if this job should be scheduled at prescribed time
intervals.
o Interval: Enter the period of time within which the job should be
scheduled

o Interval Type: Enter the units of time (HOUR or MINUTE)

A successful run of the Discovery Job with the SWEEP protocol is as shown as below:

Details of the Executed Job along with the devices that are discovered by ATOM in this job are

displayed as follows:
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Discovery

Task ID IgGF _GrkdQsn2liuFanmdhghg

LR E T 30/04/2020, 18:19:38 I Unknown |

PH RPC Opera
P Request
“DFLGEQouSPFL - EVtgthkeh-ow™} }

P Discovery Job RPC started.

PH  default_agent: Setting State to:MAMAGED for Discovered Device:172.16.3.39
+19:30 PH Discovered Dewice 172.16.3.39 with Serial Number eb91182f3eB6

19:32 pH default_agent Discovery completed for: 172.16.3.39

PH  17Z.16.3.39 managed.

P default_agent: Setting 5tate to:MAMAGED for Discovered Device:172.16.3.38
PH  Discovered Dewice 172.15.3.38 with %erial Number 75cc23872789

PH  default_sgent:: Discovery complsted for: 172.16.3.38

PM  17Z.16.3.38 managed.

PH  default_agent: Setting State to:MAMAGED for Discovered Device:172.16.3.34
PH  Discovered Dewice 172.16.3.34 with Serial Number 94WBQLOSULE

M default_agent:: Discowvery completed for: 172.16.3.34

PH 17Z.16.3.34 managed.

PH  default_agent: Setting State to:MAMAGED for Discovered Device:172.16.3.32
PH  Discovered Dewice 172.18.3.32 with Serial Number $XXKSSPQRLES

M default_agent:: Discowvery completed for: 172.16.3.32

PH 172.16.3.32 managed.

n jobs:runjob started.

&o&
-
113
s
7]

&

EERERREEREERER

&o&
I
113

- - - -
[ R R
wowm oW W oW
B
oA

-
-
w
=
el

6:19:45 pH  default_agent: Setting State to:MAMAGED for Discovered Device:172.16.3.49
6:19:45 PH Discovered Dewvice 172.16.3.49 with Serial Number 92GIZ0UXSBF

6:19:45 pM  default_agent:: Discovery completed for: 172.16.3.49

6:19:45 PH 172.16.3.49 managed.

&
iy
W
4
o

PH  default_agent: Setting State to:MAMAGED for Discovered Device:172.16.3.33
5 PH Discovered Device 172.15.3.33 with Serial Number 91ZEWZF1386E

5 PH default_agent Discovery compleated for: 172.16.3.33

5 PH 172.16.3.33 managed.

5 M default_sgent: Setting State to:MAMAGED for Discovered Device:172.16.3.42
5 PH Discovered Device 172.15.3.42 with Serial Number 9H7EKRHS4UD

:19:46 PH  default_agent:: Discovery completed for: 172.16.3.42

i PH 172.16.3.42 managed.

5 PM default_agent: Setting State to:MAMAGED for Discowered Device:172.16.3.47
PM  Discovered Device 172.16.3.47 with Serial Number JHZXAVIIXLO

:19:47 PH default_agent:: Discovery completed for: 172.16.3.47

PH  172.16.3.47 managed.

&
-
113
e
=

= - - -
O e e
wowmoww
B
[ =

&
iy
W
4
=

-
[T
oo
I
N

&
iy
W
4
1

Discovered Devices

¢ 160F16 | Search a
O Device 4 Ip Address Serial Humber State Credential Prafile Hops
D CSR_3.47.anutacorp.com 17216.3.41 96TIOVAIBI) MANAGED i o

D GRE-WMX.5.05 17216339 2b211623e86 MANAGED eli L]

\:\ Router.anute.com 17216.3.48 9153GI3RXQS MANAGED oli o

D ana-buf-2-gw.anutacorp.com 17216.3.46 92ZDZREDRIU MANAGED i o

D ana-cbb-1-gw.net. disney.com 17216.3.31 9L5JZSL2TZG MANAGED oli o

D &na-cd-1-gw.net disney.com 17216.3.34 94WBQTDSUUE MANAGED oli o

D ana-sve-O-gw.net disney.com 17216343 QVOBKYATJIGF MANAGED cli a

D anuta-lab02 anutacorp.com 17216.3.32 OXXKSSPORLS MANAGED oli o

D anutachb-lab2 17216338 T50c23872709 MANAGED oli o

D csr_322 net disney.com 17216.3.30 9E156NJIBZD MANAGED cli o

D enscch 17216.3.47 QHZXAVIINLO MANAGED eli L]

D n7-chb-0-gw.net disney.com 17216342 9HTEKRHO4UD MANAGED cli a

[ testensechnasesloszens 17216336 SAIHAVFIDG MANAGED <i [

D whu anuta.com 17216.3.49 92GZ20UXIBF MANAGED oli o

\:\ whuchb-bur-0-gw.net disney.com 17216.3.33 QJZEWT1306E MANAGED oli o

[0  whuchb-bur-1-gw net disney com 17216344 9XJIDIKOATZE MANAGED i o

Managed Task

This task will be triggered in ATOM after the successful run of the discovery job. All the
discovered devices are added to the device table maintained in the ATOM inventory are marked
as “Managed” devices
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Manage Devices x
22/05/2019, 15:57:40 g 22/05/2019, 15:57:50 Time Taken : 1 seconds

TASKID : GIwLRFfZwfLS_i0YZKZIWKEISW

19/88/22 18:27:40 aql 172.16.1.139 managed.
e 72 1813 1: 172.16.1.138 managed.
mnofes 22 10:27:5 a1 Failed: @, Completed: 2, Total: 2

Inventory Job

Inventory job is used for detecting and adding device Interfaces, interface capabilities, and
interface addresses.

Extended Inventory: Retrieves the lost network connections, establishes the new network
connections between the devices, retrieves the configurations from the device, By default, this
job is scheduled to run every 12 hours.

Maintenance Job

You can configure the maintenance jobs to remove unwanted records of the tasks or the alarms
in ATOM. The maintenance jobs can be scheduled on a one-time basis or run

Periodically.

Purge Older Alarm Records
You can remove unwanted, older records of the Alarms generated in ATOM.
Creating a Purge Older Alarm Records Job
1. Navigate to Resource Manager > Jobs
2. In the left pane, navigate to the MAINTENANCE folder
3. Click the MAINTENANCE folder > Actions > Add Job
4. In the Create MAINTENANCE screen, enter the values for each field described below:

Maintenance Job Name: Enter a name for the maintenance job to be created.
Description: Enter a suitable description for the job
Maintenance Type: Select the type as " PURGE_OLDER_ALARM_RECORDS" to
create a job to clean all the old Alarms from ATOM

e Threshold (in days): Enter a number of days, of which the records for which
history should be maintained. All the records before the prescribed days will be
deleted.
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e Schedule: In order to schedule the job to run periodically at specified intervals of
time, select the Schedule option.

e Interval: Enter the number for the interval

e Interval Type: Select either Hour or Minute as units of time.

Example:

If 30, 24, and HOUR are entered as values in the fields - Threshold, Interval, and Interval
Type respectively, a maintenance job is executed every 24 hours that will remove all the
Alarm records older than 30 days. That is, all the records of the previous month before
the 30th day will be deleted..

Purge Older Task Details Records

You can schedule a maintenance job that can be run to remove all the details of the tasks run
before a specified period in time.

Creating a Purge Older Task Details Records
1. Navigate to Monitoring> Jobs
2. In the left pane, navigate to the maintenance folder
3. Click the maintenance folder > Actions > Add Job
4. In the Create maintenance screen, enter the values for each field described below:

Maintenance Job Name: Enter a name for the maintenance job to be created.
Description: Enter a suitable description for the job
Maintenance Type: Select the type as " PURGE_OLDER_TASK_RECORDS" to
create a job to clean all the details of the tasks

e Threshold (in days): Enter a number of days, of which the records for which
history should be maintained. All the records before the prescribed days will be
deleted.

e Schedule: In order to schedule the job to run periodically at specified intervals of
time, select the Schedule option.
Interval: Enter the number for the interval

e Interval Type: Select either Hour or Minute as units of time.

Example

If 30, 24, and HOUR are entered as values in the fields - Threshold, Interval, and Interval
Type respectively, a maintenance job is executed every 24 hours that will remove all the
details of the tasks older than 30 days. That is, all those task details of the previous
month before the 30th day will be deleted.
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>

>
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>
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>

.

>

>

.

Jobs

Search for a config

batchreports
colletion
configuation
diagnostic
discovery
fix.complanceiob
maintenance
measurement
anmp-collection
syslogcollection

telemetry-collections

Jobs

Search for a config

batchreports.
collection
configuration
diagnostic
discovery
fix-compliancerjob
maintenance:
measurement
snmp-collection
syslog-collection

telemetry-collections

acs

Attributes
resourcePath
Jjobsjobs

+ B @&

Name 4+

Job-Type

Description

PurgeOlderAlarmRecor
PurgeOlderhuditLogs
PurgeOiderEvents
PurgeOiderTask

UnAckAckAlertJob

oooooo0o|aQ

MAINTENANCE

MAINTENANCE

MAINTENANCE

MAINTENANCE

MAINTENANCE

Purging Alarm Records
Purging the Older Config Archives
Purging Events

Purging Older Tasks

Defauit job to schedule unAcknowledge the acknowledged alert

Maintenance-Type
PURGE_OLDER_NOTIFICATIONS
PURGE_OLDER_ALARM_RECORDS
PURGE_OLDER_AUDIT_LOGS
PURGE_OLDER_EVENTS
PURGE_OLDER_TASKS

UNACK_ACKGED_ALERT

Threshold

606 | Search

Q03000
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Image Manager

ATOM acts as Network Element Image Repository (Image Server). Devices can boot an
Image from ATOM Image Server manually or through ATOM Network Element Software
Image Upgrade Workflow. Image Transfer is supported through SFTP.

Following steps enable SFTP on ATOM & Upload Images:

1. Navigate to Administration > User Management > Users and select the target
user and click on edit.

User Name 4 First-Name Last-Name Email Phone-Number

subbareddyk@anutanetworks.com 555-555-1212

ser
c
i
-]
||| dmi System Administrator
O

kmanoj T Manoj Kumar kmanoj@anutanetworks.com

(<N
®®

2. Enable SFTP in the user and click on save option.
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® Edit User x @

O B

local.mode -
11
B cnablestip
2
2

Security-Question o

What s the country of your ultimate dream vacation? x -

(o)

Security-Answer o

Password

Confirm Passworde

Enable-Address

O

Role

3. To upload a file to the Image Manager navigate to Resource Manager > Image Manager

search by file name Q

UL

Resource Manager
pwes.0.02ip
Devices

Network
1 IPAM
Locations
Groups
Config Compliance
Software Compliance
Config Scheduler
Image Manager
U

4. Click on the upload option
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-y | scerch by il name Q
c
© @
& scad Irkflow-8.5.0.0.zip

11

)

%)

[u]

®R | searc h by file name Q .

c +

@ scale_compliance_workflow-8.5.0.0.zip

$ O

Once files got uploaded to the image-manager then login to the client device, then transfer
the files to a particular location on device by using scp protocol..

Syntax : file copy scp://{user-name}@/{file-server IP}:{file-server node port}./{path}/{file-name}
{Destination path}/{file-name}

Example : file copy
scp://admin@10.113.10.44:32222:/pub/images/junos-vmhost-install-mx-x86-64-18.3R1.9.tgz
re0:/var/tmp/junos-vmhost-install-mx-x86-64-18.3R1.9.tgz
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anuta@Services-PE-OCl-Lab-RE1> file copy scp://admin@l0.113.10.44:32222:/pub/images/junos-vmhost-install-mx-x86-64-18.3R1.9.tgz re@:/var/tmp/junos-vmhost-install-mx-x86-64-18.3R1.
The authenticity of host '[10.113.10.44]:32222 ([10.113.10.44]:32222)"' can't be established.

RSA key fingerprint is SHA256:3uq+6dWSATCvMHOy fA48DBBOYdW+T37cYeShvTORleM.

Are you sure you want to continue connecting (yes/no)? yes

Warning: Permanently added '[10.113.10.44]:32222' (RSA) to the list of known hosts.

Password authentication

Password:

junos-vmhost-install-mx-x86-64-18.3R1.9.tgz 3014MB 39.1MB/s 01:17

{master}
anuta@Services-PE-0Cl-Lab-RE1> file list /var/tmp

/var/tmp:
10-15-19_Services-PE-0C1-Lab-REO-10g5.tgz
10-15-10 Services-PE-0Cl-lab-REl-logs.tgz

{master}
anuta@Services-PE-0C1-Lab-RE1> file list re@:/var/tmp

/var/tmp:
LOCK_FILE
appidd cust_app_trace

appidd_trace_debug

etc/

juniper.conf.sync.gz
junos-install-mx-x86-64-18.4R1.8.tgz*
junos-install-mx-x86-64-20.1R1-S1.2.tgz*
junos-vmhost-install-mx-x86-64-18.3R1.9.tgz
krt_rpf_filter.txt

mmcq_mmdb_rep_mmcg

mmcq_sdb_bbe mmcq

netproxy

package.log

pc /

pfe debug commands

pics/

pkg_cleanup.log

pkg_cleanup.log.err

pkg_cleanup.log.old

ppe_trap fpcl LU 0 00.0

ppe_trap fpcl LU 6 06.1

ppe_trap_fpcl LU_1 00

ppe_trap fpcl LU 1 00
preinstall_boot_loader.conf

rtsdb/

sampled.pkts
sd-upgrade/
sec-download/
ttrace fpcl LU ©_00.
ttrace_fpcl LU ©_00.
ttrace fpcl LU 6 _01.
ttrace_fpcl LU ©_O1.
ttrace fpcl LU ©_02
ttrace Tpcl LU @ 02.
ttrace fpcl LU ©_03.
ttrace Tpcl LU @ 03.
ttrace fpcl LU 1 00
ttrace fpcl LU 1 00.
ttrace fpcl LU 1 01.
ttrace fpcl LU 1 01
ttrace fpcl LU 1 02.
ttrace fpcl LU 1 02.
ttrace fpcl LU 1 03
ttrace fpcl LU 1 3.

HoHOHOROHOHOHORO

{master}
anuta@Services-PE-0C

Note: When you try to copy the file from the file server to the client then service
atom-file-server-node ports should be running.
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Network Automation

ATOM provides stateful or Service and stateless (MOP) automation framework.

Stateless, Low Code or MOP automation - Low Code Workflow automation enables network
administrators to perform method-of-procedures involving different actions configuration,
operations including show & exec commands on the device. Multiple actions can be stitched
together to form a flow. Such flow is executed on one more device with appropriate user inputs.

Example:

1. Device Software Image Upgrade

2. Protocol Migration [IPV4 TO V6, OSPF to ISIS]

3. Hardware RMA/ Refresh [Moving from one vendor to another]

MOP Automation can be a combination of Stateless Action and Staful actions as well. In such
scenarios MOP will contain stateless actions like pre-checks while performing API invocations
against Device or Service Models to perform stateful transactional action.

Such tasks have no requirement for statefulness and can be best developed using Workflow
Automation.

Example:
1. Application Deployment in Data Center with Pre-checks and Post-Checks
2. Branch Config Deployment with Pre-Checks & Post-Checks

Stateful, Service Automation - ATOM Service automation helps administrators develop stateful
and atomic transactions. Admins can create service models that enable Create, Update and
Delete operations (CRUD). Such operations can be carried out throughout the life of the service.
Brownfield service discovery is also supported.

Example:

1. Application Deployment in Data Center
2. Layer-3 VPN

3. Layer-2 VPN

4. Private Cloud to Public Cloud Interconnect

Network Workflow & Low Code Automation

Workflow breaks down an activity into subtasks and ties them together with network events,
provisioning actions, show-commands, pre-checks, post-checks, user forms and approvals,
timed background tasks, inventory checks etc.

Workflow Automation offers an intuitive graphical designer to automate network provisioning
and maintenance activities.
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Administrators can create simple or complex flows using ATOM Workflow’s drag and drop
interface. ATOM Workflow has prebuilt adaptors to enable integration with ticketing, billing,
0SS, BSS and many other network elements. Workflow can also automate multi-level approval
sequences. Use workflows for a one time project or for repetitive tasks. Workflow development
is covered in “Workflow Modelling” section in the ATOM Platform Guide guide. For automation
of tasks that require stateful and atomic transactions it is advised to use ATOM Service Models
discussed in ATOM Platform Guide.

Uploading Workflow Package

Navigate to Administration > Plugins & Extensions > Packages

1. Click on Add at the top bar to upload the packages.

Packages

c + B8 1-500f153 Pagel0f4 > >  Search Q

Version Name 4. Description Driver-Name Type System-Created Active
O sa20 Anuta Networks Anuta Networks Base Package DEVICE (] ()
O sa20 Anuta Networks Seed Data Anuta Networks Seed Data Package DEVICE (] ()
O sooo Arista Networks Aarista Networks Base Package DEVICE ® )
O 850028589 BigF BiglP Driver Package build=28589, branch=S(scmBranch), date..  BIG IP Device Driver DEVICE ® ]
O 76102158 BigP DEvICE ® ®
O es0028088 BigP DEVICE ® ®

7.020 DEvICE ® ®

& Administration pEvice ® ®

DEvICE ® )
Tasks and Events
DEvICE ® )
Tenants
DEVICE ® ®
System
DEvICE ® )
System Manager
DEVIcE ® [
Plugins & Extensions
InfobloxDeviceDriver DEVICE ® )
[
DEvICE ® ®
Tags Management Device Support
Juniper Networks Base Package DEVICE ® ®
UI Custorizations Network Functions
= = Juniper Networks Base Package DEvICE ® )
Troubleshoot
Juniper Telemetry DEVICE ® [}
DSL
Juniper194R1 Juniper194R110NetconfDriver DEVICE ® )
Deprecated
Juniper190penconfig Juniper190penconfig Base Package DEVICE ® )
File Server
PaloAlto Palo Alto Base Package DEVICE ® ]
About
_— [E—— \mware deice orver Package Vimiare Host oevice ° o
abstractdevicemodels Abstract Device Models SERVICE_MODEL ® ®
ice Models SERVICE_MODEL ® ®
ice Models SERVICE_MODEL ® ®
ice Models SERVICE_MODEL ) @

2. Upload workflow package and click on the tick mark

Up-Load Package

File-Upload

C:\fakepath\smu-7.5.0.0.zip m
@ ‘ | Type
oeviee

7.500 R Da. DEVICE

[

7.020 " DEVICE

7513 BiglP BigIP Driver Package bul.. BIG IP Device Driver DEVICE

7.0041 CISCO_CLASS_BASED_Q.. CISCO_CLASS_BASED_Q. DEVICE

7.000 CISCO_EIGRP_MIB CISCO_EIGRP_MIB Base .. DEvicE

7.000 CISCO_IPSLA_ETHERNE. CISCO_IPSLA_ETHERNE .. DEvicE

7.000 CISCO_PROCESS_MIB CISCO_PROCESS_MIB B.. DEVICE

7.020 i - DEVICE

7.000 aitrx Gitrx Base Package DEvIcE

7.5.0.0.16679 it ge buil.. DEVICE

7.000 Device SDK Device Model SDK Packa.. DEVICE

7.5.00 Device SDK Device Model SDK Packa. DEVICE

7.000 F5 Networks. F5 Networks Base Packa. DEVICE

00@0009900@900@-§
Q0000000000000 §

7000 Fotinet Foinet Base Package DEvIcE

7.020
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3. Select the package and click on Activate

= (o) atom > Packages g O Admn&
Packages :
9 X  Packages Information A
° CcC u @ o 3 Selected () 1-500f 51 u
© Versiom Name Description Driver-Name Type sctive
& false
[ 7020 IF-MIB IF-MIB Base Package DEVICE
|z 0 7.000 mib_dependencies mib_dependencies Package DEVICE
Description
© [0 7020 mib_dependencies mib_dependencies Package DEVICE smuworkflow Base Package
B [ 7500 Device SDK Device Model SDK Package DEVICE
& 7.5.0.0 smuworkflow smuworkflow Base Package SERVICE_MODEL driver-name
S ] 7000 Base P, DEVICE
- module-name
D 7.0.2.0 servicemodel Service Model SDK Package SERVICE_MODEL
smuworkflow
O 7000 abstractdevicemodels Abstract Device Models SERVICE_MODEL
[ 7.000 jinja2 Jinja2 Package SERVICE_MODEL Name
smuworkflow
[0 7500 capacitymgrdriver Capacity Manager Driver Pa, SYSTEM_SERVICE
0 7500 amgplistener Amgp Listener SYSTEM_SERVICE
Resource Path
0 7500 deviceinventorydriver Device Inventory Driver Pack SYSTEM_SERVICE /controller:packages/package=smuworkflow,7.5.0.0
[0 7.000 nexparser Parser SERVICE_MODEL
[0 7500 Vmware Service Vmware device Driver Packa. VmWare Host DEVICE :ylﬁ“:‘“'c’“‘w
alse
[0 7500716679 CitrixDeviceDriver Citrix Driver Package build= Citrix Device Driver DEVICE
] 7.000 Citrix Citrix Base Package DEVICE type

Workflow Lifecycle Management

A workflow definition defines the structure of a workflow. A workflow instance is an individual
execution of a workflow definition.The relation of the workflow instance to the workflow
definition is the same as the relation between Object and Class in Object Oriented
Programming.The workflow engine is responsible for creating workflow instances and managing
their state.

Workflow Instances traverse different states as they progress from the start to end.The various
states are as listed below:

e Active : Once the workflow is started it gets into an active state. Through-out the
different tasks , workflow continues to be in an active state and indicates an error free
execution.

e Error State : If there are unhandled exceptions in the scripts and programmatic/syntactic
errors in inline scripts the workflow execution goes to an error state.

e Internally Terminated : If there are any errors in communication with the device or any
custom RPCs throw exceptions which don't have explicit error handling defined in the
workflow they are internally terminated by ATOM and state is updated accordingly.

e Externally Terminated: If the Network Administrator finds any unexpected behavior
during any point in the workflow execution he has an option of manually terminating the
workflow instance. This is the only state which the end user can manually state to
terminate the flow.

165



ATOM User Guide

e Completed:Once the workflow is terminated and has reached the stop event, the
workflow goes to a completed stage and indicates a successful positive flow execution.

® m © 8Internally Terminated @ 4 Completed 4 Active  ® 1 Externally Terminated ~ Version: 6 (Latest) X ~
0 . o o - - o __ o I I | . -<£ - =
. ERErasngls EEEEHT B =)o =
1h O ? ok m
. ) ‘ al =
o) I ® ol ~
2 &
= - o
e —
2 T F
S Hi 3 5 iL
o o R
O &
= ]
.

>_ { J-:Ho

C @ © imstances selected 170f17 | Search by Instance Name Q

Workflow Instance Name Workflow Id 1d State Start Time
O  upgl SoftwareMaintenanceUpgrade-IOSXR:6:1208983 1282898 INTERNALLY_TERMINATED 01/02/20,3:07:00 PM
a testw SoftwareMaintenanceUpgrade-IOSXR:6:1208983 1302670 INTERNALLY_TERMINATED 01/10/20,1:39:03 PM
test_smu SoftwareMaintenanceUpgrade-IOSXR:6:1208983 1743629 ACTIVE 05/01/20,3:11:10 PM

a test SoftwareMaintenanceUpgrade-IOSXR:6:1208983 1282681 COMPLETED 01/02/20,3:31:24 PM

O test SoftwareMaintenanceUpgrade-IOSXR:6:1208983 1283646 COMPLETED 01/02/20, 4:13:35 PM

O u2 SoftwareMaintenanceUpgrade-IOSXR:6:1208983 1303611 EXTERNALLY_TERMINATED 01/10/20,3:01:17 PM

M cmunn L ol D:6:12000! aoooo020  INTCONALIY TCOMINATED SoDhA

Start Workflows

To start a workflow instance follow the steps below.
1. Navigate to Automation > Workflows > Workflows
2. Select the workflow package from the list

3. Click on Start to start an instance of the workflow and provide valid Instance Name
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Actions

@® Summary ~ Workflows ~ Workflow Instances
0 @ O  sclected
Name

|I| smu-l0S-XE-upload-mock
o SnmpServerCli
¥ Snow_Alert
9 Software Image Upgrade Flow
&) Software Image Upgrade - 10S

Software Maintenance Upgrade - Fortigate
Q Software Maintenance Upgrade - I0OSXE
>_ Software Maintenance Upgrade - I0SXE - mock

Software Maintenance Upgrade - IOSXR

Software Maintenance Upgrade SNOW
Subprocess Execute CLI Commands
SWIM_Cisco_3850_16.x
SWIM_Cisco_3850_3.x_16.x

Switch MOP

testrpe

Traceroute

JO0OO0O0OO0OO0OO0ODO0OO0O®sO0OO0OO0OO0COO0OOODm Q

VRF Creation .Junos via CLI

Software Maintenance Upgrade - Juniper QFX

Software Maintenance Upgrade - IOSXR NONINTER...

IMAIN; VRE Workflow for Juno:

My Actions

Description

Software Maintenance Upgrade with Pre/Post Checks for Cisco...

Snmp server related cmds are pushed on device

Subprocess: Device onboarding Software Image Upgrade For Ci...

MAIN: Software Image Upgrade For Cisco 10S Platform

Software Maintenance Upgrade with Pre/Post Checks for Foritn...
Software Maintenance Upgrade with Pre/Post Checks for Cisco...
Software Maintenance Upgrade with Pre/Post Checks for Cisco...
Software Maintenance Upgrade with Pre/Post Checks for Cisco...
Software Maintenance Upgrade with Pre/Post Checks for Cisco...
Software Maintenance Upgrade with Pre/Post Checks for Junip...
Software Maintenance Upgrade with Pre/Post Checks for Cisco...

Subprocess: Execute commands with pre/post checks & multip...

MAIN: Supports Software Upgrade from 16.x to 16.x (OR) Dow...
MAIN: Supports Software Upgrade from 3.x to 16.x

MAIN: Supports Switch MOP

MAIN : Traceroute check for alerts

g CLL

50-930f93 IK < Page2 Of2 >
Version
1
1

1

Start Workflow | Software Maintenance Upgrade - IOSXR

Workflow Instance Names

I0SXR-SMU

Inspecting Workflows

To view the current running stage of the workflow

1. Navigate to Workflows > Instances

2. Click on Inspect

>| | search by Workflow Name Q
Key
smu-I0S-XE-upload-mock
SnmpServerCli
Snow_Alert
software_image_upgrade_flow
SoftwarelmageUpgrade-10S
SoftwareMaintenanceUpgrade-Fortigate
SoftwareMaintenanceUpgrade-IOSXE

Jpgrade-I0SXE-mock

SoftwareMaintenanceUpgrade-I0SXR
SoftwareMaintenanceUpgrade-IOSXR-NONINTERACTIVE
SoftwareMaintenanceUpgrade-JuniperQFX
SoftwareMaintenanceUpgradeSNOW
subprocess_execute_cli_commands
SWIM_Cisco_3850_16.x

SWIM_Cisco_3850_3.x_16.x

Switch_MOP'

Process_014bb9t

Traceroute

VRF Creation iunos via CLI

This opens a window with the workflow elements. Green indicates successfully completed tasks.
Yellow indicates the current task being executed
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c 10f1 | testsmu x
O  Workflow Instance Name Workflow Id 1d state Start Time

[u] g SoftwareMaintenanceUpgrade OSXR61208983 1743629 AcTivE 05/01/20,3:11:10 M

Suspend/Pause Workflows

In the workflow definition view and in the workflow instance view, can suspend the selected
workflow definition or workflow instance by using the suspend button on the panel.

Workflow Definition Suspension

If you suspend the workflow definition, you prevent the workflow definition from being
instantiated. No further operations can be done while the workflow definition is in the
suspended state. You can simply re-activate the workflow definition .
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® Summary ~ Workflows ~ Workflow Instances ~ Actions My Actions
0 cC © % Selected 50-930f93 |< Search by Workflow Name Q
\
B Neme @ Description Version Key
|Il O smu-l0S-XE-upload-mock Software Maintenance Upgrade with Pre/Post Checks for Cisco.. 1 smu-10S-XE-upload-mock
o O SnmpServerCli Snmp server related cmds are pushed on device 1 SnmpServercCli
- O  snow_Alert 1 Snow_Alert
9 O Software Image Upgrade Flow Subprocess: Device onboarding Software Image Upgrade For Ci.. 1 software_image_upgrade_flow
&) O Software Image Upgrade - 10S MAIN: Software Image Upgrade For Cisco 10S Platform 1 SoftwarelmageUpgrade-10S
O  software Maintenance Upgrade - Fortigate Software Maintenance Upgrade with Pre/Post Checks for Foritn.. 1 SoftwareMaintenanceUpgrade-Fortigate
Q O Software Maintenance Upgrade - I0OSXE Software Maintenance Upgrade with Pre/Post Checks for Cisco.. 1 SoftwareMaintenanceUpgrade-I0SXE
> [0  software Maintenance Upgrade - IOSXE - mock Software Maintenance Upgrade with Pre/Post Checks for Cisco.. 1 SoftwareMaintenanceUpgrade-I0SXE-mock
Software Maintenance Upgrade - IOSXR Software Maintenance Upgrade with Pre/Post Checks for Cisco.. 6 SoftwareMaintenanceUpgrade-I0SXR
O Software Maintenance Upgrade - IOSXR NONINTER. Software Maintenance Upgrade with Pre/Post Checks for Cisco... 1 SoftwareMaintenanceUpgrade-IOSXR-NONINTERACTIVE
O Software Maintenance Upgrade - Juniper QFX Software Maintenance Upgrade with Pre/Post Checks for Junip. 1 SoftwareMaintenanceUpgrade-JuniperQFX
O  software Maintenance Upgrade SNOW Software Maintenance Upgrade with Pre/Post Checks for Cisco.. 4 SoftwareMaintenanceUpgradeSNOW
O Subprocess Execute CLI Commands Subprocess: Execute commands with pre/post checks & multip.. 1 subprocess_execute_cli_commands
[0  SWIM_Cisco_3850_16.x MAIN: Supports Software Upgrade from 16.x to 16.x (OR) Dow.. 1 SWIM_Cisco_3850_16.x
[0  SWIM_Cisco_3850_3.x_16.x MAIN: Supports Software Upgrade from 3.x to 16.x 1 SWIM_Cisco_3850_3.x_16.x
O  switchmoP MAIN: Supports Switch MOP 1 Switch_MOP
O  testrpc 1 Process_014bbot
O  Traceroute MAIN : Traceroute check for alerts 1 Traceroute
M VRF Creation Junos via CLI MAIN; VRE Workflow for Junos via CLI 1 VRF Creation iunos via CLI

Workflow Instance Suspension

If you suspend the workflow instance, you can prevent the workflow instance from being
executed any further. This includes suspending all tasks included in the process instance. You

can re-activate the process instance at any later point of time.

®* w © 8 Intemally Terminated  ® 4 Completed
ey gy ey =
_1§Cj+ 3D o

4Active 1Extemally Terminated ~ Version: 6 (Latest) X

m

gana }:]
rH?«» Lo

- S

LDJ

) ' =

Advanced Search

o

C @ @ 'nstances Selected 170f17 | Search by Instance Name Q
B Workflow Instance Name Workflow Id 1d State Start Time

O  upgl SoftwareMaintenanceUpgrade-IOSXR:6:1208983 1282898 INTERNALLY_TERMINATED 01/02/20,3:07:00 PM

a testw SoftwareMaintenanceUpgrade-IOSXR:6:1208983 1302670 INTERNALLY_TERMINATED 01/10/20,1:39:03 PM
test_smu SoftwareMaintenanceUpgrade-IOSXR:6:1208983 1743629 ACTIVE 05/01/20,3:11:10 PM

a test SoftwareMaintenanceUpgrade-IOSXR:6:1208983 1282681 COMPLETED 01/02/20, 3:31:24 PM

O test SoftwareMaintenanceUpgrade-IOSXR:6:1208983 1283646 COMPLETED 01/02/20, 4:13:35 PM

O 2 SoftwareMaintenanceUpgrade-IOSXR:6:1208983 1303611 EXTERNALLY_TERMINATED 01/10/20,3:01:17 PM

Workflow Instance Error:

Unresolved programmatic/syntactic errors of a process instance or a sub process instance are
indicated by Atom workflow engine as errors. The Errors tab in the workflow instance view lists
the failed activities with additional information.
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: Minimap
4@
il 8 @ @
(Bl rcens

Oy ki

Ovennsent | ol e [ o] Toston
foll R
>

Variables  Actions

c 202 | Enterakeyword Q
@ s Timestamp Activity TR Root Cause Process Instance ID v

=] 2020.05-04T11:58:52.373+0000 Task Oitkép 114901 14901 failedJob

D Unable to evaluate script org camunda.spinjson... | 2020-05:04T11:56:52.475+0000 Task Oikkép 114903 114903 faileddob

Retry a Failed Job

To resolve an error you can use the Retry button on the top panel. Select the corresponding
instance, so the atom-engine will re-trigger this job and increment its retry value in the
database.

Rerres!

instance Name Workflow 1d 1d State Start Time

[m] 114862 ACTIVE 05/04/20, 5:28:51 PM
o 195408 INTERNALLY_TERMINATED 05/04/20,10:09:54 PM
(m] 198869 INTERNALLY_TERMINATED 05/04/20,10:1043 PM
o s1283 INTERNALLY_TERMINATED 03/13/20, 112728 AM
(m] 51394 ACTIVE 03/13/20,11:3029 AM
o 51515 ACTIVE 03/13/20,11:44:28 AM

[m] 55330 COMPLETED 03/13/20,3:33:28 PM
jemos 275111 ACTIVE 05/05/20,10:51:08 AM

Workflow Variables

Workflow Instance Variables can be used to add data to workflow runtime state. Various API
methods/Service Tasks that change the state of these entities allow updating of the attached
variables. In general, a variable consists of a name and a value. The name is used for
identification across workflow constructs. For example, if one activity sets a variable named var,
a follow-up activity can access it by using this name. The value of a variable is the value held by
that particular named variable in the Atom engine for that particular workflow instance context.

To view the workflow variables
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1. Select the particular workflow instance that is active.

@* w Toggle Details 5Active  ® 2 Externally Terminated

0 o
ih 3] +
%

R
D e
&
>

C @ @ instances selected 70f7 | Search by Instance Name Q
B Workflow Instance Name Workflow Id Id State Start Time

test45 SoftwareMaintenanceUpgrade-IOSXR:1:2165 3803 ACTIVE 05/26/20, 5:19:26 PM

O swua SoftwareMaintenanceUpgrade-IOSXR:1:2165 2348 EXTERNALLY_TERMINATED 05/26/20,3:12:08 PM

O smus SoftwareMaintenanceUpgrade-IOSXR:1:2165 2325 EXTERNALLY_TERMINATED 05/26/20,3:12:00 PM

O SMuU2 SoftwareMaintenanceUpgrade-lI0OSXR:1:2165 2287 ACTIVE 05/26/20,3:11:51 PM

O SMu1 SoftwareMaintenanceUpgrade-lI0OSXR:1:2165 2273 ACTIVE 05/26/20,3:11:41 PM

O sdf SoftwareMaintenanceUpgrade-lI0OSXR:1:2165 2611 ACTIVE 05/26/20,3:31:02 PM

2. View the workflow variables in the bottom panel.

Variables  Sub Workflow Instances ~ Actions  Errors

+ C 60f6 | Search by Name Q
[0 Variable Name Id Value Type

[0  atom_user_id 2288 0VpBgCazIxKc9BASVMThDZLA String

[0  businesskey 2289 SMu2 string

[0  atom_user_name 2290 admin String

[0  atom_user_owner 2291 system String

O Taskid 2293 2287:FCO3fpVv3sR-OxngoZzuslug String

I T .

3. Users can also edit the variable values during runtime.

=
o
+
Q Variable Namee
o showlnstallActive
Variable Types R
(]
String v O
o Variable Values
N <response>xrvOk-xr-6.1.4 version=6.1.4 [Boot image] xrvok-bgp-1.0.0.1-1614.CSCve28943
- </response>
Variables  Sub Workflow Instances ~ Actions  Errors
v C  selected 390f39 | Search by Name Q
B  Variable Name Id pe
LJ showinfSumm 1284619 tring
showlnstallActive 1284625 <response>xrvok-xr-6.1.4 version=6.1.4 [Boot image... String
[0  pre-upgradeimage 1284626 <respon String
[0  cfsCheck 1284632 <response>{u'cfs check’: u'cfs check\nThu Jan21... String
[0  clearConf 1284643 <response>{u'clear configuration inconsistency’: u... String
httns://172.16.22.137:30443/nai/atom/dashboard 10anan0

cnrnace -

4. Alternatively User can compare two variable values and see the difference on the
screen.
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®R w Trrbizrn

o . = e S o

" SERSresng I jef=H e =) (=]

ih C =0 s - :

%) - : E
R

& O

L]

N type showlnstallActive

B Bl ciseoz05 xR B! <response>xrvok-xr-6.1.4 version=6.1.4 [Boot image] xrv9k-bgp-1.0.0.1-

r614.CSCve28943 </response>

Variables  Sub V

] % se | Q

B Variable r; |

[0  anActiveRrs

type

[J  diskSpace

[0 showinfsu I
I

User Inputs

Some workflows may require the administrator to enter some values at particular stages.
Workflow execution will be stalled until the values are entered.

To view if any Action items are pending against a particular workflow instance we can view it
under the specific workflow instance view :

For viewing such tasks:

1. Select the particular workflow instance that is active.

@* w Toggle Details 5Active  ® 2 Externally Terminated

Advanced Search

C @ O instances selected 70f7 | Search by Instance Name Q
B Workflow Instance Name Workflow Id Id State Start Time

test45 SoftwareMaintenanceUpgrade-I0OSXR:1:2165 3803 ACTIVE 05/26/20, 5:19:26 PM

O swua SoftwareMaintenanceUpgrade-IOSXR:1:2165 2348 EXTERNALLY_TERMINATED 05/26/20,3:12:08 PM

O SMU3 SoftwareMaintenanceUpgrade-IOSXR:1:2165 2325 EXTERNALLY_TERMINATED 05/26/20, 3:12:00 PM

O SMuU2 SoftwareMaintenanceUpgrade-lI0OSXR:1:2165 2287 ACTIVE 05/26/20,3:11:51 PM

O SMUT SoftwareMaintenanceUpgrade-IOSXR:1:2165 2273 ACTIVE 05/26/20,3:11:41 PM

O sdf SoftwareMaintenanceUpgrade-lI0OSXR:1:2165 2611 ACTIVE 05/26/20,3:31:02 PM

2. Once Selected navigate to the action tabs to view all pending action items against this
particular workflow instance.
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[ ot [ Fosoeesie

Advanced Search

[0  Workflow Instance Id
[J 1284393
[m]

1284393

Workflow Instance Name

Name
SMU-IOSXR: approve reload

SMU-IOSXR: user inputs

20f2 | Search by Action Name Q
1d Workflow Id
1284761 SoftwareMaintenanceUpgrade-IOSXR:6:1208
1284503 SoftwareMaintenanceUpgrade-IOSXR:6:1208

For completing such tasks
1. Navigate to Workflows > Actions

2. Select the workflow task and click on Claim to claim the task

@® Summary ~ Workflows ~ Workflow Instances ~ Actions My Actions
Advanced seach -
0
¢ Selected 1-500f 388 Page1 Of8 > | | Searchby Action Name Q
ih Claim
. B Workflow nstance Id Workflow Instance Name Name Id Workflow Id
o 1833771 10SXR-SMU SMU-IOSXR: user inputs 1833781 SoftwareMaintenancelUpgr:
Q9 O 1817599 may18-ipvédemo User inputs 1817608 ipv6_configs:1:1205648
O 1816197 may18-demol Cisco APIC Details 1816205 cisco_apic_workflowV1:2:1
g O 1816005 abe Cisco APIC Details 1816013 cisco_apic_workflowV1:2:1
e [0 1800943 swmop-demo123 Rollback Approvals to push commands-172.16.5.63 1801361 Switch_MOP:1:1502738
5 D 1800943 swmop-demo123 Approvals to push commands-172.16.5.63 1801102 Switch_MOP:1:1502738
- [0 1800943 swmop-demo123 SWITCH MOP: Device user inputs 1800951 Switch_MOP:1:1502738
O 1800850 iosvlan-demo2 Approvals - 172.16.5.63 - push generated cmds 1800893 iosvlan:1:1425306
O 1800850 iosvlan-demo2 10S VLAN: Prerequisites to start workflow 1800858 iosvlan:1:1425306
O 1800748 fosvlan-test] Approvals - 172.16.5.63 - push generated cmds 1800795 iosvlan:1:1425306
D 1800748 iosvlan-test1 10S VLAN: Prerequisites to start workflow 1800756 iosvlan:1:1425306
O 1799909 13ser4 L3ServiceDeviceModel: deviceid 1799918 L3ServiceDeviceModel_Vali
O 1799834 13wer L3ServiceDeviceModel: deviceid 1799843 L3ServiceDeviceModel_Vali
O 1799521 13ser1 L3ServiceDeviceModel: deviceid 1799530 L3ServiceDeviceModel_Vali
O 1799228 1081 Approvals - 172.16.1.139 - push generated cmds 1799308 iosvlan:1:1425306
D 1799246 I3ser L3ServiceDeviceModel: deviceid 1799255 L3ServiceDeviceModel_Vali
O 1799228 1051 10S VLAN: Prerequisites to start workflow 1799236 iosvlan:1:1425306

3. Navigate to Workflow > My Actions

4. Select the task claimed at step 2 and click on Complete
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® Summary ~ Workflows ~ Workflow Instances ~ Actions My Actions
¢ Ay Seleoted 310f31 | Search by Action Name Q
©
Name Workflow Instance Name id Workflow Instance Id Workflow Id
III SMU-IOSXR: user inputs I0SXR-SMU 1833781 1833771 SoftwareMaintenanceUpgrade-|f
o5 [0  Ansible: user inputs 123456 1758061 1758053 anisbleflow:2:1121118
o [0  SMU-I0SXR: user inputs test_smu 1743639 1743629 SoftwareMaintenanceUpgrade-|
D CONFIG RESTORE: Inputs bul 1732492 1732483 config_restore:1:1295587
D [0  userinputs m 1710954 1710946 SoftwareMaintenanceUpgrade-J
o [0  userinputs test 1687633 1687625 cox_demo_1:1:1220032
[0  SwITCH MOP: Device user inputs Testswitchmop6 1680735 1680727 Switch_MOP:1:1502738
- [0  CONFIG RESTORE: Inputs testnbe 1680719 1680710 config_restore:1:1295587
[0  CONFIG RESTORE: Inputs gcl 1680450 1680441 config_restore:1:1295587
[0  Rollback Approvals to push commands-172.16.5...  Testswitchmop6 1680041 1679646 Switch_MOP:1:1502738
[0  updateSnmpConfiginputs Testbl 1651343 1651315 SnmpServerCli:1:736189
[0  userinputs sda 1530736 1530728 cox_demo:1:1408849
[0  userinputs k1 1512751 1512743 SoftwareMaintenanceUpgrade-Ji
O  userinputs juntrl 1512526 1512518 SoftwareMaintenanceUpgrade-Ji
[0 inputs to restore the configuration test] 1489709 1489701 Config_Restore:1:1295599
[0  userinputs testing1 1424453 1424445 SoftwareMaintenanceUpgrade-Ji
O  userinputs testcoxdemo1 1423084 1423076 cox_demo:1:1408849
[0  userinputs lag_demo 1408883 1408875 cox_demo:1:1408849

5. Enter values and click on the tick mark

* SMU-IOSXR: User Inputs (KX
0 172.16.18.176 = @
III Atom_stream_instance
Q Pl
= true
0 Protocol e
D
ftp

Server o

~
|

172.16.19.184
Path »

files
Backup_file o
backup.file

testtxt
Upgrade_files o

upgrade._files
xrv9k-6.1.4.CSCve28943 tar

Network Service Automation

Stateful services are developed using ATOM SDK and involve Service model developed in YANG
and optional business logic in Python. Such services have a continuous life cycle and undergo
multiple changes over a period.

Services can be deployed in two modes -

Greenfield Mode - A user can instantiate the service, a set of network configurations, using the
service template. These service templates are rendered from schema files that have been
developed as a part of the Service package. ATOM automatically generates and applies relevant
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configurations on to the devices.

Brownfield Mode - ATOM automatically discovers services running on the device and maps it to
the service template. For detailed information about service packages and how to write your
own service models, and usage of “maps-to” extension, refer to the “ATOM Platform Guide”.

Ordering Greenfield Services in ATOM

To order a service, that was modelled earlier, do the following:
1. Navigate to Automation > Services
2. Inthe right pane, click Add
3. Inthe ensuing form, enter values for the fields that are displayed.
4. Click OK
ATOM automatically generates relevant network configurations.

Note: If “Dry Run” is enabled in the Administration tab, the generated configurations will not be
applied to the devices.

Let us take an example of creating an instance of the “L3 Services” in ATOM. The schematic
representation of the service is defined in the .yang file (in this case, I3service.yang file). This file
is contained in the model folder of the corresponding service package (I3 service package)
uploaded as a plugin to ATOM.

1. Navigate to Administration > Plugins & Extensions

2. Navigate to Automation > Services > I13-services and click on Add

ﬁ L3-services instances

cC + B
0 U
[ nName 4 Service-Status Device ID
11
r*y
"

Deploying BSD services in ATOM

Let us take an example of the deploying the “Application Profiles” service in Brownfield
deployment mode:
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1. Obtain the appropriate service package from Anuta Networks
2. Upload the service package into ATOM.

3. Navigate to Administration > Deprecated > Services to view the uploaded service
package.

Administration

Tasks and Events
Tenants
System

Systemn Manager

Plugins & Extensions

User Management

Tags Management

Ul Customizations

Troubleshoot

DSL

Deprecated Services
File Server

About

4. In the Add Application Profiles pane, select the Brownfield Mode as shown below:

4 Add Application-Profiles Y Group =) Access Control

=+ Greenfield Mode irce-pool Device-ip Partition Domain-number  Vip-pool Vip-port Vip Lb-profile Pool-members Snat-members

== Brownfield M@e
No items to display

5. In the Create Application Services form, all the values discovered from the device are
populated in the parameters shown below:

Enter values in the fields that have been marked mandatory.
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Create application-profiles =%
Name* @ appservicel
Resource-Pool* @ | RP X ‘V‘
Devicelp* @ 172.16.3.37 X v

57
a3
L<]

Partition™ |
OThis field is required

Domain-Number® | X ‘V‘
@ This field is required
Vip-Poo* @ X v
Vip
Vip-Port™ @ e
+ Add Px
pool-members @
No Records Found <
[ oc ] carea ] remvines -

Note: The borders of the fields that contain the auto discovered values are coloured in
brown color.

6. Click OK after selecting the requisite values in each of the fields.

The commands that are generated in ATOM are not pushed to the device because of the
mode of Brownfield deployment.

Transactional control at the Service level

For every service, the admin can control whether the corresponding configurations, generated
by ATOM, should be pushed to the device. This gives an admin a granular level of control
wherein some services can be sent to the device and a few can be retained on ATOM.

1. Navigate to Automation > Services
2. Click the service that you want to configure the transaction policies.

3. You can either enter the values of the fields or import the values from a template to fill
the form.

4. In the Create service template,click Transaction Policies > Transaction Policy Configs
screen to set the control at the transaction level as shown:
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Do not send commands to devices

Fail Fast

Validation Scope

Command Seguence

Auto Rollback

Clonakle Device

COMMITTED_DATA ¥
DEFEMDEMCY_BASED ¥
»

Option

Type

Description

do-not- send-commands- to
-devices

boolean

Controls whether commands can be sent
to the device. devices

Select this option to commit the data to
ATOM datastore, but no configuration
changes will be applied on the device.
Useful for testing or in the case of a
brown-field environment to create
services.

Note: The value set for this option at the
transaction policy overrides the value at
the global level (in the General Settings)

fail-fast

boolean

Controls whether the reference validation
should be done immediately.

False: Defers the validation to after
‘commit-task’ state of the transaction

validation-scope-type

enum

Controls whether data validation scope is
across transactions. This flag is similar to

178




ATOM User Guide

isolation control in traditional RDBMS,
but limited to just data validation.
Allowed values are "COMMITTED_DATA"
and "UNCOMMITTED_DATA".

COMMITTED_DATA Validation will be done only using the

committed data. Current transaction will
not see changes done by other parallel

transactions
UNCOMMITTED_DATA

Data validation will be done using the
uncommitted data. Current transaction
will see changes done by other parallel
transactions

Command-sequence-policy | enum Controls whether the generated
commands need to be ordered according
to the dependencies specified in the
model.

DEPENDENCY_ BASED Generated commands will be re-ordered

based on the dependencies specified in
the data model.

NONE
Generated commands reflect the order of
the requests sent from the client, no
re-ordering is done

The values for following options can be cross-verified before creation of each service
e Fail Fast
e \Validation Scope
e Command Sequence Policy

Click the task created for the created service to view the commands generated by ATOM
in the Task Details.

In the Task details, click Commands to view the generated commands by ATOM. As the
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commands should not be sent to the device, (if do-not-send-commands-to-device option
is selected), the status of the commands is set to “TO_BE_PROVISIONED” as shown
below:

Create: |3-service x

21/05/2019, 18:24:39 gl 21/05/2019, 18:24:41 Time Taken : 2 seconds

TASKID : Maxe9xtYtcTXaaajRHgbVDvA

Logs Cﬂpﬁlmands

Result: DEVICE: name = CSR3.31.Anuta.com ip-address = 172.16.3.31

Operation: CreateVrf
Status: TO_BE_PROVISIONED

vrf definition test
address-family ipwv4

exit-address-family

Operation: Updatelnterface
Status: TO_BE_PROVISIONED

interface GigabitEthernet2
vrf forwarding test

ip address 10.18.48.19% 255.255.255.@

no shutdown [

RollbackCommands:

Download as Config i

The generated commands can be downloaded and verified with the expected configurations for

that service.

Cancelling an ordered Service

1. Select the service and click Delete.

2. In the Confirmation window, before selecting the Yes button, click the Transaction

Policies.
3. Select the option, “Do-not-send-commands-to-devices” in the policy

In the corresponding task generated, in the Task Details pane, click Commands to view
the generated commands by ATOM. As the commands should not be sent to the device
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(if “do not send commands to the device” option selected in the transaction policy
config), the status of the command is set to “TO_BE_PROVISIONED”.

IMPORTANT: If this option is not selected properly as per create behavior, the service
deletion might fail.

Service Approvals

You can create policies for approving creation, deletion or updation of the service configurations
on devices. In addition, you can add approvers who must approve the operations defined in the

service approval policy. Apart from seeking approvals for services, you can set approvers for any
of the operations for any entity in ATOM.

1. Navigate to Automation ->Services-> Approvals

2. Inthe right pane, click Add Policy to create the details as shown below:

i
&

(@) atom > senices

Create Policy D._

Entities - - h
Policy olicy-Name » Create Policy

Delete-ApprovatNeaded

=]

Update-Approval-Nesded

[&]
Policy-Type =

ALL

3. Navigate to the right pane to add details as described below:
i.  Policy Name: Enter a name for the approval policy

ii. Service Target: Enter the path for the object in the data model tree for which
approval is required.

For example: If the object of interest is a service, enter the path of the service.

/controller:services/I3service:I3-services, which means that the operation of
interest on this managed-cpe -service will be sent to the approver or approvers
for their perusal before being pushed to the device.
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Vi.

Provision Approval Needed: Check this option if the user selected as the
approver should approve the configurations before they are pushed to the
respective device or devices.

Delete Approval Needed: Check this option if the approver should approve the
configurations that are required for deletion of the service configurations from
the device or devices.

Update Approval Needed: Check this option if the admin should approve the
configurations that are required to update the service configurations on the
device or devices.

Policy Type: This option enables you to set if approvals are required from a single
approver or multiple approvers.

e ALL: The task that is generated as a result of a service operation awaits the approval of

all the approvers who have been added for that service .

In the following example, the operation of creating a ‘customer’ needs approval of two
approvers, ‘admin’ and ‘Userl’. The task is completed successfully after receiving the approval
of all the approvers as shown below:

=+

TASKID :

Approver

admin

KzH8TpVmaQREWKdAPPG3AT-A I}

| Delete: I3-service %

B 21/05/2019, 18:40:53 |8

Approvals

Status Notes

WAITING
i

|

Download as Config I

P

e ANY_ONE: The task generated as a result of a service operation awaits the approval of

any of the multiple approvers added for that service.

NOTE: All changes made in the service approval policy will come into effect only for the
subsequent service instantiations and will not affect the ongoing service operations.

4. Navigate to the left pane to add the tenant users who should approve the configurations
generated by ATOM for any of the service operations (create, delete or update ).
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a Create Policy E

“O Entities - - £ @
I .

Policy
ih T —

NOTE: Do not edit the name of the user (UserName) who has been added as an
approver in the service policy.

Agents

ATOM Agent handles all device communication which communicates with Other ATOM
Components either remotely or locally based on deployment mode.

Each ATOM Agent manages multiple network devices. ATOM agents can be assigned with
multiple CIDR blocks to manage the devices. It is used to communicate, collect and monitor the
networking devices in your infrastructure using standard protocols. Once the agent collects the
data, it gets encrypted and sent to Anuta ATOM Server over an outgoing SSL Connection.

One Agent can typically manage hundreds of devices. However, it depends on many other
factors such as device type, data collection, size of the data, frequency etc. Checkout ATOM
Agent Hardware requirements for further information.

ATOM Agent Deployment is discussed in detail in “ATOM Agent Deployment Guide”.

Administration

As an administrator, you can manage changes in the ATOM that will affect the behavior of the
system and have a global effect on all the components of ATOM.

e '"Tasks" and “Events”

e “Tenants"

e '"System"

e “System Manager”
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"Plugins and Extensions"

“User Management"

“Tag management"

“Ul Customizations"

“Troubleshoot"

lIDSLll

4

‘Deprecated"

“File Server"

“About"

Tasks & Events

You can view any activity, “task”that is being executed in ATOM as a result of an user- initiated

action. Tasks are generated during the following operations such as:

e Adding or Deleting Devices

e Executing Jobs

e Validating the resource pool and running the Inventory

e Configuration out -of -sync between the device and ATOM

e Creating or Deleting Networks

1. Select any Task and click Details to view the configurations associated with that task.

2. You can search for any Task by entering a query in the Search field.

3. Select any task and click Cancel to view the task is to be cancelled

4. Select any task and click Download Log to view the system related logs and message.
For example, enter “Create” in the Search field, if you want to query for all the Create
operations that have been executed so far. All the Create tasks that have been triggered
in various operations are displayed as shown below:

5. Click Retry when the creation of a Service (during instantiation of the Service) fails due
to deficit in the operational resources or during provisioning. 4. Click Task log to view the
system related logs and messages

Events

Events represent an important part of an operation or a change in the state of an object in
ATOM. For example, an event is generated when a user logins to ATOM. In addition, login

attempts to a device using any of the transport types is also displayed.
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Select a task and click Details to view the schema of the service, click Commands to view the
configurations associated with the service generated by ATOM.

TraceLogs

Trace Logs enables users to end-to-end distributed tracing of a task.User can monitor the
performance of the task and latency optimisation can be done. It actually helps users to
encounter the root cause analysis. The Tracelog option was enabled in tasks Ul and also in tasks
and events.

Select any task and click Trace Logs to view the task in distributed tracing.

Trace logs Ul can be visualized from jaeger Ul, this shows a complete cycle of the task and all the
components involved in it.

To Enable TraceLogs Navigate to Administration > User Management > Users
Here select a User and Entities > DLS-Config

®R Create Dls-Config [N x

Disable-Tracing

O

gl Logging Validity

0D Module-Scope

Enabled-Module
140F14  search a
O  EnabledModule 4

O compliance

O rog4 Include logdj logs

O parsing Parsing

[ performance Performance Numbers.
O roac RBAC

O schema Yang schema

[ sevice Service

O system Other system level

e Disable-Tracing: Set true to disable tracing for the user.

e Logging-Validity: Validity of the limited-time logging in seconds.

e Module-Scope: List of the modules that are supported for tracing.
Any: Enables any of the modules selected.
Selected: Enables only selected modules to tracelogs.
Disabled: Selected Module will disabled while tracing.
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should be up.

Note: When you select the trace logs from tasks Ul it opens in the new tab as jaeger Ul with
SSO URLs. When you select trace logs from Tasks and Events then it opens in the ATOM
application itself as a new window. To enable trace logs from deployment jaeger-tracing pods

X Tasks ¢ 530

Search

0 513
Awaiting Complete

device-config-diff-download

@ Operation completed successfully

O 2020-11-10 18:39:37

server-side-config-diff

@ Operation completed successfully

o 2020-11-10 18:39:06

server-side-config-diff

@ Operation completed successfully

O N7N-11-10 1/-30-N8

< v frontend: executeOperation:device-config-diff-download

16 1

Errors Running

Details

Trace Logs
Debug Logs
View

Download

z
Trace Start November 10 2020, 18:39:37. Duration 162.31ms Services2 Depth4 Total Spans 8
oms 40.58ms 81.15ms 121.73ms 162.31ms
Service & Operation v > ¥ » O0ms 40.58ms. 81.15ms 121.73ms 162.31ms

v | frontend executeOperation:device-config-difi-download I

v | Kafka To_anutaatom.yang notication

v | Kafka From_anuta atom.yang notfication

frontend from:anuta.atom.yang.notification

from:anuta.atom.yang.notification

> Tags: internal.span.format = proto

0.32ms

Service: frontend | Duration: 0.32ms | Start Time: 59ms

> Process: hostname = atom-frontend = ip = 10.200.15.143  jaeger.version = Java-1.4.0

frontend minio_getObject
v | Kafka To_anutaatom.yang notication
v | Kafka From_anuta atom.yang notmication

frontend from:anuta.atom.yang.notification

from:anuta.atom.yang.notification

> Tags: internal.span.format = proto

37dc693a88672da9 ¢

0.31ms

Service: frontend = Duration: 0.31ms | Start Time: 162ms

> Process: hostname = atom-frontend = ip = 10.200.15.143  jaeger.version = Java-1.4.0

60fef5525M07cefe ¢

186




ATOM User Guide

System

As an administrator, you may want to configure or modify the system settings or customize
these settings after installing ATOM.

n

Rule Engine"

"License"

General Settings"

"Look and Feel"

"Event Summary"

"Notifications"

Message Brokers"

Rule Engine

Rule engine is a functionality in which the user-defined business logic is executed to bring about
changes in the state of the resources managed by ATOM. The logic describes the sequence of
operations that is associated with data in a database to carry out the rule. You can create rules
in the Rule engine for ATOM to handle changes in devices in a maintainable, reusable,
extensible way. Rule engines support rules, conditions, priority (based on index), and other
functions. Rules can be constructed to serve various functions, some of which are listed below:

e Resources Validation

e Triggering different actions based on some user defined conditions

OooooooD0 Q

All the system defined rules available in ATOM as shown in the following snippet:

g

QAAPIR®Q g

Match-Type
MATCHALL
MATCHALL
MATCHALL
MATCHALL
MATCH_ANY
MATCHALL

MATCH_ALL

1-500f137 Page1 0f3 > >l | Search Q
Context-Path Change-Type
controller:de s/device UPDATE,CREATE DELET]|
Jeapacities:device-capacities/device-capacity/capacity-limits/c. CREATE
limits/c. DELETE
limits/c. UPDATE

Jeontrollerdevices/device

/controller-device: CREATE

/controllerdevices/device/capacitiesicapacities/capacity DELETE

Click on any rule > Entities of your interest and view the Actions and Conditions associated with

that rule.

For example, double click the ‘agent-down-alarm’ rule as shown below:

Rules.

Description

Ghanges in ActionDto

Changes in ActionDto

Glear alarm when Agent s Up

Alertianager alerts repeat interval time

QAQQQ0Q ¢

Amgp Listener Async Notification

Match-Type

MATCH_ALL
MATCH_ALL
MATCH_ALL
MATCH_ALL
MATCH_ALL
MATCH_ALL

MATCH_ALL

X Rules Information 2
1-500f137 Page Details Entities Pl |
Context-Path
Enter a keyword. Q

/alert-defactions|

Jalertdefactions)  Actions

efalertilt
Conditions

Jcontrollersysterr

feontroller system

Jeontroller:admin:

Jamaplistenersiar
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This rule comes to effect when any of the ATOM Agents goes OFFLINE and the status is
set to INACTIVE.

Actions

C 7/ [] i Selected n 10f1  search Q

Index ¢

10f1 | Search Q

c
O index 4 Description Condition-Expression Xpath-Expression

a o $../status == Inactive’

In addition to the rules that are available by default, you can create a custom rule as per
your requirement as described in the following section.
Rule

Rules are conditional statements that govern the conduct of business processes. A rule consists
of a condition and a set of actions. If that condition is met, and is evaluated as true then the
rule engine initiates one or more actions.

A rule is composed of three parts:

1. Condition - The condition part is a logical test that, if satisfied or evaluates to true,
causes the action to be carried out

2. Action - The action part consists of one or more actions that need to be performed
when the condition is met.

3. Event - The event part specifies the signal that triggers the invocation of the rule.

Create Rule
1. Navigate to Administration > System > Rule Engine > Rules
2. Click Add Rule and fill the following fields:
o Name: Enter a string that will be used to identify the rule.
o Rule Type: Select the category that the rule should belong to.
There are two types of categories available now:
m UNCATEGORIZED
m COMPLIANCE
o Enable: Select this option if the rule should be enabled.

o Rule Context: Enter the context in which the rule has to be triggered:
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CreateRule [

Entities + . X v

Name e

Rule

Context-Path e
/controllerdevices/device

Rule-Type
UNCATEGORIZED -

Change-Type

CREATE

UPDATE

DELETE

REPLACE
CREATE_UPDATE_REPLACE
ANY

Enable

Rule-Context o

DATAMODEL -

Description

Match-Type

m  DATAMODEL: Select this option if the rule should be triggered on a ATOM
managed entity.

e Context path: Example: For this rule to be applicable on the
devices, enter the context path as /controller:devices

m  EVENT: Select this option if the rule should be triggered in the case of an
event generated in ATOM.

e Event Spec: Select from the available event specs in ATOM:

CreateRule | [

Entities + . X \/
Rule
Event-Spec

i 3

Rule-Type
UNCATEGORIZED x -

Enable

Rule-Context o

EVENT X -

Description

Match-Type

MATCH_ALL MATCH_ANY
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o Description: Enter descriptive text for the rule

o Change type The rule engine will check for the conditions defined in the rule
when one of the following scenarios listed below:

Change -Type Description
o CREATE A component is created in ATOM
e UPDATE A component is updated in ATOM
e DELETE A component is deleted from ATOM
* Match-Type The conditions can be evaluated on an ANY or ALL basis.
Match-All: . All the conditions will be matched before executing the action.
e Match-Any: Any condition of the condition-set will be matched before executing the
action.
Create conditions?

Conditions are statements that should be qualified by the system before subsequent actions can
take place. In other words, conditions are what the rule is looking for to trigger an action.

1. Navigate to Administration > System > Rule Engine > Add Rule
2. Inthe Create Rule > Select Entity > click on + > conditions >click on + > rule-condition
3. Inthe right pane, enter values in the following fields:

e Index: Enter a unique number as an identifier

o Condition-Expression: Enter an expression that should be checked by the rule
engine for the condition to be true.

Example: To check for a condition when the device is ONLINE, enter an
expression: /controller:devices/device/status == 'ONLINE'

NOTE: Condition expression * means that the rule is triggered on all the conditions as
defined in the context path.

e Description: Enter some text describing the condition.

Create actions?

Actions are operations that will be performed on the entities managed by ATOM once that the
condition is evaluated as true by the Rule Engine.

1. Navigate to Administration > System > Rule Engine > Add Rule
2. In the Create Rule > Select Entity > click on + > Actions

3. In the right pane, enter values in the following fields:
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Index: Enter a unique number that will be used as an identifier and also setting the
priority

Type: Select the type of the component that should be acted upon, once the set
condition is true.

Description: Enter a description for the rule-action

Event-Name: Select the appropriate event-name from the drop-down menu

Licensing & Entitlements

Usage limits in ATOM are enforced through a license file issued by Anuta Networks.

ATOM in Dedicated Mode

License File can be applied at System Level or at Each Tenant. This is applicable to ATOM Cloud

Customers using a Silo/Dedicated Instance or an On-Premises instance. Following are the Admin

& Tenant privileges:

P wnN e

Anuta Networks will issue the License

For On-Premises Deployment - Customer will apply the License

For ATOM Cloud Deployment - ATOM Cloud Administrator will apply the License
System Admin will have full access (View, Apply & Usage) to System and Tenant License
Files

Tenant Admin/User will be able to view Available licenses and Usage for Tenant they are
assigned to

ATOM in Multi-Tenant or Shared Mode

This is applicable only in ATOM Cloud Following are the Admin & Tenant privileges:

1.

Anuta Networks will issue the License

Anuta Cloud Administrator will issue & Apply the License for each Tenant

System Admin will have full (View, Apply & Usage) access to System and Tenant License
Files

Tenant Admin/User will be able to view Available licenses and Usage for Tenant they are
assigned to

Uploading a License

We can upload the license using the upload button. Multiple license files can be uploaded to

ATOM. Usage limits are cumulative of all License Files.
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@® Licenses
® 0/130 0/120 0/130 0/130 3 Dec 31,2023
il Total Usage(C1) Total Usage(C2) Total Usage(C3) Total Usage(C4) Active Licenses Expiry Date
——
&
c o 30f3 | Search a
[l
@ O  vicen| Upload License(lic) File fmitC1 Device-Limit-C2 Device-Limit-C3. Device-Limit-C4 License-Type Expiry-Date Grace-Period Customer-Name Licens|
* [0 sTanparD 100 100 100 100 TRIAL 20211231 5 system valid
O sTanparo 20 10 10 20 TRIAL 2023-12-31 10 pepsi valid
* O sanbaro 10 10 20 10 TRIAL 20221231 10 coke Valid

Upload license *

License Summary

To view the License Summary & Details - Navigate to Administration > License

License Summary will show the overall summary across all the License Files.

© 0/130 0/120 0/130 0/130 3 Dec 31,2023

il Total Usage(C1) Total Usage(C2) Total Usage(C3) Total Usage(C4) Active Licenses Expiry Date

Total Usage(C1): C1 Category Licenses Used vs Allowed

Total Usage(C2): C2 Category Licenses Used vs Allowed

Total Usage(C3): C3 Category Licenses Used vs Allowed

Total Usage(C4): C4 Category Licenses Used vs Allowed

Active licenses: Number of licenses which are active will be shown under active licenses
Expiry date: Farthest expiry date among all the License Files

Below the License Summary, all available License File details are shown as below:

® 0/130 0/120 0/130 0/130 3 Dec 31,2023

ils Total Usage(C1) Total Usage(C2) Total Usage(C3) Total Usage(C4) Active Licenses Expiry Date

cC o 30f3  Search @
@ O ticenseTier 4 Device-Limit-C1 Device-Limit-C2 Device-Limit-C3 Device-Limit-C4 License-Type Expiry-Date. Grace-Period Customer-Name Licens|
* O sTanparo 100 100 100 100 TRIAL 20211231 5 system Valid
O sTanparp 20 10 10 20 TRIAL 20231231 10 pepsi Valid
* O sTanparp 10 10 20 10 TRIAL 20221231 10 coke Valid

Tenant admin license
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Licenses

0/100 1/100 0/100 0/100 1 Dec 31,2021

Total Usage(C1) Total Usage(C2) Total Usage(C3) Total Usage(C4) Active Licenses Cxpiry Date

£ Cc o 10f1 | search a

General Settings

You can edit and save the change the configuration parameters for each module in ATOM and
these global changes are applicable to all the resources contained in each module.

1. Go to Administration > System > General Settings

2. Inthe General Settings panel, you can review the default settings of the following
options and modify them.

3. Click Edit to modify the parameters arranged for each module.

URL Management

1. Base URL: This option enables the administrator to set the address (Base URL) for the
third-party clients to make API request calls to ATOM server. The format of the Base URL
is http[s]://ip|hostname, where ip is the IP address of the ATOM server and the
hostname is the host name of the ATOM server.

2. Support URL: Enter the URL of the support to login to the support portal of Anuta
Networks

3. User Session Timeout: This is the time that you can set for the ATOM server to timeout
if no activity takes place in the browser for a specified period of time. The user will be
automatically logged out of the session, after the expiry of the specified time.

Alert Monitoring

1.Unwanted-alertlabel-keys: Each alert consists of multiple labels like alert name, app,
collections_name etc, out of which some may not be persisted in Atom.

193



ATOM User Guide

Chart-setting

1.Chart-theme: Select the chart theme from drop down, it should show in the monitoring

custom chart.

2.Chart-refresh-interval: To set the default refresh interval,it should refresh the chart based on
the given interval time in this global set.

Device Management

1.

10.

Configuration Retrieval: This option enables the server to retrieve configurations from
the devices after each operation. By default, this option is selected.

Syslog Configuration: This option enables ATOM to configure the device to send syslog
events. By default, this option is selected.

Persist Configuration: This option enables the configurations to persist in the NVRAM of
the device after each provisioning.

Dry Run: This option enables ATOM to push the commands to the device or not. When
selected the commands are pushed to the device..

Auto Retry: Select this option to enable ATOM to try establishing the connection with
the device in case the connection is lost initially

a. Number of Retries: Enter the number of times that ATOM should try
establishing the connection with the device in case of failure.

b. Retry Wait Time: Enter the time period that ATOM should wait between
subsequent retries.

Configuration Parsing: This option enables ATOM to parse the configuration retrieved
from the device and store the configuration data in the data model maintained in ATOM.

Configuration Pull Type: This option determines how the mode of retrieving the running
configuration from the device

e TFTP_EXPORT - The running configurations are obtained from the TFTP server

e SHOW_COMMAND - The current configuration on the device are obtained by
ATOM

Log Running Config: This option enables ATOM to dump the retrieved configurations
from the device in the logs obtained for the Config Retrieval Jobs.

Run-extended-inventory: TConfiguration settings on disabling the extended inventory
when device is added

Generate-config-inventory-event: This option allows ATOM to enable or disable the
config inventory event
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Service now

1.Snow-instance : To enable service now option to perform the service now workflow
2.Snow-url : To provide the instance id for service-now
3.Snow-username : User name for service now

4.Snow-password : Password for service now

Service Management

1. Service Auto Retry: Select this option if ATOM should retry pushing the configurations to

the device in the event of a service failure.

a. Service Number of retries: Enter the number of times ATOM should retry
sending the configuration after initial failure of the service.

b. Service Retry Wait Time: Enter the duration of the time that ATOM should wait
before trying to establish a connection with the device again.

2. Auto Delete Stale Inv Data: Select this option if all the available “stale” entries should be
deleted from ATOM. Stale entries are the configurations that are available in the device

and not seen in ATOM. These differences are not due to the service configurations
created by ATOM and pushed to the device.

3. Delayed Event Buffer Time:

TSDB

1.Retention-period: Retention period of prometheus db

2.Retention-size: Retention period of prometheus db

3.Namespace: Namespace to get the stateful sets and config map

4. Tsdb-url: Url to get metrics

5.Workflow-url:The url to get workflow

6.Tsdb-config-map-name:The name of the tsdb config map

7.Tsdb-stats-name:The statefulset name of the tsdb server
8.Tsdb-infra-alert-config-map-name:The name of the tsdb config map for system alert
9.Alert-repeat-interval:The repeat interval time of the alerts

10.Tsdb-alert-manager-config-map-name:The name of the alert manager config map

SNMP v2 Configurations

1. Enable Device Audit Trail Mode: Select this option to view all the events generated in
ATOM while communicating with the device using the SNMP protocol. SNMP events
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such as SNMP WALK, GET, DEVICE_LOGIN and DEVICE_COMMAND EXECUTION are
captured in ATOM as Events.

2. Enable Multi Tenancy: Select this option to enable ownership of the resource. Once this
option is enabled, the fields “Owner & Sharedwith” are displayed

3. SNMP Configuration Contact: Enter the mailing ID for contacting the admin (support)
managing the SNMP server.

4. SNMP Configuration Location: Enter the location of SNMP server

5. SNMP Community string: Enter the community string required for authentication in
SNMPv2 sessions..

SMTP Configurations

You may have to configure an external email server to send email notifications to the ATOM
users.

SMTP Mail From: You can set up an external SMTP email server to send email notifications to
the ATOM users. To do so, enter values in the fields described below:

1. SMTP Host: Enter the name of the server that will send the email.
2. SMTP Port: Enter the number of the port that is used to connect to the SMTP host

3. SMTP Auth Required: Enable this option is authentication is required to connect to the
SMTP Host

4. SMTP User Name: Enter the name of SMTP user
5. SMTP Password: Enter the password to retrieve the email.

6. SMTP Encryption SSL: Select this option if the connection to the SMTP server should use
SSL as the authentication method.

7. SMTP Encryption TLS: Select this option if the connection to the SMTP server should use

TLS as the authentication method

Notification

Email Notifications: Select this option if you wish to be notified via email about changes taking
place in the system.

License Expiry Threshold (days): Set the number of days to notify the user that the license is

about to expire.

Python Remote Debug

Python Remote Debug: Select this option if you want to allow debugging of the logs in ATOM
remotely.

Debug Server Port: Enter the port number of the remote debug server.
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Developer Options

Enable Developer Mode: Select this option for the Developer Options to be visible in ATOM.

Using the Developer Options, the admin can view the all the ATOM entities represented in the
data model tree, figure out the xpaths of the objects, all the device and service ATOM SDK

System Maintenance

Enable Maintenance Mode: Select this option if the system needs to be suspended for some
time during which no operation can be performed on the ATOM VM. All the TASKS running in
ATOM should be in “COMPLETE” state before enabling this option.

View Actions

Show Module Prefixes: Enable this option if the module prefixes for child entities on Profile and
Action items should be made visible.

Request Sanitization

As an administrator , you can protect the data entered in ATOM from malicious attacks in the
form of HTML tags. These tags when injected into the application’s HTML code can make ATOM
vulnerable to these attacks and have a large impact as any user of the application can be a
target.

The data entered in ATOM can be sanitized based on the

1. Security Sanitizer Enabled: Select this option if the sanitization filter should be enabled
in ATOM.

2. Sanitizer Exclude URL: Enter the tags that should be excluded from filtering. The
patterns mentioned here are allowed as values in the text fields in any of the HTML
forms used in ATOM. For example, These tags can be added in the exclusion list
-/login,/initialize,/logout,/*.js,/controller:admin-settings$

3. Sanitizer Patterns: Enter the patterns that will be used to sanitize the data and should
not be allowed as values in any of the fields in any of the text fields in the HTML forms
of ATOM.

An appropriate error message is displayed in the webpage when the user inputted data
matches with the sanitizer pattern mentioned above.

Password Profile
The parameters required for a password that is used to authenticate logging into ATOM can be
1. Password Expiry Days: Enter the number of days for which the set password is valid.

2. Password Pattern:
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3. Password Min Length: Enter the minimum number of characters that should be
contained in the password used to authenticate the logging into ATOM.

4. Password Max Length: Enter the maximum number of characters that should be
contained in a password used to authenticate the logging into ATOM.

Primary container load limit

1.Set the range of container load limit

Workflow

1.If true both delete both active and historical instances on package unload,if false, history will
be maintained but unload will fail if active instances are there.

Look and Feel

You can change the "look and feel" of ATOM’s GUI by uploading images of your choice to ATOM.
1. Navigate to Administration > System > Look & Feel

e Product Logo: Select the image that you should be displayed as the product logo,
visible on all the screens.

e Login Screen Logo: Select the image that should be displayed on the login screen.
2. Click Update for the uploaded images to come into effect on the Ul
or

3. Click Defaults to revert to the default images.

Event Summary

ATOM generated events are grouped into different categories, (Alarm, Services and System)
with an assigned severity to each category. ATOM maintains an event catalog and decides how
and when an event is created and whether to associate an alarm with the event. Events are
generated in ATOM through notifications received via the syslog and trap messages, inventory
changes, discovery of the devices, changes in the ATOM server itself.

The severity of events can be classified into:

® CRITICAL - Events that demand the immediate attention of the system administrator.
They are generally directed at the global (system-wide) level, such as System or
Application. They can also be used to indicate that an application or system has failed or
stopped responding.

e WARNING - A warning indicates that a component or application is not in an ideal state
and that some further actions could result in a critical error. These can be treated as
forewarning of a problem that might occur.
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e ERROR - Events that indicate problems, but in a category that does not require
immediate attention.

e INFORMATIONAL - Events that pass noncritical information to the administrator.

Not all Events are associated with Alarms. Multiple events can be mapped to the same alarm.
All Alarm Events are associated with an alarm that can be either state, CLEARED or ACTIVE.

Notifications

All the events that are triggered in ATOM due to various reasons such as change in the
component state, device unreachability, high CPU usage of the system and so on can be
notified to subscribers. As an administrator, you can create notifications such that users,
message brokers can be notified when an event is triggered.

Subscribers can be added to the events falling in any of these categories:
e Alarm Events
e Internal Events
e System Events
® Resource Events
® Service Events

Each of these categories contain many Events, pre-defined in ATOM. You can create subscribers
or the recipients of a particular notification.
1. Navigate to Administration > System > Notifications

3

@ Alams Search

[ Reports

Service Events

- . click on any events to show
& Administration Alarm Events

Tasks and Events System Events

Internal Events

Tenants
System Resource Events
Rule Engine
License
General Settings
Look & Feel
Event Summary
Notifications
Amgp Listeners
Message Brokers
System Components
Domain APIs
System Manager

Plugins & Extensions

2. In the left pane, click a folder (of your choice). All the events are grouped into different
categories
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3. Inthe expanded view of the folder, select an Event as shown below:

) Alarms Search
Q 1to130f0 I< < Page0 of0 > >l C
Reports Service Events v
Administration [ Service Update Operation O  EventName Event Category
Started
o SERVICE_UPDATE_OPERATION_START S Event:
Tasks and Events B Service is out of sync a | - LS ervice Events
Tenants B Amgp Listner Added [  SERVICE_OUT_OF_SYNC Service Events
System e e alope ciogend [J  AMQP_NOTIFICATION Service Events
[ Service Update Operation End
EBEE [ TFTP read Successful [J  SERVICE_CREATE_OPERATION_END Service Events
o [B Service Create Operation Started [[]  SERVICE_UPDATE_OPERATION_END Service Events
icense
TFTP file upload aborted
: & P [J  TFTP_READ_SUCCESSFUL Service Events
General Settings [B Service Delete Operation Started
Lok Feal B Service Operation Rejected [C]  SERVICE_CREATE_OPERATION_START Service Events
[ Service Delete Operation End [J  TFTP_FILE_UPLOAD_ABORTED Service Events
Event Summary Service Operation Approved
& B 2 [J  SERVICE_DELETE_OPERATION_START Service Events
Notifications [B service Operation Waiting for
Approval [J  SERVICE_OPERATION_REJECTED Service Events
Amgp Listeners
P Alarm Events » [[J  SERVICE_DELETE_OPERATION_END Service Events
Message Brokers System Events > []  SERVICE_OPERATION_APPROVED Service Events
Internal Events >
System Components [[]  SERVICE_OPERATION_WAITING Service Events
A Resource Events >
Domain APIs
System Manager
Plugins & Extensions

4. In the Events Subscribers pane, click Add to the subscriber to the ATOM generated
event.

Create Subscriber

Subscriber Typee

5. In the Create Subscriber (s) screen, choose the type of the Subscriber:

o User

m These users are the users created in ATOM . See the section, Creating
Users in ATOM

o AMQP Broker

200



ATOM User Guide

m These are the message brokers where the events generated in ATOM are
published. See the section, Creating Message Brokers for more
information.

Message Brokers

As an administrator, you can configure a message broker to publish the events generated by
ATOM. A message broker can be notified of all events or an event belonging to a specific event

type.
In the current implementation of ATOM message brokers, RabbitMQ is the supported AMQP

server where ATOM publishes the events and from where any AMQP listener consumes them.

Prerequisites

Before creating Message Brokers in ATOM, check whether a virtual host exists in RabbitMQ.
If there is no existing vHost, create a new virtual host as shown below:

1. Login to RabbitMQ and go to the Virtual Hosts tab to add a new vHost

2. Add users for the created virtual host

3. Create users with required permissions in the vHost

Creating Message Brokers in ATOM

1. Navigate to Administration > System > Message Brokers > click Add

2. Inthe Create message broker screen, enter the following fields as described below:

Create Message-Broker &

Broker-Address e

Port Number o

User Name «

Password e

Vhost

Exchange o

Enable-Publishing
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Broker Address: Enter the IP address of the message broker (AMQP server which in our
case is RabbitMQ).

Port Number: This is the port number used to communicate with ATOM. By default, it is
5673.

Username and Password: Enter the credentials for logging into the message broker.

vHost: Enter the virtual host name that was created in RabbitMQ. Refer "Prerequisites"
section.

Exchange: Enter the name of the exchange in the message broker where the events
generated in ATOM should be published. The default name is “ATOMNotifications”.

Enable Publishing: This option enables the administrator to enable or disable sending
notifications from ATOM to the exchange. By default, the checkbox is selected, which
means that the events can be sent to the broker.

Connection Status: After saving the Message Broker, this field will be updated to
True/False based on the success or failure of connectivity to RabbitMQ

Click Add to select the events that should be sent to the message broker.

AMAQP Listeners

You can create AMQP listeners in ATOM so that the messages (events) published in ATOM can
be consumed by them.

In the current implementation of ATOM message brokers, RabbitMQ is the supported AMQP
server where ATOM publishes the events and from where any AMQP listener consumes them.

Prerequisites

1.
2.

Login to RabbitMQ Message Broker using the appropriate credentials
Create Queues in RabbitMQ
a. Login to RabbitMQ and go to the Queues tab.

b. Add a new queue as shown below:

202



ATOM User Guide

BRabbitMQ

Overview Connections Channels Exchanges Users Virtual Hosts

Queues

b All queues

v Add a new queue

Virtual host: |/ v

MName: Interface_Qxeue

Durability: | Durable v
Auto delete: (7) . No v
Message TTL: (?) ms
Auto expire: (7) ms

Dead letter exchange: (7)

I

Dead letter routing key: (?)

Arguments:

e

HTTP API | Command Line

3. Bind the Queue with the Exchange in RabbitMQ
i.  In RabbitMQ, navigate to Exchanges

ii.  An Exchange entry is created in RabbitMQ and connection with ATOM is
established

iii. Select the Exchange, “ATOMNOotifications”, created in ATOM and bind the
created Queue to the same as follows:
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BRabbit

Overview

Connections Channels Exchanges Queues

Exchange: NCXNotifications

r Overview

Type  topic

Parameters
+ Message rates

Incoming (7

... no publishes ...
» Bindings

Qutgoing from NCXNotifications

NCXNotifications | — ... no bindings ...
Add binding
queue ¥ | AgentQusus
NCxXMotifications | — Routing key: =
Arguments:

<=

Users Virtual Hosts

OQutgoing (7)

... no publishes ...

<=
<=

4. Verify the messages in RabbitMQ

i. GotoQueue > Get messages

ii. Inthe Messages field, enter a number for the messages that you want to be

displayed.

iii.  Click Get Messages as shown below:
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¥ Gel messages
‘Warning: getting messages from a queue is a destructive action,

Requeue: | Yes L
Encoding: | Auto string / base64 v

Messages: 30

Message 1

The server reported 275 meassagas remaining.
Exchange  NCxXNetifications
Routing Key
Redelivered »

Properties  delivery_mode: 1
headers:

Payload

Message 2
The server reported 274 messages remaining.
Exchange  NCxNotifications
Routing Key  ncloudx.task.background
Redelivered =

Froperties

Payload = Task_ld«7f8684ca-4305-4654-8780- 19ac38F3063d; Task_Component=Server; Task_ComponentType=SERVERDOE; Task_Operation=5ystesHealthCheck; Task_Status=NOT_STARTED;

Message 3

To create the AMQP listener in ATOM, do the following:
1. Navigate to Administration > System > AMQP Listeners
2. Click Add AMQP Listener in the right pane to create a listener in ATOM

Enter values in the fields in the Create AMQP Listener screen as described below:

Create Amqp-Listener [N

Broker-Address ¢

Port Number » [N

User Name o

Password »

Vhost e

/

Queue

Connection-Status
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o Broker Address: Enter the IP address of the AMQP server that will receive the
notifications from ATOM.

e Port Number: This is the port number that needs to be configured on the message
broker to listen into the ATOM notifications.

e Username: Enter the username of the AMQP listener.

e Password: Enter the password to authenticate the AMQP listener.

e vHost: Enter the virtual host name that was created in RabbitMQ

® Queue: Enter the name of the Queue created in the AMQP server (example, RabbitMQ)

o Agent Name: Select the ATOM agent from which the ATOM notifications are generated
on a given set of devices. All the notifications created on the device managed by the
ATOM agent will be published in the queue.

System Manager

To view the components, microservices and the applications managed by ATOM, navigate to
Administration > System Manager

Dashboard

View the graphical representation of the connection between the Applications, Components,
and the underlying microservices.

Navigate > Administration > System Manager > Dashboard

Display: < A A [JEUEEN

JOBS " SERVICE-COMPLIANCE DEVICE-COMPLIANCE CONFIGURATION-MGMT ADMINISTRATION ~ CLOSED-LOOP-AUTOMATION - TELEMETRY-COLLECTION ORCHESTRATION . KPI-METRICS USER-INTERFACE ~ API

\ \ _— = = .
N \ / — = - 7 %
Administration ATOM-SCHEDULER ~ATOM-CORE - ATOM-AGENT - ATOM-SYSMGR _ ATOM-QUERY-SERVICE « ATOM-INVENTORY-MGR - ATOM-WORKFLOW-ENGINE - ATOM-TELEMETRY-ENGINE - ATOM-FRONTEND

Tasks and Events ) N < - s ===
Tenants ! R g o = 3 -

L o = { — { J (] (] (]
—— @ ) A f\ . a A
Ereten i Dashbegrd RT-MGR INFRA-SFTP INFRA-GLOWROOT  INFRA-KAFKA INFRA-ELASTICSEARCH ~INFRA-TIME-SERIES-DB - INFRA-DISTRIBUTED-DB  INFRA-WEB-PROXY
Plugins & Extensions ATOM Components
User Management FQDN Agent Settings
Tags Management Y 'Y ® 'Y 'Y Y ®

o A ES EN A A A ES

Ul Customizations
Troubleshoot INFRA-ZOOKEEPER INFRA-CONTROL-CENTER INFRA-KAFKA-CONTROL INFRA-LOGSTASH DISTRIBUTED-APP-TRACING INFRA-KIBANA INFRA-GRAFANA
DSL
Deprecated

File Server @ <}>’
About
INFRA-SCHEMA-REPO IR R LEL
]

https://172.16.21.187:30443/nqui/atom/system-manager

[ )

MAINTENANCE UPGRADE
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ATOM Components

Navigate > Administration > System Manager > Atom components > Atom components

The components, of ATOM, along with their dependencies are displayed as follows:

ATOM Components

Name Dependencies
ATOM-Agent Device, infra-elasticsearch, infra-kafka, infra-sftp
ATOM-Query-Service Kubernetes, infra-distributed-db, infra-time-series-db
ATOM-Telemetry-engine ATOM-Frontend, infra-distributed-db, infra-elasticsearch, infrak
ATOM-Frontend infira-web-proxy

ATOM-Workfiow-engine ATOM-Agent, ATOM-Frontend, infra-distributed-db, infra-elastics.
ATOM-Sysmgr ATOM-Agent, ATOM-Frontend, ATOM-Inventory-mgr, ATON-Quer.
ATOM-nventory-mgr infia-distributed-db, infra-elasticsearch, infra-kafka

Administration ATOM-core, infra-lasticsearch, infra-kafka

I  infra-distributed-db,  infra-kef.

Tasks and Events

Tenants

System

System Manager Dashboard
Plugins & Extensions ATOM Components > ATOM Compgnents
User Management FQDN Agent Settings All Components

Tags Management Component relations
Ul Customizations Applications
Troubleshoot Component Functions
DSL Deployment
Deprecated

File Server

About

https;//172.16.21.187:30443/ngui/at =sys-mgr-sw-comp s-summa

All Components

Search Q

Navigate > Administration > System Manager > Atom components > All components

The components of the Kubernetes cluster that are not owned by Anuta are displayed as

follows:

Components

O nNeme 4 Description Component-owner
O AtomAgent Anta
O AToMFrontend Anuta
O  ATominventory-mgr Anuta
O  aTom-Queryservice Anuta
[0 ATOM-Scheduler Anuta
O  aromsysmgr Anta
(] __ATOM-Telemetry-engi. Anuta

Administration Anuta

Anuta
Tasks and Events

3rd-party
Tenants

Kubernetes
System

CNCF

System Manager Dashboard )
[ ATOM Components 'ATOM Gomponents
User Management FQDN Agent Settings Al Cgnponents

Tags Management Component relations
Ul Customizations Applications
Troubleshoot Component Functions
DSL Deployment

Deprecated

Used to rebalance partitions Apache Kafka
File Server
ELK
About
O  infralogstash ELK
infra-schema-repo Apache Kafka

https;//172.16.21.187:30443/ngui/atom/page?schemaPath=%2Fsys-managersysmgr%2Fcomponents

Component Relations

Prefix

Kapacitor

kafka

broker

Parent

infrakafka

infra-zookeeper

infra-zookeeper

Type
micro-serviee

devicenfra
orchestration nfra
analyticsinfra
streamprocessingnfra
inframonitoring
databasejnfra

infra searchengine

third partyjog-collectionjnfra
infra

bus,nfra

infra

visualizationinfra

infra

infrajog-collection

infra

28028 | Search a

Navigate > Administration > System Manager > Atom components > Component Relations
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All the dependencies between the components can be visualized as follows:

Comp-Relations.

1-500f52 Page1 0f2 > >l | Search a
O Fom 4 To Description Dependency Dependency-Condition Dependency-Nature
O ATOM-Agent infrakafka mandatory
O  atomAgent Device mandatory
O  atomagent infra-elasticsearch conditonallymandatory
O  atomAgent infra-sftp mandatory diect
O  atomFrontend infra-web-proxy mandatory
O  ATOMHnventory-mgr infra-kafka mandatory
[J  ATOMHnventory-mgr infra-elasticsearch conditionally-mandatory

Administration infra-distributed-db mandatory

infrati mandatory direct
Tasks and Events
infra-distributed- mandatory direct
Tenants
Kuberetes mandatory direct
System
- mandatary
System Manager > Dashboard
mandatory direct
Plugins & Extensions >  ATOM Components > ATOM Components
mandatory
User Management > FQDN Agent Settings All Components
= — conditionallymandatory logical
Tags Management
AToMcore conditionallymandatory logical
Ul Customizations
ATOM-Agent conditionallymandatory logical
Troubleshoot Component Functions
ATOM:Scheduler conditionallymandatory logical
DSL Deployment
ATOM-Inventory-mgr conditionallymandatory logical
Deprecated
ATOM-Telemetry-engine conditionallymandatory logical
File Server
ATOM-Query-Service conditionallymandatory logical
About
— mandatory
O  ATOMTelemetry-engi. mandatory
M AToMTeler mandatory direct
2.16.21.187:30443, atom/page?schemaPath=%2Fsys-managersysmgré2Fcomp-relations

Applications

Navigate > Administration > System Manager > Atom components > Applications

All the applications served by the underlying Components are displayed as follows:

Applications

11011 | Search Q

Name g Enabled

API

[

Administration
Closed-Loop-Automati
Configuration-Mgrnt
Device-Compliance
Jobs

KPLMetrics

Oooooooo

Administration

Tasks and Events

Tenants

QAA000000

System
System Manager Dashboard

Plugins & Extensions ATOM Components > ' ATOM Components
User Management FQDN Agent Settings All Components

Tags Management Component relations
Ul Customizations Applications
Troubleshoot Component Functions
DSL Deployment
Deprecated

File Server

About

httne /1177 1891 187-20442 Inr i atam Inanale shamaDath 9. JEeve_m an.

Component Functions

Navigate > Administration > System Manager > Atom components > Component Functions

The association of the components between the applications can be visualized as follows:
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Comp-Functions

Component 4

ATOM-Agent

oooooo

ATOM-core

Administration

Tasks and Events.
Tenants

System

System Manager
Plugins & Extensions
User Management
Tags Management
Ul Customizations.
Troubleshoot

DSL

Deprecated

File Server

About

Deployment Functions

Name

Configuration-Mgmt

ATOM-Inventory-mgr Inventory
ATOM-Telemetry-engi..  Assurance(CLA)
ATOM-Telemetry-engi..  Telemetry

Orchestration

Dashboard
ATOM Gomponents
FQDN Agent Settings

Description

> ATOM Gomponents
All Components
Component relations
Applications
Comppnent Functions

Deployment

50f5 | Search

Navigate > Administration > System Manager > Atom components > Deployment Functions

The following deployment summaries to be displayed

Deployment Summary

Neme
atom-core
atom-defaultagent
atom-frontend
atom-inventory-mgr
atom-isim
atom-pnp-server
atom-query-service

Administration

Tasks and Events
Tenants

System

System Manager
[
User Management
Tags Management
Ul Customizations
Troubleshoot

DSL

Deprecated

File Server

About

infra-tsdb-1-alertmanager

Replicas

Dashboard
ATOM Components
FQDN Agent Settings

> ATOM Components
All Components.
Component relations
Applications
Component Functions

Deplo{ﬂ\em

Search

infra-tsdb-monitoring-alertmanaaer
httns://172.16.21.187:30443/naui/atom/) —svs-mar-s ent

FQDN Agent Settings

Navigate > Administration > System Manager > FQDN Agent Settings

1.No need to restart any pod, it should discover any endpoints.

Command : kubectl edit cm -n kube-system coredns
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2.Content added as below:

anutacorp.com:53 {
errors
cache 30

forward . 172.16.100.5

Go to Administration/System Manager/FQDN Agent setting for pattern
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Q Administration

Tasks and Events
’= Tenants
System
System Manager Dashboard
Plugins & Extensions ATOM Components
User Management FQDN :Went Settings
Tags Management
Alarm Management
Ul Customizations
Troubleshoot

DSL
About

Click Add Symbol and Select Default-Domain-Agent and give proper Pattern & Priority

Create Fqdn-Config (X

Entities ° X

Fgdn-Config - Agent1 Name «

agent1

Default-Domain-Agent &

default_agent xo
Patterns

x | 4[*]+.anutacorp.com
Priority

1| S

After creating FQDN then go to Entities/Ip-Ranges as shown.

@ Fqdn-Configs X fqdn-configs Information A
> - ‘
Q ¢ 4 u T Selected Details Entities Ve |
@ Name Default-Domain-Agent Priority Patterns
Enter a keyword.. Q
I I 1 agent1 default_agent 1 A[*]+.anutacorp.com
Ip-Ranges
- &
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Provide valid IP Ranges and select agent

) Create Ip-Ranges X

® -mandatory information
O

Name e
I I ' agent1_lp_ranges
* IP Range
o e

192.168.16.0-192.168.16.10

@ Agent-Name

Name of the agent
D agent5_india [ X v
>

Go to Devices and click add symbol and Provide FQDN-Name to resolve FQDN
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&R Create Device E_

Idw
il
s Management-Mode
L M d - ATOM manag crchestrates such devices. Unbanaged Devices: h
@ MAMNAGED UNMAMAGED DU
Mame
D e umque name
# Fgdn-Mame
3 ind-car333.ind.anutacorp.com
Mgmt-lp-Address =
Must be a walid IF Addr 16.1.:24
Credential Set »
W o
Device Type
UNKMOWHN s -
Descripticn

Driver-Mame
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&R Create Device B_

id=

Managemeni-Mode

.. Managed device: ATOM manages and orchectrabes such devices. Unbanaged Devices:
MANAGED UNMANAGED DUMBY

Mame

)
ped

Fgdn-Name

3 ind-car333.ind.anutacorp.com

Mgmt-lp-Address =

Must be & valid IP Addres Fr Al

. Ex:17216.1.24.

u

172.16.3.33

Credential Set =

Device Type
UNMKMOWHN o

Description

device type description

Driver-Mame

get-ip-from-fqdn x

05/02/20:20, 143716 gl 05/02/2020, 143717 Time Tzken - 0 seconds
TASKID @ DEZ3xbcoBxSR-PsFEGUCLIPDA

2B2B/BZ/Bs B9:07:16 aM: RPC Operation get-ip-from-fgdn started.
IEZB/B2/B5 B9:BT:15 AM: Request %
{"input”: {"hostname™: "ind-csr333.ind.anutacorp.com”}}

2B2B/BZ/B5 @9:07:16 aM: Matching FQDN config name: agentd

2BzB/BZ /8% B5:87:15 AM: Domain-Agent for config name: agentd_india

IBZBSBZ/ B B5:B7:15 AM: Empty IP-Ranges for config name: agentd

zBZE/BZ/B% B5:07:17 AM: RPC Operation Output :{"output”:{"ipaddress":"17Z.16.3.33","resolved-
Qys=rta_india ")y

2BZB/B2/8% 85:87:17 aM: RPC Operation get-ip-from-fgdn Completed.

Task completed
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Plugins and Extensions

By utilizing the normalized device abstractions maintained in data stores written in YANG
maintained in ATOM, the customers can write their own device models and applications to
meet their specific operational needs, thereby utilizing the extensibility of ATOM.

The device and service packages are loaded as bundles or plugins to the ATOM container
thereby making them modular. The packages can be installed, updated, or deleted without
disrupting the operation of the device.

In addition to modeling the devices and service, you can model the features or network
functions required to build a network service. These features thus modeled appear as icons in
the feature palette of Service Designer pane of ATOM. The newly added features along with the
included associated services can now be used to design the service in ATOM.

Packages

ATOM is packaged with many predefined device packages to enable you to work with many
vendor devices. ATOM also provides capability to update the existing device packages and
ability to add new device packages

A Device Model contains inventory models, communication model, and notification model that
are packaged and uploaded to ATOM. A device package consists of models, a vendor -specific
configuration data for all the different devices.

For details about what constitutes a device package and how to write it, refer to examples cited
in the guide, “ATOM Platform Guide”.

A Service package contains the services models, service yang files and metadata information.
For more information about Service Modeling, refer to examples cited in the guide, “ATOM
Platform Guide”.

Package Explorer

Users can manage and get the information of the packages that are currently available in the
system. The packages that were uploaded and loaded can be viewed in minio Ul.
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Navigate to Administration > Plugins & Extensions > Package Explorer

search by package name

c + @

1-250f67

Page
v & anta

»m

€@D packagexm!

model

-
-
-
> &

Administration

Anuta Networks

Anuta Networks Seed Datz

BiglP

Cisco Systems.

Tasks and Events
Tenants

System

System Manager
Plugins & Extensions
User Management
Tags Management
Ul Customizations
Troubleshoot

DSL

Scripts

Deprecated

File Server

SNMP

Anuta

<oxml versis

> package.xml

yes'2>

1.0" encoding="UTF-8" standalor

20 <package>

1ofz > >l

a 11+

Packages
PR
SNMP

Device Support

Network Functions

<name>Anuta Networks</name>
<module-name>Anuta< /module-name>

<description>Package auto-created on upgrade</description>
<version>8.8.0.6</version>
<nex-version>[8.8.0.0)</ncx-version>
<deploy-on-server>true</deploy-on-server>
<deploy-on-agent>false</deploy-on-agent>
<auto-start>false</auto-start>

<EypesDEVICES/type>

<order>a</order>
<deploy-on-telemetry>false</deploy-on-telemetry>
<deploy-on-workflow>false</deploy-on-workflows
<isin-data>false</isin-data>
<Force-schema-diff>False</force-schema-diffs

</package>

Navigate > Administration > Plugins & Extensions > Package > SNMP > SNMP Mibs >Upload

S
&

C o 1-50 0f 65 Page10f2 » 3| | Enterakeyword Q
O Neme Entity Name — it |
[  ANUTAATOMINDEPENDENTOIDSMIB Misc_me e
O wowrme interfaces PACKAGE e
O srowrxenavme interfaces PACKAGE e
[ AToMsnMPip-ADDRESSMIB PacKAGE e
[ ATOMSERALNUMEERMIE
O romosversionws PacKacE e
PACKAGE true
Administration PACKAGE true
Tasks and Events pacrace frue
S breors v PACKAGE true
System PACKAGE true
System Manager FILE falee
Plugins & Extensions Packages FILE felse
User Management Package Explorer FILE felse
Tags Management SNMP > SNMPMIBs FILE felse
Ul Customizations Device Support SNMP OID Map FILE false
Troubleshoot Network Functions TRAP OID Map FILE felse
DSL SNMP Metric Metadata FILE falee
Scripts FILE false
P— FILE false
FILE false

File Server
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Yy Ve
c 270f27 | Enter akeyword Q
0
O Neme Entity Name Source Active
[l O swrasmomoepenenTos e wisc e e
. O atomiFmie interfaces PACKAGE true
2 [0  ATOMHFX-ENTRY-MIE interfaces PACKAGE true
]  ATOM-SNMPAP-ADDRESSMIE PACKAGE true
[0  ATOM-SERIALNUMBERMIE PACKAGE true
() [0 ATOM-OSVERSION-MIB PACKAGE true
O  AtoMeNTTV-MIB PACKAGE true
O  ATOM-Pvs-ADDRESSMIB PACKAGE true
] ATOM-SNMP-COP-NEIGHEORS MIB PACKAGE true
[0 ATOM-SNMP-LLDP-NEIGHBORS MIB PACKAGE true
]  ATOM-SNMP-AXS-LLDP-NEIGHBORS-MIE PACKAGE true
O snvpvmie FILE true
O snMPv2-CONF FILE true
O swwmpvTc FILE true
O swvPvswi FILE true
O scPams FILE true
[0 srDGEMEB FILE false
O ciscosm FILE true
O cisco-process-mib FILE true
O ianaentTvME FILE true
O rve FILE true
O  aNaifTypemiB FILE true
[0 SNMP-FRAMEWORKMIE FILE true
O Henomte FILE true

Navigate > Administration > Plugins & Extensions > Package > SNMP > SNMP OID Maps > Add

@ SNMP-OID-Maps
c B8 1-500f473 Page10f10 > > | Search a
o O Neme 4 Platform Parent oid PostProcessor-Prop Fetch-Type Is Metric-Candidate Is-Accessible
[0  aristacososversion ALLIALLIALL |Arista EOS|Arista Networks 136121110 \etworks/aristat 0stP1 gre GET
[0  axslidpRemEntry ALLIALLIALLJALLIALL axslidpRemTable 1.3.6.1.41.21839.2.2.1.100.4.1.1 NONE
[0  axslidpRemPortDesc ALLIALLIALLJALLIALL axslidpRemEntry 1.3.6.1.41.21839.2.2.1.100.4.1.1.8 WALK
[0  axslidpRemRemotePort ALLIALLIALLJALLIALL axslidpRemEntry 1.3.6.1.41.21839.2.2.1.100.4.1.1.7 WALK
@ [0  axslidpRemSysName ALLIALLIALLJALLIALL axslidpRemEntry 1.3.6.1.41.21839.2.2.1.100.4.1.1.9 WALK
D [0  axslidpRemTable ALLIALLIALLJALLIALL 1.3.6.1.4.1.21839.2.2.1.100.4.1 NONE
[0  bgpapathAttrAsPathSegment  ALLIALLIALLIALLIALL bgpaPathAttrEntry 1.361.21.156.1.5 WALK
* [0  bgpapathAttrAggregatorAS ALLIALLIALLJALLIALL bgpaPathAttrEntry 1.36.1.21.156.1.10 WALK
[0 bgp4pathattraggregatorAddr  ALLIALLIALLIALLIALL bgp4PathAttrEntry 1.36.1.21.156.1.11 WALK
[0  bgpapathattratomicAggreg. ALLIALLIALLJALLIALL bgpaPathAttrEntry 1.361.21.156.1.9 WALK
[0  bgpspathatirBest ALLIALLIALLIALLIALL bgp4PathAtiiEntry 126121156113 WALK
[0 bgpapathattrcalcLocalPref ALLIALLIALLIALLIALL bgpaPathattrEntry 136121156112 WALK
[0  bgparathattrentry ALUALLIALLIALLIALL bgpapathAtrTable 1361211561 NONE ®
[0  bgpapathattripAddrPrefix ALLIALLIALLJALLIALL bgpaPathAttrEntry 1.361.21.156.1.3 WALK
[0  bgpapathattripAddrPrefixien  ALLIALLIALLIALLIALL bgpapathAtirEntry 12612115612 WALK
[0  bgpapathattrLocalPref ALLIALLIALLIALLIALL bgpaPathattrEntry 13612115618 WALK
[0  bgpsapathattrMultiexitise ALLIALLIALUALLIALL bgp4PathAthEntry 13612115617 WALK
[0  bgpapathattiNextHop ALLIALLIALLJALLIALL bgpaPathAttrEntry 1.361.21.156.1.6 WALK
[0  bgpsPathatirorigin ALUALLIALLIALLIALL bgpdPathAtirEntry 13612115614 WALK
[0  bgpapathattrPeer ALLIALLIALLIALLIALL bgpaPathattrEntry 13612115611 WALK
O  bgpapathattrTable ALLIALLALUALLALL 136121156 NONE ®
[0  bgpapathattrunknown ALLIALLIALLIALLIALL bgpaPathattrEntry 136121156114 WALK
O  bgpidentifier ALLIALLIALLIALLIALL 1.36121.1540 GET
O bgpLocalas ALLIALLIALLIALLIALL 1361211520 GET
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(o

Create Oid-Snmp-Map | [

Entities

Oid-Snmp-Map - BgpaPathAttrBest

Metric-Instance Schemardevices

c
[m]
[m]
[m]
[m]
[m]
[m]
[m]
[m]
[m]
[m]
[m]
[m]
[m]
[m]
[m]
[m]
[m]
a
[m]
[m]
[m]
[m]
[m]
[m]
[m]
n

8
Deviee D 4
172161139
1721618176
1721618181
172163170
17216330
17216331
17216332
17216333
17216334
17216336
172.16.3.36_SNMPV3
17216338
17216339
17216340
17216341
17216344
17216346
17216347
17216348
17216349
17216351
17216353
17216358
17216371

17216372

Platform e
Platform string for aspecifc oid

ALLALUALLALLALL

Name o
Name of the oid

bgpapathatirBest

Parent

bgpaPathattrBest x v

136121156113

Post-Processor-Prop

y e name o invoke

Fetch-Type
fechaype

Sl < GEE None
Key-Oid
Mapping related key-cid of a
x|1361211561213612115611,13612115613 | +
Metric-Tag-Oid
Oid th e

Snmo-Pron

400740 | Search
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172.16.18.181

172163170
440f44

Device Support

Device Support view allows users to create a new Vendor, Device Type, Device Family, OS Type,
Device Capabilities, Terminal Handling Properties etc.,

Managing Tenants

The administrator can make use of ATOM’s multi tenancy capability to share IT resources
cost-efficiently and securely by creating Tenants. The Tenants share common infrastructure, yet
utilize a defined set of highly secure services, with complete isolation from other tenants. The
resources managed by ATOM can be securely shared among multiple applications and tenants
(businesses, organizations, etc.) that use the resources of the datacenter.

Overview of Multi Tenancy

Mulltitenancy feature is enabled in the system as a result of which every object managed by
ATOM can be owned by an admin and shared with multiple users (tenants) simultaneously.

Aided by rules and roles that can be created in ATOM, the administrator can either assign or
restrict access to the resources (resource pools, sites, locations, IPAM, devices) managed by
ATOM.

All the created resources in ATOM are allocated to the system, the default admin user who is
the owner of the resources. These resources managed by ATOM are available to all the Tenants
in the system. The administrator can now share the system resources with the required tenant
or tenants. From then on, all the resources that are created in each Tenant (parent) are available
to only the users (child nodes) of a particular parent.
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Root Tenant

‘System’ is the root tenant. Every other tenant is a child or in the child hierarchy of this root.
There may be few objects which are kept ‘private’ to the system, meaning, those are not
‘shared’ to child tenants.

Top Level Tenants

Top Level Tenants (referred ‘tenants’ for simplicity) are the immediate children of system nodes.
For ex;
System

Company-1

Company-2

Company-3

In the above example, company-1, 2, 3 are top level tenants.

Simple Multi Tenancy

ATOM supports Sub tenancy where a tenant can subdivide their resources into a sub hierarchy.
But, when there are no sub tenants in the deployment, it is referred to as ‘Simple Multi
Tenancy’.
For ex;
System

Company-1

Company-2

Company-3

In On-Prem deployment, it is up to the customer how they treat the root tenant.
If they don't create any child tenants to the system, then, system and customer are
synonymous.

Tenants  Tenant Heirarch;
® ey
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Hierarchical Multi Tenancy

Sub Tenant

A sub tenant is a child [directly or indirectly] of a Top Level [Not root] tenant.

System
Company-1
North
South
Campus-1
Company-2
Company-3

In the above example,

‘System’ is the root tenant

Company-1, Company-2, Company-3 are top level tenants
Company-1.north, Company-1.south are sub tenants of Company-1.
Company-1.south.campus-1 is a sub tenant of acme.south

Tenants  Tenant Heirarch:
& y

0 c 4+ B o & » 60f6  Search Q
‘ O Neme 4 Description Sub-Tenancy-Enabled Vnme-Dn Naming-Counter Dry-Run System-Defined o

th O companyt o ®
Wl (] company-iNorth ) ®

O mpany-1.North.campus-1 ) ®
O © ®
Bl O companya b ® ®
@ O  system system tenant ® ®

System users

System is the root tenant. System users are those, whose User.owner = ‘system’.
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Invite User(s) x

s-mandatory information

External User »

Add Userse +

Usernamese Email Addresse

user user@anutanetworks.com

Assign Roles to User

Select one or more Roles to assign to this user(s)

User Roles l}: 4

Assign Groups to User

Select one or more User Groups that this user(s) belong(s) to

User Groups v

Enable Developer Mode

Enable Developer Mode for this user

[]

Can-Read-Data-Of Can-Change-Data-Of
Select the sub-set of tenants that are available to this u.. Select the sub-set of tenants this user(s) is authorized t...
x | system hd x | system bl
Ownere Shared-With
system X - % system -

Tenant Users

Tenant users are customer users owned by individual tenants. User.owner != ‘system’
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Invite User(s) x

s-mandatory information

External User »
Add Userse +
Usernames Email Addresss
=
companyadmin companyadmin@anutanetworks.co

User Groups -

Enable Developer Mode

Enable Developer Mode for this user

[]

Can-Read-Data-Of Can-Change-Data-Of
Select the sub-set of tenants that are available to this u.. Select the sub-set of tenants this user(s) is authorized t...
x | company-1 - ® | compamny-1 -

Shared-With

company-1 x  company-1 -

Send Invites

Owner

Owner is a tenant. And, we use ‘tenant-id’ to identify a tenant.
Tenant-id uses fully qualified names separated with dots, such as, Company-1.south.campus-1.

223



ATOM User Guide

Multi Tenancy is all about keeping data private to a tenant. This means, data identified by a key
can have one copy for each tenant. Suppose, 2 tenants want to bring in the same device-1?
That counts to 2 instances with the same key. Clearly object id by itself is not sufficient. Hence,
objects are identified by their id and ‘owner’. Object key is formed by object id and owner.

Shared-with

A resource can be shared with multiple tenants or kept private to the owner.

Sharing of resources applies only when a resource owned by one tenant is to be used by
another tenant.

For example, a device owned by tenant-1 is used by a ‘network service’ created by a tenant-2.
Sharing across tenants is not supported. but, within a tenant sub hierarchy is supported.

For example, no data is ever shared among the 3 companies of the following hierarchy
System

Company-1

Company-2

Company-3

But there is, down the hierarchy sharing allowed. Such as, ‘system’ resources are shared to all
the three [and sub tenants, if exist].

If Resource is shared-with system then it is private to system
If Resource is shared-with system.* then it is shared with all the sub tenants.

Concept Of Visibility And Usability

Visibility is the same as ‘Readability’; Whether a resource is visible to a user.

Usability of a resource is with respect to another resource and it is about whether a resource-1
can be referred (in a relation for example) by another resource.

For example,

device-1.credential-set = ‘cred-1’

# resource Owner
1 device-1 Univ.Engg
2 cred-1 Univ.Phy

Device-1 wants to use ‘cred-1" in a ‘device.credential-set’ relation.
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Currently, to make cred-1 available (visible, usable) to resources of Univ.Engg, you have to share

it with that tenant.

# resource Owner shared-with

1 device-1 Univ.Engg

2 cred-1 Univ.Phy Univ.Engg

Shared With Variations
System
Company-1
Campus-1
Department-1
Department-2
Campus-2

Owner Resource Shared With Details

Company-1 R1 Company-1 R1 becomes a private

object

Company-1 R1 Company-1, A Tenant Resource
system shared with system

[there are a few
scenarios where this is
useful]

Campus-2 R1 companyl.Camp | Sharing with other
us-1, tenants [in the sub
companyl.Camp | hierarchy]
us-2

Campus-1 R1 Campus-1.* Using wildcards in

sharing-with. R1 will be
shared with all sub
tenants. Since sub
tenants can be added or
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removed during the life
cycle of a deployment,
sharing is spread to all
the sub tenants
available at the time of
invocation.

User.Owner

User object has an ‘owner’ property, just like any other resource.

But, there is a special meaning to ‘user.owner’.

Users need to be authenticated in the system.

Authentication is done with an ‘Identity Provider’, such as an LDAP.
Identity Providers are associated with tenants.

So, a user is authenticated against the provider traced via User.owner

User.can-read-data-of And User.can-change-data-of

A user could be created at a higher level (user.owner) but to limit the user to a subset of tenants
there are two properties.

‘can-read-data-of’ controls which tenant data a user can read.

‘can-change-data-of’ controls which tenant data a user can change.

When a top level tenant does not have sub-tenants, user.can-read-data-of will be fixed to the
tenant. User.can-change-data-of can be used to disable writes [by omitting a value]. If decided
to allow writes , the value will be fixed to the tenant.
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Invite User(s)

e-mandatory information

External User

Add Userse

Usernamese

user

Assign Roles to User

Assign Groups to User

User Groups

Enable Developer Mode

Enable Developer Mode for this

[]

Can-Read-Data-Of

Select the sub-set of tenants that are available to this

x | system

Email Addresse

user@anutanetworks.com

Or More Roles 10 as8s I

Can-Change-Data-Of
system

Shared-With

X - x | system

Select the sub-set of tenants this user(s) is

Send Invites

NOTE: Except Monitoring and Alerts all other components are MT Enabled.
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Creating Tenants
Before instantiating a service, there should be at least a single Tenant created in ATOM.
1. Navigate to Administration > Tenants
2. Select the Tenants folder > click Add
3. Inthe Create Tenant screen, enter the following:
e Name: Enter an alphanumeric string of not more than 32 characters
e Description: Enter a description for the Tenant
e Tenantld: Enter a unique identifier for the Tenant

e Dry Run: This option does not allow ATOM to send the configurations to the
devices while creating services. By default, this option is unselected.

o Select the checkbox to allow ATOM to push the commands on to the
devices.

User Management

The control of users and groups is a core element of ATOM system administration.Users can also
be grouped (based on the function) to have read permissions, write permissions, execute
permissions or any combination of read/write/execute permissions for files owned by that
group.

Managing Users in ATOM not only covers creating users but also configuring or assigning the
privileges for each user or similar group of users to perform tasks in ATOM. Apart from creating
the access or deny permissions in ATOM locally, you can import existing LDAP or AD users into
ATOM and extend the necessary permissions to them too.

User management and Authentication works in ATOM as shown in the diagram below. The user
information is saved in KeyCloak. OAuth Proxy acts as a gatekeeper checking all the incoming
requests and ensuring the requests are coming from an authenticated client. If the proxy sees
an non-authentic call, it redirects the request to a login screen served by the identity provider,
which is KeyCloak.
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KeyCloak
Client - ; hr OAuth2
Browser Proxy

User management in ATOM includes the following:

e "Roles"
e "Creating Authentication Mode Priority"
e "Managing Users"
e "Configuring Access Control"
e "Managing OpenLDAP Users"
e "Managing Active Directory Users"
e "Managing TACACS Users"
Roles

ATOM
Services

A set of system-defined permissions are grouped into roles and are available in ATOM by

default. These roles can be assigned to a user during the creation of users in ATOM.

e ROLE_SYSTEM_ADMIN: Administrator of the root tenant ('system'). Every other tenant
is either a direct child of the system or a sub tenant (descendent) of a top level tenant.

System admin is given permission to onboard tenants and manage 'system' tenant

resources.
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e ROLE_TENANT_ADMIN: Is the equivalent of ROLE_SYSTEM_ADMIN (gets blanket
permissions on all resources) but limited to resources of the specific tenant
(‘user.owner)’ .

e ROLE_USER_ADMIN: Gives all access to user mgmt objects (users, Groups, rbac rules
[rule list and everything down] etc), but limited to user.owner.
e ROLE_WORKFLOW_ADMIN: Allows a user all permissions on all workflow resources.

This avoids having to create individual workflow permissions.
Note that other permissions (rpc, data node etc) are still needed to be given explicitly,
because this role only covers ‘Workflow resources’ only.

Creating Authentication Mode Priority

Starting from the 5.8.7 release, the admin can set the priority of the authentication modes in
ATOM. By setting the priority of the authentication modes, the admin can enable the login
failover to another authentication mode, if the first authentication mode (as arranged in the
order of priority) fails. ATOM fails to the local authentication mode, if all the authentication
modes as defined in the priority list fail.

To create the authentication mode priority in ATOM, do the following:

1. Navigate to Administration > Users & Tenants> Authentication Mode Priority in the left
pane.

2. Inthe right pane click Add Auth Priority and in the Create Auth Priority screen, click
Entities > auth-modes

3. Enter values in the fields as described below:

i Priority: Set the priority for the authentication mode. (1 is the highest priority)

ii.  Authentication Mode - Select the authentication mode from the available
authentication modes (TACACS, OpenlLDAP, Active Directory and Local)

re | 172.16.23.197.

Users  Roles  NACM

Administration

Tasks and Events

Users & Tenants Users & Roles

License Tenants

System Authentication Mode Priority
System Manager Proxy Configuration For RBAC
Plugins & Extensions RBAC Default Permissions
Tags Management Open LDAP

Ul Customizations Keycloak

Troubleshoot Active Directory
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* Create Auth-Priority | [, « °
© Entities +
i Auth-Priority - Authentication | Auth Modes

authentication

¢

Owner o
%) system X v
£ Shared With
a x| system -

~
|

After setting the priority for each of the authentication modes, you can view the list as shown
below:

Auth-Priorities

®* X Auth-Priorities Information 2
M Cc - 78 B ¥ seeced Details  Entities s
&

B tNeme 4 Owner Shared With Created-On Created-By Last-h
||| Enter a keyword Q

authentication system system 2021-03-12 09:40:53.022 2021-
%) O  tocalmode system system.* 2021-02-26 03:30:40.071 2021-  Auth-Modes

O  erimary system system.* 2021-02-26 03:30:40.07 2021+

Unprovisioned Configuration

ATOM | Authentication Mode Pric X + =

C A Notsecure | 172.16.23.197 % @ incognito

Auth-Priorities
®* X Auth-Priorities Information 2
C 7 ® B A ¥ sdced Details  Entities P
0
B neme 4 Owner Shared With Created-On Created-By Last
ih Enter a keyword Q
authentication system system 2021-03-12 09:40:53.022 2021-
0 O local.mode system system.* 2021-02-26 03:30:40.071 2021- Auth-{jodes
O  erimary system system.* 2021-02-26 03:30:40.07 2021-

Unprovisioned Configuration

-~
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Auth-Modes
(1]

cC + B o A » Search Q
0

O  riority 4 Authentication-Mode Owner Shared With Created-On Created-By Last-Modified-On Last-Modi
ih

R Create Auth-Modes (X « °
A$ @ -mandatory information
Priority
ih v
1
"

Authentication-Mode

9 LOCAL OPENLDAP ACTIVE_DIRECTORY TACACS

Owner o
* system X v
5. Shared With
x| system -

R Create Auth-Modes ] x °
Aﬁ @ -mandatory information
Priority e
ih i
2
)

Authentication-Mode

9 LOCAL OPENLDAP TACACS
Owner »
e system X v
N Shared With
x system -

Auth-Modes

(]

cC + B © & » 20f2  Search Q
0

O Priority PN Authentication-Mode Owner Shared With Created-On Created-By Last-Modified-On Last-Modi
18

D 1 OPENLDAP system system 2021-03-12 09:46:39.995 2021-03-12 09:46:39.995

.

-':- D 2 ACTIVE_DIRECTORY system system 2021-03-12 09:47:21.283 2021-03-12 09:47:21.283
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The authentication mode priority thus set can be assigned to a user at the time of creation of
the user in ATOM

Managing Users

An Administrator can add local users to ATOM and configure their email accounts to receive
notifications from ATOM. Apart from local users, ATOM lets its customers integrate their central
authentication servers to streamline the user login process and automate administrative tasks
such as user creation and role assignment. User data is synchronized from customer
authentication servers into ATOM.

Adding a New User
To add Users in ATOM, do the following:

1. Navigate to Administration > Users & Tenants > Users & Roles and click Add.

2. Inthe User Invitation screen, enter the values in the following fields:
a. External User: Enable this button to create AD, LDAP, or TACACS users in ATOM.
When this button is not enabled, a local user is created in ATOM.

Note: A local user will be required to reset his account password on first login
attempt. An external user can directly login to ATOM using the link in their
invitation email.

b. Add User: The administrator can invite one or more users to ATOM at once. To
add more than one user, click on the + button.

Invite User(s)

‘e-mandatory informatio
External User

Enable Developer Mode
5 eloper Mode for this user

Can-Read-Data-Of
Select the subset of tenants that an

‘Shared-With

Select avalue
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i.  Username: Enter an alphanumeric string of not more than 36 characters.

Note: While creating AD, LDAP, or TACACS users in ATOM, the name
entered in the Username field should be the same as that created in
the respective authentication server.

ii.  Email Address: Enter a valid email ID. Invitation emails to join ATOM
Cloud will be sent to this address.

c. Assign Roles to User: User can be assigned relevant Role(s) from the list of
system-defined Roles. Each Role is a set of system-defined permissions given to
the user.

d. Assign Groups to User: User can be put into pre-defined Group(s) to apply the
access control privileges on them as a whole.

e. Enable Developer Mode: In developer mode users have access to many tools to

work with Atom platforms.

Can-Read-Data-Of: Select the tenants, whose data this user can read.

Can-Change-Data-Of: Select the tenants, whose data this user can change.

Owner: Select the owner of this user.

Shared-With: Select the tenants with whom this user should be shared.

> @ =

Editing an Existing User

User details can be edited by selecting an user. When a user is edited, the user is taken to the
same form seen for adding a user. However, fields such as Username, Email Address and
External User are non-editable as these form the fundamental identifiers for the user.

Edit User(s)

‘o mandstory informatior
Extemnal User

Can-Change-Data-Of

x| system

Shared-With

x| system
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Resend User Invite

If the invitation to ATOM Cloud needs to be resent to the user’s email address, the
administrator can select the user and click on the resend invite icon.
Block/Unblock User

At any instance, the administrator can Enable or Disable a user account by this option. When
blocked, the user will not be allowed to login to ATOM.

Assigning Role to the User

From the drop-down menu, select the role that should be assigned to the user. These roles are
defined earlier as in the section, “Creating Roles”.

Creating SNMPv3 users

SNMPv3 users are required when the users or third party applications require additional
authentication and access control provided by SNMPv3.

1. Navigate to Administration > Users & Tenants > Add User
2. Inthe Create user screen, click user >entities> snmpv3 in the right pane.

3. Inthe right pane, enter values in the following fields:

ATOM | Users & Roles x  +

€ > C A Notsecre | 1721623.197 % @ mncogrito

Users  Roles  NACM
® X user information 2
cC 7/ § > Q Selected (D ) B
s Details Entities OtherToolBarltems s .
B el 4 User Name First Name Last Name
ih
O  abc@gmail.com abc@gmail.com abe@gmail.com Enter a keyword Q
%) admin@atom.local admin
(] Dls-Config
o O admin@atom.local admin
gshareef@anutanetworks.com com com Event-Subscription
Ell (] «prenav@anutanetworks.com m com f—
& [  krajashekar@anutanetworks.com D com m
[0  «subbareddy@anutanetworks.com com ks.com U = G e
> [0  keurendra@anutanetworks.com ks.com ks.com Workflow-User-Level-Authorizations-Policy
O mramya@anutanetworks.com m H D com
O edivya@anutanetworks.com pdivya@anutanetworks.com pdivya@anutanetworks.com
o - m m .com
O  srikanthg@anutanetworks.com etworks.com T com
O tswarupa@anutanetworks.com etworks.com p com
O yharike@anutanetworks.com m har ks.com
?
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R Create Snmpv3 | [ X °

Auth-Protocol
No-AuTH VoS

Auth-Password

Priv-Protocol

3 AES256 X v

> Priv-Password

oo ®

Owner o

system X v

Shared With

x| system -

a. Authentication Protocol: Enter the mode of authentication when SNMPv3 is
enabled.

b. Privacy Protocol: Enter the requisite privacy protocol depending on the selected
authentication protocol.

Subscribing to Events

Email notifications can be configured to be sent to the created user when a specific event or
events occur in ATOM.

1. Navigate to Administration > Users & Tenants > Add User

2. Inthe Create user screen, click user >entities> event subscription in the right pane.
3. Fill the values in the fields described below:
4

Click Add to subscribe to a specific event or click Add all to add all the events available in
ATOM.

An email is triggered and sent to the user when any of the events occur in ATOM.

You can configure the mail to be sent immediately after the occurence of the event or
schedule the mail notifications to be sent at periodic intervals as illustrated in the
screenshot below:

236



ATOM User Guide

®R Create Event-Subscription | [%

O00OO0oO0OO0OsEO0OO0O00OO

Naas-Event-Spec

Selected

1-500£77

NaasEventSpec v
ACTIVE_DIRECTORY_CONNECTION_FAILURE
AGENT_DISCONNECTED
AGENT_HEARTBEAT_LOSS
AGENT_OUT_OF_SYNC
AGENT_QUEUES_BUSY
AGENT_QUEUES_FULL
ALL_DEVICES_DISABLE_SNMPTRAPS
ALL_DEVICES_DISABLE_SYSLOG
ALL_DEVICES_ENABLE SNMPTRAPS
ALL_DEVICES_ENABLE SYSLOG
AMQP_NOTIFICATION

Page10f2 > I search

Deseription

ACTIVE_DIRECTORY_CONNECTION_FAILURE

AGENT_DISCONNECTED
AGENT_HEARTBEAT_LOSS
AGENT_OUT_OF_SYNC
AGENT_QUEUES_BUSY
AGENT_QUEUES_FULL
ALL_DEVICES_DISABLE_SNMPTRAPS
ALL_DEVICES_DISABLE_SYSLOG
ALL_DEVICES_ENABLE_SNMPTRAPS
ALL_DEVICES_ENABLE_SYSLOG
AMQP_NOTIFICATION

stem

system
system
system
system
system
system
system
system
system

system

Immediate-Email

ScheduleEmail
HOURLY DALY WEEKLY

Workflow-User-Level-Authorization

If it is decided to have user level permissions what should be the default permissions? That
guestion is answered by the global configuration at
/controller:nacm/workflow-policy-for-auto-creation-of-authorization

If it is needed to customize those permissions for a specific user? That question is answered by
this model

Using this model you can use

1.enable the user level permissions

2.choose to use the global default or customize
Here three options are there

DISABLE:: Is the default selection.Using this option you can explicitly disable the auto creation
of permission for this user.

ENABLE:Enables global defaults for this user.
READ-ONLY-PERMISSION:Enables the read only permissions out of the global defaults

OVERRIDE-GLOBAL-CONFIG:Enables user level permission creation for this user,and, for those
permissions you're going to specify here, explicitly.

1. Navigate to Administration > Users & Tenants > Add User

2. Inthe Create user screen, click user >entities>
workflow-user-level-permission-authorization in the right pane.

3. By default workflow-user-level- authorization is disabled it.
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il
©

(@) atom  £& > Users&Tenants > Users&Roles F

X
i

Create Workflow-User-Level-Authorizations-Policy (KN

Entities
Workflow-User-Level-Authorizations: User-Level-Permission

ENABLE READ_ONLY_PERMISSIONS OVERRIDE_GLOBAL_CONFIG
Owner o
system

Shared With

x| system

Configuring Access Control

By implementing NACM developed by NETCONF, ATOM enables administrators to allow or deny
access to protocol operations and data to a set of users. Access Control in ATOM is achieved by
a combination of “Rule-list” and “User Groups”. Rules are grouped into Rule-list and users are
assigned to User Groups to control access to resources managed by ATOM.

To set the global access control settings in ATOM, do the following:
1. Navigate to Administration > Users & Tenants > Access Control
2. Click Edit to modify the global settings for access control.

As an administrator, you can set the default access control settings which are applicable
to all entities in ATOM

e Enable NACM: Select this option to set a group of read, write, and execute
options that should be applicable by default to all the entities in ATOM.

o Read Default: The default value is “permit” for all the
operations/objects(Controls whether read access is granted if no appropriate
rule is found particular read request)

e Write Default: The default value is “deny” for all the operations/objects(Controls
whether create,update or delete access is granted if no appropriate rule is found
particular write request)

e Exec Default: The default value is “permit” for all the
operations/objects(Controls whether exec access is granted if no appropriate rule
is found particular protocol operation request)
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Attributes

Search for a config

resourcePath read-default enable-nacm
> groups
/controller:nacm permit true
» ruleist
exec-default write-default enable-external-groups
workflow-policy-for-auto-creation-of- . 4
authorizations eny eny frue

* Administration

N Tasks and Events
" Tenants
System

System Manager

Plugins & Extensions

User Management Roles

Tags Management Authentication Mode

Ul Customizations Erory)

Troubleshoot leas

pSL Acce‘h Control

Proxy Configuration For
RBAC

Scripts

Deprecated
https://172.16.19.161::

iy L 2

Q Search for a config Q C ¥ Attributes
[\

resourcePath read-default enable-nacm
> groups
/controller:nacm permit true
il e
exec-defaut write-default enable-external-groups
workflow-policy-for-auto-creation-of- p p
authorizations eny eny frue
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Y Editnack % @
4\6
Enable-Nacm
Enables or disables all NETCONF access conirol enforcement. If true!, then enforcerme.
il
*
]

e Read-Default

%
D Write-Default
£

PN ExecDefault

Fermit m

Note: These default settings that are entered in the above screen can be overridden by the
values set by a specific rule created for an entity.

Adding User Groups
You can organize users to groups and apply the access control privileges on them as a whole.
To create a User Group:

1. Navigate to Administration >Users & Tenants >Users & Roles> click NACM

2. Inthe Details pane, on the right, click Groups > Add Group

Search for a config Q C ¥ CreateGrowp | [ x
0
> group:
> ruledist
ih Name »
> workflow-policy-for-auto-creation-of-
o IS
%) UserNam;
* 14014 sear h Q
O oo, Descrpt o
o [ J— fr— psem
5 O edmin admin system
O comingstomiocs! dmin@stom.ocal system
O system
O system
(=] system
O system
O system
O system
[m} com system
O system
Owner o
ystem
Shared With
x| system
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e Name: Enter the name for the User Group

e Select a user to this group.

Creating Rule lists

Rule lists are an aggregated list of rules created in ATOM.
1. Navigate to Administration > Users & Tenants >Users & Roles> click NACM
In the Entities pane, on the right, click Rule-list > Add(+)

2
3. Name: Enter the text that will be used as a name for the rule list.
4

Select a group (user group) to which the created rules in the Rule list should be assigned.

yyyyyyy

Creating Rule V2

Rules are the conditions that identify individual objects in the system. Rules also capture
whether a user of a network object should be “granted” or “denied” RPC permission.

RPC : Choose a remote procedure call (RPC) on which the access control needs to be applied.
1. Click the created Rule-list > Entities > Rule V2 > Add(+)
2. Inthe Create rule screen, enter values in the fields explained below:

Create a Rule v2, “rulev2” to be given the multiple RPCs in drop down Permit-RPC-Exec(Ex:Run
device inventory, Extended inventory are etc) and Deny-RPC-Exec(Ex:Topology inventory, run dsl
are etc)
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ATOM | Users & Roles x  +

X

Q ¥ @ ncognito
5

C' A Notsecure | 172.16.23.197

Search for s config Q C ¥ | cCreateRulelist | [ -
)
p °
Entities Py
Jevz
for-auto-creation-of- Rule-List - Rulelist @
R
Group
6066 | search a
ow
system
system
= ,
system
system
system
system
Comment
ownere
ystem
Shared With
< system
?

Q C ¥ | cCreateRulelist | [

~ @
Entities.
for-auto-creation-of- © Er=len-Rrs

Deny-Action-Exec

Permit-Notification-Read

Shared With

x| system

e Select a rule v2 that will be shown the below permit and deny data node,to grant either
allow or deny access to the rule determined to match a particular request.

o Permit datanode

o Deny datanode

Click on rule v2 to add(+) permit data node to fill the below details
Id :Enter string or number(Ex:2)

Path : Enter the path of the object in the data tree on which the rule should be applied.

This is applicable only for the rule type, ‘data-node’ Select the single or multiple Data
node paths
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® Access operations : Select any of the operations on the ATOM entity that needs to be
controlled.
o * [This symbol indicates all the operations (Create, Update, Delete, Read) are
included]

o Create read update delete
© Read create
o Read update
O Read delete

o Various operation to be tested

ATOM | Users & Roles XN + X

C A Notseaure | 1721623.197 a ¥ @ mwogito

- |

Q C ¥ | CreateRulelist | [ x °

Entities

¥ Rule-List -Rulelist

RuleV2

D

>
Permit-Notification-Read
Deny-Notification-Read
Owners
ystem
Shared with
x| system
?

eny-Action Exec

Q C ¥ createRuelist | [ =
Entities. .
Ide
to-creat ¥ RuleList-Rulelist
B
v Ruev2
PermitDatarNode 1 Pathe

Shared With

x| system
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Click on rule v2 to add(+) deny data node to fill the below details

Id :Enter string or number(Ex:3)
Path : Enter the path of the object in the data tree on which the rule should be applied.
This is applicable only for the rule type, ‘data-node’ Select the single or multiple Data
node paths

e Access operations : Select any of the operations on the ATOM entity that needs to be
controlled.

o * [This symbol indicates all the operations (Create, Update, Delete, Read) are
included]

o Create read update delete
O Read create
o Read update
© Read delete

o Various operation to be tested

ATOM | Users & Roles x  +

c A Not secure | 172.16.23.197:

- |

Q C ¥ cCreateRulelist [ X

Entities + -

v Rule-List -Rulelist Permit Data-Node

v ez enyDatai e

Permit Data-Node - 1 Workfiow Author

Perm

Deny-Action Exec

Permit-Notification-Read

Deny-Notification-Read

Owner s

system

‘Shared With

x| system
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(@) atom  r > Users&Tenants > Users&Roles An = O zn )

ers  Roles  NACM

Q C ¥ | createRule-list | [ x

Entities

Workflow Authorization under rule v2:

Camunda allows users to authorize access to the data it manages. This makes it possible to
configure which user can access which process instances, tasks, etc...If it is needed to customize
those permissions for a specific workflow user

Deployment: The option is weather package is upload/load/unload and delete the package

Click on Workflow authorization to add(+) to fill the below details for Deployment

Id :Id is the hardcoded
Resource type : Select the resource type is Deployment
Resource id : Select (*) from resource id drop down to be accessed by all packages or
any specific package resource id.
Grant type:
Grant:Ranges over users and groups and grants a set of permissions. Grant
authorizations are commonly used for adding permissions to a user or group that the
global authorization revoked.

® Revoke::Ranges over users and groups and revokes a set of permissions. Revoke
authorizations are commonly used for revoking permissions to a user or group that the
global authorization grants.
User group: You can select a subset of groups to mapped it.
Permissions: A Permission defines the way an identity is allowed to interact with a
certain resource. (ALL,Create, Read, Delete)
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Workflow-Authorizations

c + B & & »

40f4 | Search Q

1PN Resource-Type
724265 PROCESS_DEFINITION
724273 DEPLOYMENT

724290 PROCESS_INSTANCE

ooooo

724298 TASK

Resource-ld Grant-Type Permission
GRANT [ALL]
604716 GRANT [ALL]

GRANT [ALL]

GRANT [ALL]

Create Authorization | [%,

1d

Resource-Type
DEPLOYMENT PROCESS_DEFINITION

Resource-d

Grant-Type

GRANT REVOKE

PROCESS_INSTANCE TASK

Shared With

x| system

Process definition: This option is access the workflow grid with specific workflow or all based

on given process definition

Click on Workflow authorization to add(+) to fill the below details for process definition

Id :Id is the hardcoded

Resource type : Select the resource type is process definition

Resource id : Select (*) from resource id drop down to be accessed by all workflows or
give any specific workflow of resource id.

Grant type:

Grant:Ranges over users and groups and grants a set of permissions. Grant

authorizations are commonly used for adding permissions to a user or group that the

global authorization revoked.
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® Revoke::Ranges over users and groups and revokes a set of permissions. Revoke
authorizations are commonly used for revoking permissions to a user or group that the
global authorization grants.
User group: You can select a subset of groups to mapped it.
Permissions: A Permission defines the way an identity is allowed to interact with a
certain resource.Choose the various permission (ALL,Create instance, Read, Delete-
instance,Update-instance,update-history,Migrate-instance,Update-task-variable,
Update-task)

(@ atom & > Users&Tenants > Users &Roles A = 8

Resource-Type

DEPLOYMENT PROCESS_INSTANCE TASK

REVOKE

Workflow instance: This option is a workflow instance and is a running instance of a workflow
definition.

Click on Workflow authorization to add(+) to fill the below details for Workflow instance

Id :Id is the hardcoded

Resource type : Select the resource type is Workflow instance

Resource id : Select (*) from resource id drop down to be accessed by all workflow
instances or any specific workflow instance of resource id.

Grant type:

Grant:Ranges over users and groups and grants a set of permissions. Grant
authorizations are commonly used for adding permissions to a user or group that the
global authorization revoked.

o Revoke::Ranges over users and groups and revokes a set of permissions. Revoke
authorizations are commonly used for revoking permissions to a user or group that the
global authorization grants.

User group: You can select a subset of groups to mapped it.
Permissions: A Permission defines the way an identity is allowed to interact with a
certain resource. Choose the various permission(ALL,Create, Update,Read, Delete)
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8 > UsesaTenants > Users&Roles _ﬂ

il
©
HE

ers  Roles  NACM

Q C ¥ | create Authorization | [ x

1d

Resource-Type

DEPLOYMENT PROCESS_DEFINITION TASK

REVOKE

Tasks: This option is a user can perform different actions on a task, like assigning the task,

claiming the task or completing the task. If a user has “Update” permission on a task (or

“Update Task” permission on the corresponding process definition) then the user is authorized

to perform all these task actions

Click on Workflow authorization to add(+) to fill the below details for Task

Id :Id is the hardcoded

Resource type : Select the resource type is Task

Resource id : Select (*) from resource id drop down to be accessed by all workflow
tasks or any specific workflow task of resource id.

Grant type:

Grant:Ranges over users and groups and grants a set of permissions. Grant
authorizations are commonly used for adding permissions to a user or group that the
global authorization revoked.

Revoke::Ranges over users and groups and revokes a set of permissions. Revoke
authorizations are commonly used for revoking permissions to a user or group that the
global authorization grants.

User group: You can select a subset of groups to mapped it.

Permissions: A Permission defines the way an identity is allowed to interact with a
certain resource.Choose the various permission(ALL,Create, Update,Read,
Delete,Read-History,Task-Assign,Task-Work)
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(@ atom &2 > Users&Tenants > Users&Roles ﬂ = o MA
@ s Roles  NACM
Q C ¥ create Authorization | [ X

0

v
ih e 1d

efaultuser-grou
fo]
Resource-Type

g DEPLOYMENT PROCESS_DEFINITION PROCESS_INSTANCE
ES Resaurce-d

v
2

v

> ule REVOKE

Note:: Need to be given the permit rpc exec in rule v2 based on given workflows & follow the

workflow payload

<output>
<user-summary>
<username>srikanth</username>
<write-default>inherit-from-global</write-default>
<read-default>inherit-from-global</read-default>
<exec-default>inherit-from-global</exec-default>
<roles/>
<user-group>
<name>group_disney</name>
<rule-list>
<name>rulelist_disney</name>
<group>group_disney</group>
<rule-v2>
<permit-rpc-exec>/controller:retrieve-configs</permit-rpc-exec>
<permit-rpc-exec>/controller:run-device-inventory</permit-rpc-exec>

<permit-rpc-exec>/disney_ipv6_api:get-neighbor-devices</permit-rpc-exec>
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<permit-rpc-exec>/disney_ipv6_api:ipv6-junos-routing</permit-rpc-exec>
<permit-rpc-exec>/disney_ipv6_api:isis-routing</permit-rpc-exec>
<permit-rpc-exec>/disney_ipv6_api:servicemodel_update</permit-rpc-exec>
<permit-rpc-exec>/disney_ipv6_config:append-task-details</permit-rpc-exec>
<permit-rpc-exec>/disney_ipv6_config:execute-command</permit-rpc-exec>
<permit-rpc-exec>/disney_ipv6_config:ipv6-addition</permit-rpc-exec>
<permit-rpc-exec>/disney_ipv6_config:ipv6-routing</permit-rpc-exec>
<permit-rpc-exec>/configarchive:config-diff</permit-rpc-exec>
<workflow-authorizations/>
<permit-data-node>
<id>1</id>
<access-operations>read create update delete</access-operations>
<path>/ipam:ipv6-pools</path>
</permit-data-node>
<permit-data-node>
<path>/controller:devices</path>
<id>2</id>
<access-operations>*</access-operations>
</permit-data-node>
</rule-v2>
</rule-list>
<group-level-workflow-authorizations>

<authorization>ID:3585112 GRANT PROCESS_DEFINITION ipv6_configs
[ALL]</authorization>

<authorization>ID:3591653 GRANT PROCESS_DEFINITION
interface_ipv6_configuration [ALL]</authorization>

<authorization>ID:3610357 GRANT PROCESS_DEFINITION
ipv6_routing_configuration [ALL]</authorization>

<authorization>1D:3611232 GRANT PROCESS_DEFINITION bgp_peer_configuration
[ALL]</authorization>

<authorization>ID:3585054 GRANT PROCESS_INSTANCE * [ALL]</authorization>
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</group-level-workflow-authorizations>
</user-group>
<user-level-workflow-authorizations/>
</user-summary>

</output>

Integrating ATOM with Central Authentication Systems

By integrating with central authentication systems such as LDAP, AD or TACACS, the users
created in these servers can login to ATOM using their credentials created in their respective
servers.

Managing Active Directory Users

You can import users of Active Directory into ATOM and manage them as other users of ATOM.

For secure communication between the AD server and ATOM, import the security certificate
into ATOM.

1. Navigate to Administration >Users & Tenants > Active Directory
2. Inthe Create Active Directory screen, enter the following:
o URL: Enter the URL address of the Active Directory(Ex:ldap://172.16.2.223)

o Domain: Enter the name of the domain(Ex:anutadev.com)
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TOM | Administration x

> C A Notsecure | 1721623197 @ noogrito

Users  Roles  NACM

c + 140f14  Search Q
O emmt o UserName FrstName LostName ok LastSeen e o
O  abc@gmail.com abc@gmail.com abc@gmail.com Invited on Info
O  admin@atomiocal admin ROLE_WORKFLOW_ADMIN ROLE_SYSTEM_ADMIN 03/12/2021 093706 Invited onlnfo
O sdmngstomiocal admin 03/12/2021 093706 vited oninfo
O oshareet@anutanetuorks.com Invted Sessionlnfo
[ —— com Inited Sessioninfo
O  rejeshekar@anutanetworks.com Invited Session Info
[ m Active Session Info
Administration Invited Sessionnfo
Active onlnfo
Tasks and Events
Invited onlnfo
sers & Tenants Users & Roles
Active onlnfo
cense Tenants
Invited onlnfo
System Authentication Mode
Invited onlnfo
System Manager iy
Active

Plugins & Extensions Proxy Configuration For
Tags Management

RBAC Default Permissions:
UI Custornizations

Open LDAP
Troubleshoot

Keycloak

Active

TACACS

Scripts
File Server

About

R Create Active-Directory [N % °

Name o
ih
AD
Q

URL e

o IE

Idap://172.16.2.223

Domain e
el G cxamoie

anutadev.com|

Owner ¢

system X w
Shared With

x system v

o Click Test Connectivity to test the connection between the ATOM and the AD
servers.
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Active-Directories
®* X Active-Directories Information 2
o C 7 8 B O H ¥ seced Details  Entities ;@
[\
Name A URL Domain pt-Allthe-Certification R Owne
il .
AD 1dap://172.16.2.223 anutadev.com syste domain
-~ anutadev.com
9] Name
AD
* Owner
system
Resource Path

ntroller:
directory=AD

Shared with
system

URL
Idap://172.16.2.223

Managing OpenLDAP Users

You can import the existing LDAP users and user groups of a tenant, thus enabling the tenant
users to login to ATOM using their LDAP credentials.

Importing OpenLDAP Users

Before you begin, ensure that the following conditions are met with:
1. Users and groups are created in the LDAP server
2. OpenLDAP users are created as Tenants in ATOM

To create LDAP users in ATOM:

1. Navigate to Administration > Users & Tenants > OpenLDAP
2. Click Add

Q

Accept-insecure-Certificates Manager-Dn User-Search-Filter User-Search-Base Group-Search-Filter

Administration

Tasks and Events

Users & Tenants Users & Roles

License Tenants Nothing to display!
System Authentication Mode Priority

System Manager Proxy Configuration For RBAC

Plugins & Extensions RBAC Default Permissions

Tags Management Open LI:“P

Ul Customizations Keycloak

Group-Se
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q

3. Inthe Create OpenLDAP screen, enter the values in the following fields:

URL: Enter the LDAP URL of the tenant. Include port number and base
distinguished name (DN)

Example: "ldap://localhost:10389/0=nCloud"

Manager Dn: Type the distinguished name (DN) of LDAP manager. This manager
should have at least read permission.

Example: “uid=admin, ou=system"
Manager Password: Type a password for the entered DN. Example: secret

User Search Filter: Specify a search filter. This field determines the query to be
run to identify the user record. Always include a query in brackets '(' ). Example:
“(uid={0})”

User Search Base: Specify a relative DN (from the root/base DN) where users are
located. Example: “ou=users”

NOTE: In LDAP, {0} is a placeholder (token) for login user ID.

Group Search Filter: This field determines the query to be run to identify the
user in a group. Always include a query in brackets (" ')'. Example:
“(uniqueMember={0})"

Group Search Base: Specify a relative DN (from the root/base DN) where user
groups are located. Example: “ou=groups”

Group Role Attribute: Specify the attribute name of role in a group. Example:

" ”

cn

User-Lastname Attribute: Attribute that contains user's last name. Example: “sn”

254




ATOM User Guide

e User- Firstname Attribute: Attribute that contains user's first name. Example:

«“ ”

cn

e Sync-Freq-in-Hours: Type the interval, in hours, at which ATOM should query the
AD/LDAP directory to schedule an automatic update.

e Last-Syn-Req-Time: The timestamp of the last successful synchronization with
the LDAP server is displayed.

After adding the LDAP user in ATOM, click Test Connectivity to check the connectivity between
the ATOM server and LDAP server.

Ldaps "
®*R & X Ldaps Information 2
cC s B O ¥ siaw Details  Enities s

)

Name URL Accept-Insecure-Certificates Manager-Dn User-Search-Filter
ih . .

Idap Idap://172.16.2.222:10389/0=Coke ® uid=admin,ou=system (uid=(0}) accept-insecure-certificates
. false
)
a
%] group-role-attribute

cn

a group-search-base
ou=groups

group-search-filter
(uniqueMember={0})

manager-dn
uid=admin,ou=system

manager-password

Managing TACACS Users

By integrating TACACS with ATOM, you can achieve a unified authentication system so that the
same login credentials (username and password) can be used to access not only for managing
network devices but for UNIX and Linux servers too. Therefore, the permissions and privileges
to access the devices can be assigned and delegated through ATOM as systems rights.

To integrate the ATOM with TACACS, do the following:
1. Navigate to Administration > Users & Tenants > TACACS > Add
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& %

Tacacs
cC + B8 o 2 10f1 | Search Q
i
O  nNeme 4 Hostp Auth-Key Port Number Owner Shared With Created-On Created-By
O taccas 172.16.4.50 testing123 49 system system 2021-03-12 10:58:37.026

Administration

Tasks and Events
Users & Tenants
License

System

System Manager
Plugins & Extensions
Tags Management
Ul Customizations
Troubleshoot
Scripts

File Server

About

Create Tacacs

Name o

taccag
Host-lp e

172.16.4.50

Auth-Key o

testing123

Port Number o
49

Owner o

system

Shared With

x  system

Users & Roles

Tenants

Authentication Mode Priority
Proxy Configuration For RBAC
RBAC Default Permissions
Open LDAP

Keycloak

Active Directory

Taclics

2. Inthe Create TACACS screen, enter values in the following fields:

Host Name: Enter the IP address of the host, which is hosting the TACACS

server(172.16.4.50)

Auth Key: Enter the key used to specify an encryption key for encrypting and
decrypting all traffic between the ATOM server and the TACACS

server(testing123)

Port Number: Enter the TCP port number to be used when making connections
to the TACACS+ daemon. The default port number is 49.

3. Click the Test Connectivity button to test the connection between the ATOM and the
TACACS servers(enter the name and the password to validate this connection).
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Tacacs
® X Tacacs Information 2
C s ® B D ¥ s Details Entities s &
0 N |
I Name A HostIp Auth-Key Port Number Owner Share
1h
taccas 172.16.4.50 testing123 49 system syste auth-key
. testing123
a
9] host-ip
172.16.4.50
a Name
taccas

Owner
system

Port Number
49

Racnnrea Path

Customizing the Dashboard using DSL

DSL, Domain Specific Language, developed by Anuta can be used for representation and
visualization of data derived from the devices managed by ATOM. DSL taps into YANG models,
platform or third-party APls to express code for model pre and post condition specification, rule
expressions, rule logic, and RPC implementation logic. Some of the advantages that you can
enjoy by implementing DSL are no more manual JAVA or Python code to carry out simple
validations, side effect processing, ability to offer richer expressions than xpath 1.0 used by
YANG, static analysis of business logic, side- effect analysis, advanced user experience, and
ability to change logic on a live system.

Starting from the 7.x release, Dashboard, the landing page of ATOM, is organized into dashlets.

A dashlet is an individual component that can be added to or removed from a dashboard. Each
dashlet is a reusable unit of functionality, providing a summary of the feature or the function
supported by ATOM and is rendered as a result of the custom queries written in DSL.

You can customize the look of the Dashboard, by adding the dashlets of your choice, and
dragging and dropping (the extreme right corner of the dashlet) to the desired location on the
dashboard.
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Py Defauit Dashboard ERT
Lshl  Devices by Status Ll Workflow Status Ll Workflow Assignments
I3
Statuses
il @ 177AcTvE
.. 36 1 3 23 4 652 @ 0SUSPENDED @ 52UNASSIGNED
)
“ Total offine Onine y @ 33 EXTERNALLY TERMINATED @ 12ASSIGNED
) Total @ 320 INTERNALLY TERMINATED Total
@ 4122 COMPLETED
o @ Devices By Type Ll Active Alerts @ Alerts history trend in last 7 days
150
N Total 136 ™
> @ cRITCAL
- 100 @ MaloR = m nz
08
MINOR 100
80 @ VWARNING
@ nro S s
= 59
@ REsOLVED %
& 50
36
&
2
40 30. Oct 31.0c 1N 2. Nov N 4N 5. N
-
2
Cisco SR o [ | N —
CRITICAL MAJOR MINOR WARNING INFO RESOLVED
& Top-N Devices - Alerts € Devices By Vendor @ Alerts history trend in last 7 days
150
Device Name Device D Alerts Device Type
v L= Palo Afto .~y Panorama S. 136 134
£ Nemark
infra-logstash-5ffacccagd-pgmng 1 Juniper e, —————— \ / e 125 /\_.\ .

Each dashlet contains the summary or the overview of the feature or the functionality
supported by ATOM.

For example, the dashlet “Device” displays the summary of devices managed by ATOM.
Some of the statistics that can be of the interest in this dashlet could be as follows:

e Total number of devices

e Number of online devices

e Number of offline devices

These statistics can be gathered by ATOM and displayed in the corresponding dashlet depending
on the DSL query written for each of them. For information about writing DSL queries, refer the

section, “Writing DSL Queries”

You can save the layout containing the dashlets of your choice and set in a particular order.
Writing DSL Queries

1. For writing any new DSL query in the editor, browse to Administration > DSL > DSL
Editor.
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(i B osiedor | [

Q DSLEditor  Schema Browser Preview  Result  Logs
«§ e _—

Sample DSL Query

Below is a sample DSL which will display Total/Offline/Online devices in ATOM as a card
layout

(n {:view "number-card", :label "Device", :id "device", :icon
"icon-Devices.svg"} "Each-Card"

(n {:label "Total"} "Each-Card"

["count" (get-count-by-schema-path "/controller:devices/device") ]
)

(n {:label "Offline", :icon "status-Critical.svg"} "Each-Card"

["count" (get-count-by-schema-path "/controller:devices/device/status"
["OFFLINE"]) ]

)
(n {:label "Online", :icon "status-Minor.svg"} "Each-Card"

["count" (get-count-by-schema-path "/controller:devices/device/status"
["ONLINE"]) ]

)
)

2. Click to Run button on the top of the editor to check if DSL is working as expected.
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DSL Editor S

DSL Editor

<root><Each-Card><metadatas<id><! [CDATA[device] ]></id><icon> <! [CDATA]
<Ivi COAT! 1></1abel: Label="T
label="0Ffline" >4¢/count><count icon='statu vg' label="Online’>40<

/status” ["OFFLINE"]

us" ["ONLINE™]

Go to the right pane to view the result.There are three tabs in the right side panel Preview,
Result and Logs

e Check the Preview of layout (Card,Grid,Pie Grid,Pie Chart) for the DSL in Preview
tab.

e XML output of the DSL will be shown in the Result tab
e All errors of the DSL will be listed in the Logs tab in case of any failures.

After the successful execution of a DSL query, you can save and use this as a new Report
or incorporate it into Dashboard view. All DSL queries will be saved in Administration >
DSL Queries.

Customizing the Dashboard

After the successful execution of DSL query, if you want to incorporate the DSL into Dashboard,
browse to Administration > DSL < DSL Queries to view all the queries as shown below:
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® DSL Queries
@ § ¥ sclected

Name 4
Device

Device-And-Collection-Profiles
Device-LastComplianceTime Report
Device-Type-Summary
Devices-With Max-Alerts

Interface-Shutdown-With-Approval

(o)

Interface-Shutdown-With-Out-Approval
NocB

Non-Compliance
Number-Of-Service-Tenants
Recent-Alerts

Reconciliation-Report
sSLcertificate-eport
Task-Summary
Telemetry-Alerts-And-Actions

Top 5 Egress Interface Utilisation
Top S interface by Egress Error Rate
Vendor-Summary

ackfirewall-report

actions-summary

alert-summary

assurance-summary

bgp-neighbor-report

0000008 O0OO0OCOCO0OO0OO0OOOO0OOOOOCOCOCE Q

collection-profiles-report

Version
B

B

id
Device1
Device-And-Collection-Profiles,1
Device-LastComplianceTime Report,1
Device-Type-Summary,1
Devices-With-Max-Alerts,1

Interface-Shutdown-With-Approval.1

Description

No.of Reconciliation Devices

Interface Shutdown With Approval

hutd h I
NOG81

Non-Compliance,1
Number-Of-Service-Tenants, 1
Recent-Alerts,1
Reconciliation-Report.1
SSLeertificate-eport,1
Task-Summary,1
Telemetry-Alerts-And-Actions,1

Top 5 Egress Interface Utilisation
Top 5 interface by Egress Error Rate
Vendor-Summary,1
ackfirewall-report 1
actions-summary.1

alert-summary.1
assurance-summary, 1
bgp-neighbor-report.1

collection-profiles-report,1

Interface Shutdown With Out Approval

No.of Reconciliation Devices

SSL Certificates

ZoneBased Firewall ACL Report

Actions Summary

Assurance Summary
o listout BGP Neighbor details across devices

collection Profiles Report

1-500f 106 Page
Value

(let {offine (get-count-by-schema-path */
(n {view number-card', label ‘Devices A
(n view "grid”, title "Device LastComplia
(n {view pieGrid", :showLabelsOnGrid *tr
(n{:view "grid", title “Top-N Devices - Ale
(do (let {alert (from-context "tick-messag
(let {alert (from-context "tick-message”)}

(n{:view "vBarChart’, label 'NOC A, id *

(n {view number-card’, label "Non Comg
(n {view pieGrid", label "No.of services {
(n{:view "grid", title Recent Alerts’, hide
(n {view number-card', label ‘Device Co
(n {view grid”, title *SSLGertificates Repy
(et {summary (invoke-rpc {y/module "tat
(n {view number-card', label “Telemetry
(n{:view "customChart”, type customch
(n{:view "customChart”, type ‘customch

(n {view ‘pieGrid", :showLabelsOnGrid *tr

(n {view "grid” title "ZoneBased FW ACL
(n {view "grid” title “Triggered Action Ba
(n{:view "vBarChart, label "Active Alerts

(n {view "grid”, title "Assurance Summar,

(n {view “grid” title "BGP Neighbor Repor

(n {view "grid” title "Collection Profiles R

X DSL Queries Information

category
reports

Description

id
Vendor-Summary,1

is-batch-mode
false

Name
Vendor-Summary

no-of-past-reports-to-show

Resource Path
/dto:dtos/dto=Vendor-Summary,1

value

(n {wview "pieGrid", showLabelsOnGrid "true, label
*Devices by Vendor', id ‘vendor-summary’,
legendvisibility“false’} "MyCustom’ (for-each entry
(xpath/extract /output/row’ (invokepe y/module
*developerutils" :/rpc get-group-count-by-schema-
path' rc/headers [ :d-/input-xml “cinput><schema-
path>/controller:devices/device/vendor-
string</schema-path></input>" })) (n ['vendor'] (n

® DSL Queries

P | _ﬁ@ Selected

Name . [P

il BGP-Neighbor h-Out-Approval
Basic123

o CPU Utilisation for 1 Minute
Compliant
Device

Device-And-Collection-Profiles

()

Device-LastComplianceTime Report
Device-Type-Summary
Devices-With-May-Alerts
Interface-Shutdown-With-Approval
Interface-Shutdown-With-Out-Approval
NocB

Non-Compliance
Number-Of-Service-Tenants
Recent-Alerts

Reconciliation-Report
SSLeertificate-report
Task-Summary
Telemetry-Alerts-And-Actions

Top 5 Egress Interface Utilisation
Top 5 interface by Egress Error Rate
Vendor-Summary

ackfirewall-report

actions-summary

JO0O®sMO0O0OO0O0ODO0OO0OOODODO0OOOCOOOOOOOOOD Q

Version

id Description
BGP- h-Out-Approval 1 ighbor Shutdown With Out Approval
Basic123

CPU Utilisation for 1 Minute
Compliant1

Device,1
Device-And-Collection-Frofiles; 1
Device-LastCompliznceTime Report,1
Device-Type-Summary,1
Devices-With-May-Alerts,1

Interface-Shutdown-With-Approval 1

No.of Reconciliation Devices.

Interface Shutdown With Approval

hutdown-With- I
NOG81

Non-Compliance,1
Number-Of-Service-Tenants, 1
Recent-Alerts1
Reconciliation-Report 1
SSLeertificate-report 1
Task-Summary,1
Telemetry-Alerts-And-Actions,

Top 5 Egress Interface Utilisation
Top 5 interface by Egress Error Rate
Vendor-summary,1
ackfirewall-report 1

actions-summary,1

Interface Shutdown With Out Approval

No.of Reconciliation Devices.

SSL Certificates

ZoneBased Firewall ACL Report

Actions Summary

1-500f106 Page
Value

(let {alert (from-context ‘tick-message”)}
(n{:view "customChart’, type "customch
(n{:view "customChart’, type "customch
(n {view number-card’, abel “Compliant
(let {offine (get-countby-schema-path
(n {view number-card’, Jabel ‘Devices A

(n {view grid’, title ‘Device LastComplia

(n (view "pieGrid', showL abelsOnGrid ‘tr
(n{:view "grid’ ttle “Top-N Devices - Ale
(do (et (alert (from-context "tick- messag
(Iet {alert (from-context ‘tick-message")}
(n (:view "VBarChart', abel "NOC &', id "

(n {view number-card’, Jabel "Non Comg

(n {view pieGrid", label "No.of services f

(n{:view "grid", title Recent Alerts”, hide

(n {view number-card’, Jabel ‘Device Co
(n Lview grid’, title "SSLCertificates Repl
(et {summary (invoke-rpe {y/module "tat
(n {view number-card', Jabel “Telemetry
(n{:view "customChart’, type "customch
(n{:view "customChart’, type "customch
(n {view ‘pieGrid", :showL abelsOnGrid *tr
(n {view "grid” title "ZoneBased FW ACL

(n {view "grid” title “Triggered Action Ba

X DSL Queries Information

category
reports

Description

id
Vendor-Summary,1

is-batch-mode
false

Name
Vendor-Summary

no-of-past-raports-to-show
]

Resource Path
/dtordtos/dto=Vendor-Summary,1

value

(n {view ‘pieGrid", showLabelsOnGrid “true’, Jabel
“Devices by Vendor', id "vendor-summary’,
legendvisibility *false’} MyCustom’ (for-each entry
(xpathy extract */output/row’ (invoke-rpe {y/module
K " :y/rpe "get-group- by-sche
path' re/headers [ :d-f/input-xml *<input><schema-
path>/controller.devices/device/vendor-
string</schema-path></input>"}) (n ['vendor'] (n

Include your new DSL and click the Save button on the right side panel of the Editor.
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« @

® DSL Editor [N Vendor-Summary
DSLEditor  Schema Browser m‘ Preview  Result  Logs
iy ———
1 <root><HyCustom> metadata><shoul abels0nGrid><! [CDATA [true]]></shoulabel sOnGrid><id><! [CDATA[vendor -summary]]></1d>
2 (n {:view "pieGrid”, :shoulabelsOnGrid "true”, :label "Devices by Vendor”, :id "vendor-summary”, <legendvisibility><! [CDATA[false]]></legendvisibility><view><! [CDATA[pieGrid]]></view><label><! [CDATA[Devices by Vendor]]>
ih Legenduiatbility "false”) Pycuston </1aber ses</vendors ALt Netuarks/nane>
E (for-each entry (xpath/extract "/output/rou” (invoke-rpc {:y/module “developerutils” <value>3</value></vendor><vendor><name>F5 Netuorks</ value>< isco
N 4 ty/rpe ‘et -group-count -by-schema-path” /vendor>- Juniper value>< ustom></root>
-~ s irc/headers (]
0, e p ol vendor-
string</schema-path></inputs”
7 )
5 (n ["vendor™]
0D 9 (n ["name” (xpath/extract "./row/value” entry)])
10 (n ["value" (xpath/extract "./row/count” entry)])
n )
be! )
13 )
18

Now you can browse to Dashboard to view the report that has been included (due to the new
DSL query that was added) in the Dashboard DSL.

Py OcfeultDashboard

Ll Devices by Status € Device Vendor Summary Ll orkflow Assignments
3
Vendor 4 DeviceType DevicaCount
II - Arista Networks DCS-2759 3
5
Total Offine Online Cisco Systems Cisco 891 1 @ 0ASSIGNED
Cisco Systems Ciscol0SXRV9000 3
- Cisco Nexus 9000V 2
D F5 Networks bigipVirtualEdition 1
€ Devices By Type Ll Workflow Status
DigipVirtu. Statuses
cadNen i
JuniperSR ® sacmve
UNKNOWN
isco 91 @ 05USPENDED

eV
GiscolosR.. @ 0 EXTERNALLY TERMINATED

Pavie
@ & INTERNALLY TERMINATED

@ 23coMPLETED

Juniperish oes2rss
papanorem
Ll Active Alerts
EN Total
0 @ CRITICAL
@ AR
isco CSR w© MINOR
@ WARNING
N @ nFo
& Devices by Vendor 0 @ resowve
ArstaNet

DSL Assignment

The define the dsl assignment is associated with the group and dto is a transfer of the object(to
get the navigation menu items after login user).

Navigate > Administration > DSL > DSL Assignment > Add

262



ATOM User Guide

()

0

Create Groups-To-Dtos

Entities

GroupsTo-Dtos.

Create Groups-To-Dtos

Entities

GroupsTo-Dtos.

Create Groups-To-Dtos

Entities

¥ GroupsTo-Dtos.

Do

r

3

r

‘o -mandstory information

Group-Name o

description: default-user-group

groupusegfry

wmer: systeth
description: group-user2

groups

90fo

‘o -mandstory information

Group-Name o

group-user2

Description

‘o -mandatory information

Dio-Name o

navigation-page with-all-features

Dto-Version

[

Description

View-Name

View-Version

Editable-View-Name

Editable-View-Version
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Tag Management

By creating the tags in global, it should show in create alert rule definition

® Grid-Customizations grid-Customizatio.

@ E & & » 101 Search Q
cnd

®R Create Grid | [, x
= O —— Create grid
fay crtities

Schema-Path o

Grid - /Controller-devices/Device
il /controllerdevices/device

Ul Customizations

Customization give control to the user.Customization may involve moving items around an
interface to reflect the users’ priorities

1.Grid column: Grid columns allows us to select which grid columns can be shown for each
entity.Current by default we have one for devices now in grid column.

Navigate > Administration > Ul customization > Grid column >Add
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Grid-Customizations:grid-Customizatio.

c + B 10f1 | Search Q

[ schemapath o

O  /controllerdevices/devi.

Administration

Tasks and Events

Tenants

System

System Manager

Plugins & Extensions

User Management

Tags Management

Ul Customizations Gijd Columns
Troubleshoot Chart-specs
DSL Chart-templates
Deprecated Chart-Variable
File Server

About

® Grid-Customizations:grid-Customizatio.

c -@ B 101 search Q

[0  SchemaPath

il [0 /eontrollerdevices/devi

()

Wy Createsrid | [

Entities @ mandatory nformato N
s}

Grid - /Controller: Schema-Path o °
ih Jeontroller|

ol
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2.Chart-specs:

A Chart Spec defines the query to be used, variables used in the query and the intended graph

type.For example, a chart spec can be written for a TopNUtilizedInterfaces report.The query

would use variables for device and the N.

An admin may decide to create two invocations of this chart spec and make them available

readily; one for top 5 and one for top 10.Admin can do so by creating 2 chart-invocation

payloads and give 25 and 50 for the N value.An end user can run these two different charts out

of the box.In addition, end user can tweak the parameter values and explore the graphs.

If a user decides to save the changed chart invocations it is a simple matter of changing the

corresponding chart invocation objects.

Navigate > Administration > Ul customization > chart -specs >Add

Metric-Charts:chart Specs.
+ B

Name 4 Description Graph-Type

Basic123

CPU Core Summary

CPU Utilisat

CPU Utilisation for 1 Minute
CPU Utilisation for § Seconds
CPU Utilization for 5 Minutes

IF-MIET2

Doooooo0OaQ

Administration

Tasks and Events
Tenants

System

System Manager

Plugins & Extensions

User Management

Tags Management

Ul Customizations Grid Colu
Troubleshoot Chart-specs
pSL Charttemplates
Deprecated ChartVariable

File Server  —

About

O  Top 5Disk Utilis:

71 Top 5 Disk Utilisation across Network
httos://172.16.21.187:30443/naui/atom/ace?schemaPath=%2Fmetric-charts:chart-soecs

® Metric-Charts:chart-Specs
e
0
Name Description Graph-Type
Basic123

CPU Core Summary

CPU Utils:

CPU Utilisation for 1 Minute

GPU Utilisation for 5 Seconds
GPU Utilization for 5 Minutes
IF-MIB12

IFMIE222

IFMIE234

IFMIEg

Memory Utiisation

]

Memory Utilisation Device Level

Network Top 5 CPU Utilisation
Network Top 5 Egress Interface Utilisation
Network Top 5 Ingress Interface Utilisation

Network Top 5 Interf

Network Top 5 Interf

Network Top 5 Mem

Network Top 5 i
Network Top 5 i
Network Top 5 i
Network Top 5 interfaces by Ingress Packet Dro

Top 5 Disk Utilisation Device Level

/0000000000000 O0O0O0O0OO0DODO0ODOOOOO0O)Q

Top 5 Disk Utilisation across Network

Platform

ALLIALLIALLIIOS[Cis

ALLIALLIALLIALL(Cis

ALLIALLIALUALLCisco Systems

ALLJALLIALLIALL[Cisco Systems

ALLIALLIALUALLCisco Systems
17.4R1MX|uniper MX|JUNOS|Juniper Networks
17.4R1IMX|Juni
ALLALUA
ALLIALLIALLIALL
ALLIALLIALLIALL
ALLIALLIALLIALL

ALLIALLIALLIALL(Cis

Platform

ALLIALLIALLIIOS[Cis

ALLIALLIALLIALL(Cis

ALLIALLIALLIALLCisco Systems

ALLIALLIALLIAI

ALLIALLIALLIALL(Cis

17.4R1|MX}Juniper MX|JUNOSHuniper Networks

17.4R1|MX|Juniper MX|JUNOS| jetworks

ALLIALLIALLIC

105

ALLIALLIALLIAI
ALLIALLIALLIAI
ALLIALLIALLIAI

ALLIALLIALLIALLCisco Systems

=
2

IBRRRRRRIIIIRIVIOIIRRRRORR®OQ

z
7

IBERRRRAIRAIROIIRIRIRIIRORO ¢

Basic-Chart Unit Device-Group

IPRRRRIFRRRIRRAIRRIIORRIORR®

410f41 | search a

8

Unit Device-Group

IBRARRAIRRIRRIIRARIRAIRA®R®O
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0

s

Create Chart-Spec kN

Entities

Chart-Spec- sasmm@s.;ec

Create Chart-Spec | [

Entities

Chart-Spec - Basic-Chart-Spec

b

 “mandatory information

Name o

Basic-chart-spec
Description
Graph-Type

DataLables x v

Platform

ALUALLIALLIALLCisco Systems x v

Node-Level

O

Basic-Chart

Unit

Device-Group
200120 search
DeviceGroup A+
Allbevices
Firewall
Host

Layer 2 switch

oooooo

Layer 2/3 switch

‘o -mandstory information
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®R Create Chart-Spec kN

iti + = e e m x
ey Enities %

¥ Chart-Spec - Basic-Chart-Spec Name ¢
ifHighSpee«
ih Query-Spec gnsped
o Description

Query e

ifHighspeedidevice=Sdevice, fDescr=SifDescr}

(o)

3.Chart-Template:

To define the template is a collection of custom charts.create the multiple basic and advanced
custom charts can be grouped into one template.it should show the chart graph in monitoring

Navigate > Administration > Ul customization > chart -template >Add

Metric-Charts:chart-Templates

+ B 90f9 | Search a
Name g Description Platform Defaut-Template Node-Level Applies-To Device-Group

chart_s ® Jcontrollerdevices/device

Interface Drops and Errors Summary null Jcontrollerdevices/device

InterfacePerformance Jcontrollerdevices/device

Network wide Interface Performance Jeontrollerdevices/device

BB

Network wise Interface Drops and Error R Jcontroller devices/device

Templated ALLIALLIALLIIOS| Jeontrollerdevices/device

CooOoooo0OQ

quertyu 17.4R1MX|Juni Jcontroller devices/device

Administration ALLIALLIALL|IOS| Jeontrollerdevices/device OfflineDevices

RARARPO®

ALLIALLIALLIIOS] Jeontrollerdevices/device

Tasks and Events
Tenants

System

System Manager
Plugins & Extensions
User Management
Tags Management

Ul Customizations Grid Columns

Troubleshoot Chart-specs

DSL Chagt-templates
Deprecated Chart-Variable
File Server

About

https://172.16.21.187:30443/nqui/atom/paqe?schemaPath=%2Fmetric-charts:chart-templates
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Py e chartschar Tempstes

c 90f9 | Search &
I\

Descrpti Platform Default Templat Node-Level AppliesTo Device-Group
0 latf fault Templ: de-Level i
on

il [ ®

(m] null ®
N
P
=y O ® ®
o m] ® ®

O Network wise Interface Drops and Error R ® ®
D O Templates ALLIALLIALLJIOS|Cisco Systems (] Jcontroller.devices/device

O qwertyu 17.4R1|MX|Juniper MX|JUNOS|Juniper Networks ® /controllerdevices/device

tem ALLIALLIALLIIOS[Cisco Systems Jeontrollerdevices/device OfflineDs
llerdevices/d i
O tes ALLIALLIALLJIOS[Cisco Systems ® Jeontrollerdevices/device

®R Create Template [N

it o mands X
ey Enities @

Template - Template Name

IIl Templat

N Description

o

9 Platform

o ALUALLIALLIALLCisco Systems x v
Default-Template

]
Node-Level
AppliesTo
x| Jeontrolerdevices/device -
Device-Group

20020  searct h Q

O Devicetrowp 4
O Ao
[ Firewal Il
O Host
[MEE
[m]
[m]

4.Chart-variables: To define a Variables are useful when the user is writing the queries to build a
custom chart.Global variable which can be reusable across multiple charts

Here Two types of variables are Constant and Query,Query type is useful to fetch a list of
entities like devices, interfaces etc.and constant is for any static values like bucket interval etc.

Navigate > Administration > Ul customization > chart -variables >Add
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Metric-Charts:variables

c + B 60f6  Search a
O Neme 4 Description DefaultValue System-Defined Type Metric Filter

O device (] device Sdevice

O  devicea ® device Sdevice

[ devices ® device Sdevice

O ifeser (] ifDescr {device":"$device"

[0 ifoescra ® ifDeser {'device™"$deviceA’}

O ifescrs ® ifDescr {'device""$deviceR’)

Administration

Tasks and Events
Tenants

System

System Manager
Plugins & Extensions
User Management
Tags Management

Ul Customizations Grid Columns

Troubleshoot Chart-specs

DSL Chart-templates
Deprecated Chart-Variable
File Server

About

hitps://172.16.21.187:30+ =9%2Fmetric-c|

@ Metric-Charts:variables
c =] 6076 Search a
® O Neme 4 Description Defauit-Value System-Defined Type Metric Filter
IIl O  device [V] device Sdevice
[0 devicea ® device Sdevice
ol O e ® device $device
O  ifoeser (] ifDescr {device":"$device}
O  ifescrd ® ifbescr {'device"$deviceA’}
[ ifoescis ® ifDeser {'device™"$deviceB}
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Default-Value

Variable Type

query

Troubleshoot

From the Troubleshoot tab, the system administrator can perform the following tasks:
e "Services & Metrics"

e "Queue Statistics"

o “Device Comm and Inv”

Services & Metrics

The administrator can view a summary of the health of the server and the associated agents. All
the services running on the ATOM server are also displayed here.

1. Go to Administration > Troubleshoot > Services and Metrics

2. Inthe left pane, click Servers > Components to view the different categories of the
servers running in ATOM.

3. Click Servers > System Health in the right pane to view the health of the components of
the server.

The health of the associated services is also displayed in the lower pane.
4. Click the Servers icon to view the Services in the right pane.

5. Select a service that is running and view the Statistics and Events associated with the
service in the bottom panel.
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Queue Statistics

ATOM uses a bus to communicate various events between the different ATOM modules or
components, thereby providing a view of the activity of the Naas Bus.

® Broker Statistics
® Naas Bus Monitor Statistics

Each row represents a particular event that ATOM components publish or subscribe to, thereby
help in monitoring the Bus.

Device Comm and Inv

Ping

As an administrator, you can check the reachability of a device from ATOM using Ping Test.
1. Navigate to Administration > Troubleshoot > Device Comm & In > Ping Test

2. To create a Ping Test, fill the fields described below:

o [P Address: Enter the IP address of a device that needs to be verified for its
reachability.

o Packet Count: Enter the number of ICMP Echo request messages to be sent.

e Time Out (sec): Specify a value for the time for which the ping command should
wait for each reply.

SNMP

SNMP Tests You can test if SNMP devices are responding correctly to SNMP queries. By default,
SNMP v2c is supported.

1. Navigate to Administration > Troubleshoot > Device Comm & In > SNMP
2. To create an SNMP test, fill the following fields:
e Device Name: Enter the name of the device

® SNMP Operation: Choose an appropriate SNMP operation from the drop- down menu:

o GET

o  GET NEXT
o GET BULK
o WALK

o SNMP OID: Enter the OID of the SNMP device
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SNMP TEST

Device Names \‘) v

csr3.30.anutacorp.com/172.16.3.30 v

SNMP Operatione

ks
Get
SNMP OIDe
1.3.6.1.2.1.1.1.0
SNMP Result
Agent:  default_agent
Status:  Success
Error Code: 0

Errorindex: 0O
Error Message :

1.3.6.1.2.1.1.1.0 -> Cisco 10S Software, CSR1000V
Software (X86_64_LINUX_IOSD-UNIVERSALK9-M),
Version 15.6(1)S, RELEASE SOFTWARE (fc4) Technical
Support: http://www.cisco.com/techsupport Copyright
(c) 1986-2015 by Cisco Systems, Inc. Compiled Wed
25-Nov-15 15:02 by mcpre

Result :

Config Parser

This utility helps you check the parsed output of any running configuration of any device. By
doing so, you can verify the extent to which ATOM supports the config parsing for a given
running configuration. All the parsed configuration can also be visualized in the supported data
models in ATOM.

1. Navigate to Administration > Troubleshoot > Device Comm & Inv > Config Parse

Config Parsing Report

o Fersng Repon Generated
Successfully

2. Select the device family details for which the config parsing support needs to be verified
in ATOM:
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i.  Vendor: Select the vendor from the supported vendor list in ATOM
ii. OS Type: Select the OS type for the device vendor for which the config parsing
needs to be checked
iii.  Device Family: Select the device family that the device belongs to
iv.  Device Type: Select the type of the device belonging to the selected device

family
v.  OS Version: Select the version of the OS
vi.  Inthe Running Config pane, paste the running configuration of the device for

which config parsing needs to be verified
vii.  Click Submit to generate the Config Parsing Report

The results of the Report can be viewed in the right pane as

e Parsed Data: The configuration, which is parsed in ATOM, for which the data model is
available can be viewed in this tab.

e Parsed Configurations: The running configuration that is parsed into blocks by ATOM
can be viewed in this tab.

e Parsing Errors: The parsed configuration derived in ATOM but with errors can be viewed
in this tab.

e UnSupported Configurations: The running configuration for which there is no parsing
support available in ATOM can be viewed in this tab

File Server

File server helps users to upload and can also down the packages related to the services or any
workflow if any user wants to save a package in the repository.

Navigate to Administration > File Server and click on the add button.

Name: Enter a name of the package
Choose File: Upload a package or a file which needs to be saved.
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® File-Server
cC + B o & »

101 Ssearch B

O neme 4 File
1 I O  workflow
1

flereporfilerepo_cla_workflow_remediation-8.0.0.0 (9) zip

o)

About

Navigate > Administration > About

-y serverversion 842027976
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